Preface

Copyright

This manual is published by PerkinElmer Health Sciences, Inc., 68 Elm Street, Hopkinton, MA 01748 USA. Copyright 2008-2014, PerkinElmer Health Sciences, Inc and its parent, affiliated, and subsidiary companies. All rights reserved, including but not limited to those rights to reproduce this publication or parts thereof. Reproduction of this publication or parts thereof or the products it describes by any means or in any form is expressly prohibited without the written permission of PerkinElmer.

Trademarks

PerkinElmer, LabChip, the PerkinElmer logo, and the LabChip logo are registered trademarks of PerkinElmer Health Sciences, Inc and/or its parent, affiliates, and/or subsidiary companies (collectively “PerkinElmer”). Microsoft, Windows, and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. All other trademarks and registered trademarks are the property of their respective holders.

Content

Any errors or omission which may have occurred in this publication, despite the utmost care taken in its production, will be corrected as soon as possible, but not necessarily immediately upon detection. PerkinElmer provides this publication “As Is” without warranty of any kind, either express or implied, including but not limited to the implied warranties of merchantability or fitness for a particular purpose. Some states or jurisdictions do not allow disclaimer of express or implied warranties in certain transactions; therefore, this statement may not apply to you. PerkinElmer reserves the right to revise this publication and to make changes from time to time in the content hereof without obligation of PerkinElmer to notify any person of such revision or changes. Further, PerkinElmer may make modifications to the product described in this manual at any time without any obligation to notify any person of such modifications.

Proper Equipment Operation

WARNINGS

- To reduce the risk of electric shock, do not remove the cover. No user serviceable parts inside. Refer to qualified service personnel if help is required.
- Use this product only in the manner described in this manual. If the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

AVERTISSEMENTS

- Pour réduire le risque de choc électrique, ne pas retirer le couvercle. Ce produit ne contient aucune pièce pouvant être réparée par l’utilisateur. Au besoin, confier l’appareil à un réparateur qualifié.
- Ce produit ne doit être utilisé que comme décrit dans ce manuel. Si cet appareil est utilisé d’une manière autre que celle spécifiée par le fabricant, la protection fournie par l’appareil peut être entravée.
Contact Us

If you have a question about the LabChip GX that is not answered in this manual or online Help, or if you need assistance with this product, contact the PerkinElmer Technical Support Center:

Phone: (US Toll Free): 800-762-4000
       (Worldwide): +1 203-925-4602
Fax:    +1 203-944-4904
Email:  global.techsupport@perkinelmer.com
Internet: www.perkinelmer.com

For support outside the United States, contact your local PerkinElmer representative.

Before you call, you should have the following information available for the technical representative:
• Product serial number
• Software version (found by choosing About from the main Help menu)
• If applicable, the error number shown in the product software or in the log file.

Product Service and Customer Support Plans

PerkinElmer offers a full range of services to ensure your success. From our original factory warranty through a comprehensive line of customer support plans, PerkinElmer offers you Field Service Engineers and in-house Specialists who are dedicated to supporting your hardware, software and application development needs.

Call: (US Toll Free): 800-762-4000
       (Worldwide): +1 203-925-4602
Fax:    +1 203-944-4904
Email:  global.techsupport@perkinelmer.com

Our programs can include such useful services as:
• Preventive maintenance
• Diagnostic servicing performed on-site by PerkinElmer field service engineers or remotely via Technical Support
• Validation performed on-site by PerkinElmer field service engineers
• Extended use of the PerkinElmer Technical Support Center
• Software updates
• Parts, labor, and travel expense coverage
• Other customized services upon request

Training For Your Product

Contact the PerkinElmer Center for Training and Development for information about the availability of training courses for your product:

Call: (508) 497-2634
Fax:   (508) 435-3439
FCC

This device complies with part 15 of the FCC (United States Federal Communications Commission) Rules. Operation is subject to the following two conditions:

• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.

CE

This device complies with all CE rules and requirements.

NOTE

Changes or modifications to this equipment not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

REMARQUE

Tout changement ou modification apporté à cet instrument non expressément approuvé par l’entité responsable de la conformité peut annuler l’autorisation d’opérer l’appareil accordée à l’utilisateur.

Table of Symbols

Table 1 contains symbols that identify particularly important information and alert you to the presence of hazards. These symbols may appear in this manual and/or on the product it describes.

Table 1. Important Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>DANGER: An imminently hazardous situation, which, if not avoided, will result in death or serious injury. DANGER: Situation présentant un danger imminent qui, s’il n’est pas éliminé, peut entraîner des blessures graves, voire la mort.</td>
</tr>
<tr>
<td>![ ]</td>
<td>NOTE: A cautionary statement; an operating tip or maintenance suggestion; may result in instrument damage if not followed. REMARQUE: Énoncé indiquant une précaution à prendre, un conseil de fonctionnement ou une suggestion d’entretien; son non-respect peut provoquer des dommages à l’instrument.</td>
</tr>
</tbody>
</table>
### Table 1. Important Symbols (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Warning]</td>
<td>Hazardous voltage; risk of shock injury. Tension dangereuse; risque de blessure par électrocution.</td>
</tr>
<tr>
<td>![Warning]</td>
<td>Crush hazard. Risk of body parts, hair, jewelry, or clothing getting caught in a moving part. Danger d’écrasement. Faire attention que les parties corporelles, les cheveux, les bijoux ou les vêtements ne soient pas pris dans une pièce mobile.</td>
</tr>
<tr>
<td>![Warning]</td>
<td>Risk of eye injury; wear safety glasses. Risque de lésion oculaire; porter des lunettes de sécurité.</td>
</tr>
<tr>
<td>![Warning]</td>
<td>Hazardous fumes. Émanations dangereuses.</td>
</tr>
<tr>
<td>![Ground Symbol]</td>
<td>Protective ground symbol. Symbole de terre de protection.</td>
</tr>
<tr>
<td>![Ground Symbol]</td>
<td>Ground symbol. Symbole de terre.</td>
</tr>
<tr>
<td>![Fuse]</td>
<td>Fuse. Fusible.</td>
</tr>
</tbody>
</table>
Table 1. Important Symbols (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off (supply).&lt;br&gt;Arrêt (alimentation).</td>
<td></td>
</tr>
<tr>
<td>CE compliance mark.&lt;br&gt;Marque de conformité CE.</td>
<td></td>
</tr>
<tr>
<td>Signifies that the unit has passed safety tests for grounding, power line transience, and current leakage.&lt;br&gt;Signifie que l’appareil a réussi les tests de sécurité pour la mise à la terre, le courant transitoire de ligne d’alimentation et la perte de courant.</td>
<td></td>
</tr>
<tr>
<td>Input.&lt;br&gt;Entrée.</td>
<td></td>
</tr>
<tr>
<td>Output.&lt;br&gt;Sortie.</td>
<td></td>
</tr>
<tr>
<td>Equipment labels are color coded:&lt;br&gt;Les étiquettes de l’appareil sont codées couleur:</td>
<td></td>
</tr>
<tr>
<td>Yellow</td>
<td>Caution, risk of danger</td>
</tr>
<tr>
<td>Red</td>
<td>Stop</td>
</tr>
<tr>
<td>Blue</td>
<td>Mandatory action</td>
</tr>
<tr>
<td>Green</td>
<td>Safe condition or information</td>
</tr>
<tr>
<td>Jaune</td>
<td>Attention, danger potentiel</td>
</tr>
<tr>
<td>Rouge</td>
<td>Arrêter</td>
</tr>
<tr>
<td>Bleu</td>
<td>Intervention obligatoire</td>
</tr>
<tr>
<td>Vert</td>
<td>Condition sûre ou informations de sécurité</td>
</tr>
<tr>
<td>Helpful hints, additional information&lt;br&gt;Conseils utiles, informations supplémentaires</td>
<td></td>
</tr>
</tbody>
</table>
Instrument Safety

The following safety information about the LabChip GX is included in this documentation. Read and review all safety information before operating the LabChip GX.

• Required Training
• “Chemical Safety” on page 8
• “Laser Safety” on page 9
• “Electrical Safety” on page 10
• “Mechanical Safety” on page 11

Required Training

Ensure that all personnel involved with the operation of the instrument have:

• Received instruction in general safety practices for laboratories.
• Received instruction in specific safety practices for the instrument.
• Read and understood all related MSDSs.

WARNING

Use this product only in the manner described in this manual. If the equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.
Chemical Safety

WARNING

Some chemicals used with the LabChip GX are potentially hazardous and can cause illness.

- Read and understand the material safety data sheet (MSDS) provided by the chemical manufacturer before you store, handle, or work with any chemical or hazardous material.
- Minimize contact with and inhalation of chemicals and chemical wastes. Wear appropriate personal protective equipment when handling chemicals (e.g., safety glasses, gloves, or clothing). For additional safety guidelines consult the MSDS.
- Do not leave chemical containers open. Use only with adequate ventilation, including a fume hood, if necessary.
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended on the MSDS.
- Dispose of waste in accordance with good laboratory practices and local, state/provincial, or national environmental and health regulations.
- After emptying waste containers, seal them appropriately.
- Comply with all local, state/provincial, or national laws and regulations related to chemical storage, handling, and disposal.
Laser Safety

**WARNING**

**BRIGHT LIGHT HAZARD.** LabChip GX Instruments contain Class 3B laser diodes. The LabChip GX is classified as a Class 1 device because the lasers are appropriately enclosed (embedded) and indicated with Warning labels.


<table>
<thead>
<tr>
<th>Class 1 Laser Product</th>
</tr>
</thead>
</table>

635 nm (visible red) laser source, 10 mW maximum continuous (CW)

**WARNING**

- **Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous radiation exposure.**
- **NEVER remove back, side, or front panels of the instrument while the laser is powered. Panels (which, if removed, could lead to laser exposure) are marked with the labels shown below:**

![CAUTION](image)

- **These panels are intended to be removed for service only by qualified personnel; they are not intended to be removed during operation or for maintenance by users. The only removable maintenance panel is the lower panel at the back of the instrument, which can be removed to access the back of the robot, if cleaning is necessary.**
Electrical Safety

The LabChip GX is powered by a UL/CSA/VDE approved 100-240 VAC, 50/60 Hz input, 5, 15, 24 VDC output power supply. Additionally, the LabChip GX High Voltage circuitry is current-limited to non-hazardous levels. Users should observe the following:

**WARNING**

Do not open the instrument enclosure. There are no user serviceable parts inside.

The wall outlet or the power cable connector on the back of the instrument should be accessible after the system's installation, to enable trained service personnel to safely disconnect power from the system during servicing.

The computer supplied with the LabChip GX instrument has internal lithium batteries. Batteries should not be incinerated.

**WARNING**

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer's instructions.

Power Cord Selection

**United States and Canada**

The LabChip GX instrument is shipped with a NEMA 5-15 / IEC 320 power cord. If the power cord needs to be replaced, substitute power cords must be UL Listed, Type SJT or equivalent, minimum No. 18 AWG, 3-conductor with ground conductor that for safety considerations should never be disconnected or defeated. The cord’s plug to the wall must be a three-pin grounding type connector with a NEMA 5-15P (15A, 125V) plug configuration. The cord’s connector at the unit must conform to requirements for an EN 60 320/IEC 320 Standard Sheet C13 connector.

The equipment is intended to be plugged into a standard NEMA 5-15R receptacle in the wall.
International

All power cord sets must be approved by an acceptable, accredited agency responsible for evaluation in the country where the power cord set and system will be used.

The flexible cord must be Type H05VV-F, 3-conductor, minimum 0.75 - 1 mm² conductor size (230 volt input). Power cord set fittings that is, the appliance coupler and wall plug, must bear the certification mark of the agency responsible for evaluation in the country where it will be used. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet C13 connector for mating with appliance inlet on the system.

Fuses

The LabChip GX instruments do not contain any user replaceable fuses. Contact PerkinElmer Technical Support (see “Contact Us” on page 3) if blown fuses are suspected.

Mechanical Safety

The LabChip GX instruments have a three axis robot that moves quickly and can be a pinch hazard. Keep the front door of the instrument closed when the robot is moving. Keep hands away from the robot when not actually placing microplates in the instrument or changing the ladder and buffer vials. Robot access areas are marked with the following warning label:
# Table of Contents

**Preface** ................................................................. 2

**Instrument Safety** .................................................. 7

  - Required Training ............................................ 7
  - Chemical Safety .............................................. 8
  - Laser Safety ................................................... 9
  - Electrical Safety ............................................. 10

    - Power Cord Selection .................................. 10
    - Fuses ....................................................... 11
  - Mechanical Safety ........................................... 11

**Introduction** ......................................................... 18

  - Principles of Operation .................................. 19
  - Software Modes Available ............................. 21

**Operation** ............................................................. 22

  - Opening the LabChip GX Software ................. 23
  - Creating Desktop Shortcuts ......................... 23
  - Creating a New Assay .................................. 24
  - Running an Assay ......................................... 25
  - Select the Auto Export Settings .................. 29
  - Monitoring the Run ...................................... 30
  - Stopping a Run ............................................ 31
  - Continuing a Stopped Run ......................... 32
  - Saving Data Files ....................................... 33
  - Saving Workspace Files ............................... 34
  - Selecting Wells using a Sample Names File .... 35

    - Using a Barcode to Specify the Sample Names File .......... 36
  - Adding a New Plate ..................................... 38
  - Placing the Barcode on the Plate .................. 40
  - Calibrating the Optics ................................. 41

**Data Analysis** ....................................................... 42

  - How the Software Analyzes DNA Data ........... 43
  - How the Software Analyzes Protein Data ......... 45
  - How the Software Analyzes RNA Data .......... 49
  - How the Software Analyzes Glycan Data ....... 54
  - How the Software Analyzes Protein Charge Variant Data ... 57
  - How the Software Analyzes Genomic DNA Data .... 58
  - Organizing, Retrieving, and Backing Up Data Files ... 59
  - Opening a New Workspace ......................... 59
  - Opening a Data File .................................... 60
  - Adding a Collection to a Workspace .............. 61
  - Selecting the Wells in a Collection .............. 62

    - Using Sample Names Files ........................ 63

      - Create a Sample Name File ....................... 63
# Table of Contents

- Sample Name File Format (.CSV Format)................................. 65
- Applying Different Window Values to Expected Peaks of the Same Size in Different Wells ......................................................... 66
- Sample Name File Import Errors........................................... 66
- Using Expected Fragments/ Expected Proteins/ Expected Glycans ............ 67
  - Entering EFs, EPs, or EGs in the Assay Analysis Window ............... 67
  - Exporting EFs, EPs, or EGs .................................................. 68
  - Importing EFs, EPs, or EGs .................................................. 68
  - Forcing Expected Peaks ....................................................... 69
  - Viewing the EFs/EPs/EGs in the Graph View .................................. 69
  - Viewing the EFs/EPs/EGs in the Gel View .................................... 70
  - Viewing the EFs/EPs/EGs in the Well Table ................................... 71
  - Viewing the EFs/EPs/EGs in the Peak Table ................................... 71
- Modifying Analysis Parameters ................................................. 72
  - Changing the Peak Find Parameters ......................................... 73
  - Adding a Peak ........................................................................ 74
  - Excluding a Peak .................................................................... 74
  - Splitting a Peak ....................................................................... 75
  - Merging Two Peaks ................................................................... 75
  - Adjusting the Peak Baseline ...................................................... 76
  - Setting the Baseline for a Range of Peaks .................................... 76
  - Removing a Manual Baseline .................................................... 77
  - Selecting a Default Ladder ....................................................... 77
  - Using the Default Ladder for Alignment ..................................... 79
  - Exporting the Default Ladder in an Assay .................................... 79
  - Clearing the Default Ladder in a Plate ....................................... 79
  - Changing the Time Window for Analysis .................................... 80
  - Aligning or Unaligning the Marker Peaks ................................... 80
- Saving and Exporting Assays .................................................... 84
- Changing the View of the Data .................................................. 85
  - Viewing Gels .......................................................................... 85
  - Viewing Zero Baselines .......................................................... 86
  - Adjust Pane Widths ................................................................. 87
  - Show or Hide Views ................................................................ 87
  - Zoom In and Zoom Out ............................................................ 88
  - Viewing Graphs in the Overlay Electropherograms Tab .................. 89
  - Viewing Graphs in the Electropherograms Tab ............................. 90
  - Viewing Analysis Errors and Warnings ...................................... 92
  - Viewing Multiple Properties in the Well Table View ....................... 93
- Copying Information ................................................................... 94
- Reanalyzing a Data File ............................................................. 95
- Printing Workspace Information ............................................... 96
- Exporting Data ........................................................................... 102
  - Exporting Data Manually ........................................................ 105
- Using the GX Software to Analyze GX Touch Data ......................... 107
- Understanding Peak Finding ..................................................... 108
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Smoothing</td>
<td>108</td>
</tr>
<tr>
<td>Peak Detection - Slope Threshold</td>
<td>109</td>
</tr>
<tr>
<td>Peak Splitting - Inflection Threshold</td>
<td>112</td>
</tr>
<tr>
<td>Peak Identification</td>
<td>113</td>
</tr>
<tr>
<td><strong>Software Security</strong></td>
<td>114</td>
</tr>
<tr>
<td>Locking and Unlocking the Software</td>
<td>116</td>
</tr>
<tr>
<td>Managing User Accounts</td>
<td>117</td>
</tr>
<tr>
<td>Adding New Users</td>
<td>118</td>
</tr>
<tr>
<td>Changing User Information</td>
<td>119</td>
</tr>
<tr>
<td>Printing User Information</td>
<td>120</td>
</tr>
<tr>
<td>Activating and Deactivating User Accounts</td>
<td>120</td>
</tr>
<tr>
<td>Changing Access Rights</td>
<td>121</td>
</tr>
<tr>
<td>Printing Access Rights</td>
<td>122</td>
</tr>
<tr>
<td>Setting Policies for User Accounts</td>
<td>123</td>
</tr>
<tr>
<td>Printing User Policies</td>
<td>124</td>
</tr>
<tr>
<td>Electronic Signatures</td>
<td>125</td>
</tr>
<tr>
<td>Automatically Exporting Copies of Data Files</td>
<td>126</td>
</tr>
<tr>
<td>Reverting to a Specific Data File Revision</td>
<td>126</td>
</tr>
<tr>
<td>Audit Trail</td>
<td>127</td>
</tr>
<tr>
<td>Viewing the Audit Trail</td>
<td>128</td>
</tr>
<tr>
<td>Exporting the Audit Trail</td>
<td>129</td>
</tr>
<tr>
<td>Central Data Repository (CDR)</td>
<td>130</td>
</tr>
<tr>
<td>CDR Security Suggestions</td>
<td>130</td>
</tr>
<tr>
<td>Creating New Data Folders</td>
<td>131</td>
</tr>
<tr>
<td>Moving Data Files into Folders</td>
<td>131</td>
</tr>
<tr>
<td>Deleting Data Folders</td>
<td>131</td>
</tr>
<tr>
<td>Hiding Data Files in the CDR Manager Window</td>
<td>132</td>
</tr>
<tr>
<td>Showing Hidden Data Files in the CDR Manager Window</td>
<td>132</td>
</tr>
<tr>
<td>Remote CDR Server Backup</td>
<td>133</td>
</tr>
<tr>
<td>Setting Up the Remote CDR Server</td>
<td>133</td>
</tr>
<tr>
<td>Backing Up Data Files to the Remote CDR</td>
<td>135</td>
</tr>
<tr>
<td>Restoring Data Files from the Remote CDR</td>
<td>136</td>
</tr>
<tr>
<td>Viewing the Files in the Remote CDR Folder</td>
<td>137</td>
</tr>
<tr>
<td>Manually Backing Up and Restoring the CFR Files</td>
<td>138</td>
</tr>
<tr>
<td>Backing Up CFR Files</td>
<td>138</td>
</tr>
<tr>
<td>Restoring CFR Files</td>
<td>140</td>
</tr>
<tr>
<td><strong>Software Reference</strong></td>
<td>142</td>
</tr>
<tr>
<td>LabChip GX Main Window</td>
<td>143</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>144</td>
</tr>
<tr>
<td>Chip Status and Run Status</td>
<td>151</td>
</tr>
<tr>
<td>Error Message Area</td>
<td>153</td>
</tr>
<tr>
<td>Plate View or Plate List</td>
<td>154</td>
</tr>
<tr>
<td>Collection Pane</td>
<td>157</td>
</tr>
<tr>
<td>Graph View</td>
<td>158</td>
</tr>
<tr>
<td>Graph View Properties</td>
<td>164</td>
</tr>
<tr>
<td>Gel View</td>
<td>167</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Gel View Properties</td>
<td>170</td>
</tr>
<tr>
<td>Well Table View</td>
<td>172</td>
</tr>
<tr>
<td>Peak Table View</td>
<td>174</td>
</tr>
<tr>
<td>Peak Table Properties</td>
<td>179</td>
</tr>
<tr>
<td>Filter View</td>
<td>180</td>
</tr>
<tr>
<td>About LabChip GX Window</td>
<td>183</td>
</tr>
<tr>
<td>Add New Expected Peak Window</td>
<td>184</td>
</tr>
<tr>
<td>Add Plate Window</td>
<td>185</td>
</tr>
<tr>
<td>Assay Analysis Window</td>
<td>186</td>
</tr>
<tr>
<td>Assay Information Tab</td>
<td>187</td>
</tr>
<tr>
<td>Alignment Tab</td>
<td>188</td>
</tr>
<tr>
<td>Analysis Tab</td>
<td>189</td>
</tr>
<tr>
<td>Peak Find Tab</td>
<td>192</td>
</tr>
<tr>
<td>Expected Fragments/Proteins/Glycans Tab</td>
<td>196</td>
</tr>
<tr>
<td>Excluded Peaks Tab</td>
<td>198</td>
</tr>
<tr>
<td>Smear Analysis Tab</td>
<td>200</td>
</tr>
<tr>
<td>Titer Tab</td>
<td>202</td>
</tr>
<tr>
<td>Advanced Tab</td>
<td>205</td>
</tr>
<tr>
<td>Audit Trail Window</td>
<td>208</td>
</tr>
<tr>
<td>Audit Trail Export Window</td>
<td>209</td>
</tr>
<tr>
<td>Audit Trail Manage Columns Window</td>
<td>210</td>
</tr>
<tr>
<td>CDR Manager Window</td>
<td>211</td>
</tr>
<tr>
<td>CDR Server Utility Window</td>
<td>213</td>
</tr>
<tr>
<td>CDR Utility Window</td>
<td>214</td>
</tr>
<tr>
<td>Change Password Window</td>
<td>216</td>
</tr>
<tr>
<td>Data File Version Window</td>
<td>217</td>
</tr>
<tr>
<td>Event Viewer Window</td>
<td>218</td>
</tr>
<tr>
<td>Export Window</td>
<td>219</td>
</tr>
<tr>
<td>Installation Qualification Window</td>
<td>222</td>
</tr>
<tr>
<td>Layout Options Window</td>
<td>223</td>
</tr>
<tr>
<td>Login Window</td>
<td>224</td>
</tr>
<tr>
<td>New Collection Window</td>
<td>225</td>
</tr>
<tr>
<td>Optics Calibration Window</td>
<td>226</td>
</tr>
<tr>
<td>Perform Signature Window</td>
<td>228</td>
</tr>
<tr>
<td>Plate Information Window</td>
<td>229</td>
</tr>
<tr>
<td>Print Window</td>
<td>230</td>
</tr>
<tr>
<td>Print Validation Reports Window</td>
<td>232</td>
</tr>
<tr>
<td>Rename Collection Window</td>
<td>233</td>
</tr>
<tr>
<td>Robot Teaching Wizard</td>
<td>234</td>
</tr>
<tr>
<td>Welcome Window</td>
<td>235</td>
</tr>
<tr>
<td>Teach Robot Window</td>
<td>236</td>
</tr>
<tr>
<td>Teach the X, Y and Z Reference Positions Window</td>
<td>237</td>
</tr>
<tr>
<td>Verify a Plate Window</td>
<td>238</td>
</tr>
<tr>
<td>Verify Positions Window</td>
<td>239</td>
</tr>
<tr>
<td>Finished Window</td>
<td>240</td>
</tr>
<tr>
<td>Verify All Target Positions Window</td>
<td>241</td>
</tr>
<tr>
<td>Verify All Target Positions Correct Window</td>
<td>242</td>
</tr>
</tbody>
</table>
## Table of Contents

Run File Editor Window ................................................................. 243  
Run Info Window ........................................................................ 244  
Sample Name Editor Window ..................................................... 245  
Save Workspace As Window ...................................................... 247  
Select a Data File Window ......................................................... 248  
Start Run Window ...................................................................... 249  
  Run Tab ................................................................................ 250  
  Output Tab ......................................................................... 252  
  Advanced Tab ..................................................................... 254  
System Diagnostics Window ....................................................... 256  
Unlock Application Window ....................................................... 258  
Unlock Data File Window .......................................................... 259  
User Administration Window .................................................... 260  
  Create New User .................................................................... 261  
  Edit Users ............................................................................. 263  
  Show User Info ..................................................................... 264  
  De/Activate User ................................................................... 266  
  Define Access ....................................................................... 267  
  Set Policies .......................................................................... 269  
**LabChip GX Instrument Description** ........................................ 270  
  Front View ............................................................................ 270  
  Front Panel .......................................................................... 271  
  Rear Connectors .................................................................. 272  
  Optics .................................................................................. 273  
  Chip Pressure System ............................................................ 273  
  Barcode Reader .................................................................... 273  
  DNA, RNA, and Protein Chips ............................................... 274  
  Chip Cartridge ...................................................................... 275  
    High Voltage Interface .......................................................... 276  
  Microplate Carrier ................................................................ 277  
  USB Key for 21 CFR Part 11 Option ........................................ 277  
Specifications ............................................................................ 278  
  General ............................................................................... 278  
  Environmental ...................................................................... 278  
  Electrical ............................................................................. 278  
  Assay Voltage ...................................................................... 279  
  Chip Pressure ...................................................................... 279  
  Chip Temperature Control ..................................................... 279  
  Fluorescence Detection .......................................................... 279  
  Light Source (Red laser diode) ............................................... 279  
  Barcode Reader .................................................................... 279  
**Maintenance and Service** ...................................................... 280  
  Cleaning the Chip Cartridge .................................................. 281  
  Cleaning the Instrument Electrodes ......................................... 281  
  Cleaning Test Chip C .............................................................. 282  
**Troubleshooting and Diagnostics** ........................................ 283
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Searching for Events in the Events Tab</td>
<td>283</td>
</tr>
<tr>
<td>Viewing Current Events in the Events Tab</td>
<td>284</td>
</tr>
<tr>
<td>Viewing Past Events in the Events Tab</td>
<td>284</td>
</tr>
<tr>
<td>Error Messages</td>
<td>285</td>
</tr>
<tr>
<td>Device &lt;Name&gt; is Disconnected</td>
<td>286</td>
</tr>
<tr>
<td>Plate Carrier Motion Blocked</td>
<td>286</td>
</tr>
<tr>
<td>Home Timeout</td>
<td>286</td>
</tr>
<tr>
<td>Move Timeout</td>
<td>287</td>
</tr>
<tr>
<td>Pressure Leak Detected</td>
<td>287</td>
</tr>
<tr>
<td>Focus Failed</td>
<td>287</td>
</tr>
<tr>
<td>Maximum Samples Exceeded</td>
<td>288</td>
</tr>
<tr>
<td>Chip Primed for Different Assay</td>
<td>288</td>
</tr>
<tr>
<td>HV Check Failed</td>
<td>288</td>
</tr>
<tr>
<td>Current Leakage Check Failed</td>
<td>289</td>
</tr>
<tr>
<td>Chip Temperature Warning</td>
<td>289</td>
</tr>
<tr>
<td>Running Installation Qualification (IQ)</td>
<td>290</td>
</tr>
<tr>
<td>Running Operational Qualification (OQ)</td>
<td>290</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>291</td>
</tr>
<tr>
<td>Running the Diagnostics Tests</td>
<td>291</td>
</tr>
<tr>
<td>Description of Diagnostic Tests</td>
<td>292</td>
</tr>
<tr>
<td>Troubleshooting Assay Problems</td>
<td>298</td>
</tr>
<tr>
<td>Software Problems</td>
<td>298</td>
</tr>
<tr>
<td>Cannot Save a File</td>
<td>298</td>
</tr>
<tr>
<td>Computer Software Lock-Ups</td>
<td>299</td>
</tr>
<tr>
<td>Zipping the Log Files</td>
<td>300</td>
</tr>
<tr>
<td>Tips and Shortcuts</td>
<td>301</td>
</tr>
<tr>
<td>Glossary of Terms</td>
<td>302</td>
</tr>
<tr>
<td>PerkinElmer Product Warranty</td>
<td>330</td>
</tr>
<tr>
<td>PerkinElmer Software License Agreement</td>
<td>332</td>
</tr>
<tr>
<td>Index</td>
<td>336</td>
</tr>
</tbody>
</table>
Introduction

This manual includes general instructions for using the LabChip GX hardware and software. It includes general procedures for operating the system, analyzing the data, using software security to comply with 21 CFR Part 11 requirements, instrument maintenance, and hardware and software troubleshooting.

DNA, gDNA, RNA, Protein, Glycan, and Protein Charge Variant (CZE) Chip and Reagent Kits are available to run specific assays on the LabChip GX. The Assay Kits include the reagents and consumables required to run the specific assay. Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.

Assay User Guides

Assay User Guides provide information about the assay. Instructions for preparing the chip, the plate, the ladder vial, and the buffer vial are included in the LabChip GX/GXII Assay User Guide for the specific assay that you are running. Detailed information about the assays, including Specifications, Safety Warnings, Preparation Procedures, Expected Results, Troubleshooting, LabChip Kit Essential Practices, and Reordering Information is also located in the LabChip GX/GXII Assay User Guide for the specific assay that you are running.

The current version of the Assay User Guides can be accessed on the PerkinElmer web site at: www.perkinelmer.com/labchipguides.

Assay Quick Guides

Assay Quick Guides are included with each Assay Kit and include instructions for preparing the chip to run an assay.

The current version of the Assay Quick Guides can be accessed on the PerkinElmer web site at: www.perkinelmer.com/labchipguides.
Principles of Operation

The LabChip GX assays are based on traditional gel electrophoresis principles that have been transferred to a chip format. The chip format dramatically reduces separation time and provides automated sizing and quantitation information in a digital format.

The chip contains an interconnected set of microchannels that join the separation channel and buffer wells. One of the microchannels is connected to a short capillary that extends from the bottom of the chip at a 90-degree angle. The capillary sips sample from the wells of a microplate during the assay.

Some of the channels in the chip are larger than others. The larger channels contain buffer. During the chip preparation, the smaller channels and some of the wells are filled with sieving gel and buffer.

After the channels are filled, the chip functions as an integrated electrical circuit. The circuit is driven by the 7 electrodes in the electrode cartridge that contact solutions in the chip's wells when the chip holder is closed. Each electrode is connected to an independent power supply that provides maximum control and flexibility.

The polymer filling the smaller channels in the chip is designed to sieve DNA/RNA fragments or proteins by size as they are driven through it by means of electrophoresis, similar to using agarose or polyacrylamide gels. The sample and sieving buffers also contain a fluorescent dye that gets brighter upon binding to double-stranded DNA, RNA, or protein/SDS complex. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)
Principles of Operation (Continued)

In the chip, each sample is sipped from the microplate by negative pressure until a sufficient quantity is loaded in the chip. The sample is then moved electrophoretically into the central channel. As the fragments move down the central channel, they separate by size, and then pass the laser, which excites the fluorescent dye bound to the molecule. The LabChip GX software plots fluorescence intensity versus time and produces electropherograms for each sample (see Figure 2).

![Figure 2. Electropherogram](image)

The data can be viewed in a gel-like format on the Gel Tab to achieve the appearance of a slab gel. (The colors of the gel can be changed.)

![Figure 3. Gel View](image)
Principles of Operation (Continued)

For DNA, RNA, Protein, and Glycan assays, quantitating the concentration and accurately sizing each fragment are achieved by comparing against a sizing ladder and running internal standards or “markers” with each sample. Internal standards of known concentration are mixed with the sample to aid in quantitation.

The amount of sample sipped into the chip depends on pH, salt concentration, and buffer additives. The internal standards normalize these factors so that the software can use the ratio of the area of the curve of the standard to the unknown peak to determine concentration directly. The internal standards lie slightly outside the assay range so they do not interfere with analysis.

Capillary Zone Electrophoresis (CZE) is an electrophoretic separation technique used to evaluate the charge heterogeneity of proteins in a sample. For Protein Charge Variant assays, analytes are separated based on their net charges, with molecules with a higher net charge migrating faster than those with a lower net charge. The data is analyzed to calculate the % Relative Amount of the peaks.

Software Modes Available

The LabChip GX software has three modes available: Instrument, Simulation, and Reviewer. The mode can be selected when the LabChip GX software is installed.

**Instrument Mode** is used to control the LabChip GX instrument and to review data generated by the LabChip GX.

- The 21 CFR Part 11 Compliance option is a purchased option that can be used when the software is installed in Instrument mode.

**Simulation Mode** is used to simulate running an instrument and to review data generated by the LabChip GX.

**Reviewer Mode** is used to review data and develop assays, but does not control an instrument or display the instrument controls.

If the LabChip GX software is installed in Instrument mode, shortcuts can be created on the desktop to run the LabChip GX software in Simulation or Reviewer mode (see “Creating Desktop Shortcuts” on page 23).
Operation

This section includes general instructions for using the LabChip GX hardware and software to run an assay.

This section contains the following information:
• Opening the LabChip GX Software
• Creating Desktop Shortcuts
• Creating a New Assay
• Running an Assay
• Select the Auto Export Settings
• Monitoring the Run
• Stopping a Run
• Continuing a Stopped Run
• Saving Data Files
• Saving Workspace Files
• Selecting Wells using a Sample Names File
• Adding a New Plate
• Placing the Barcode on the Plate
• Calibrating the Optics

For assay-specific information, see the LabChip GX/GXII Assay User Guide for the specific assay that you are running. For instructions on preparing the chip and plate, see the LabChip GX/GXII Assay Quick Guide for the specific assay. The current version of the Assay User Guides and Quick Guides can be accessed on the PerkinElmer web site at: http://www.perkinelmer.com/labchipguides.

To run an assay in the LabChip GX:

1 Open the LabChip GX software. (See “Opening the LabChip GX Software” on page 23.)

2 If necessary, create a new assay. (See “Creating a New Assay” on page 24)

3 Clean the electrodes and the O-Rings as directed in the LabChip GX/GXII Assay User Guide.

4 If necessary, calibrate the optics (see page 41) and run Diagnostics (see page 291).

5 Prepare the chip for the assay as directed in the LabChip GX/GXII Assay Quick Guide.
6 Prepare the plate for the assay as directed in the LabChip GX/GXII Assay Quick Guide. (See “Placing the Barcode on the Plate” on page 40 if using barcodes on the sample plates.)

7 Run the assay. (See “Running an Assay” on page 25.)

Opening the LabChip GX Software

If the LabChip GX software was installed in Instrument mode, with or without the 21 CFR Part 11 security option, the desktop icon opens the software in Instrument mode. If desired, you can create shortcuts for Reviewer mode or Simulation mode as described below. If the LabChip GX software was installed in Reviewer mode, the desktop icon opens the software in Reviewer mode.

To open the LabChip GX software:

1 Double-click on the LabChip GX icon on the Windows desktop.

2 If 21 CFR Part 11 Security is installed, the Login Window opens. Type a valid LabChip GX user name and password into the text boxes and click the OK button. (For instructions on creating LabChip GX user names, see “Adding New Users” on page 118.)

The LabChip GX Main Window opens.

3 See “Creating a New Assay” on page 24 or “Running an Assay” on page 25.

Creating Desktop Shortcuts

If the LabChip GX software was installed in Instrument mode, you can create desktop shortcuts to run the LabChip GX software in Reviewer mode or Simulation Mode, if desired.

To create new software shortcuts on the Windows desktop:

1 Right-click on the LabChip GX icon on the Windows desktop and click Copy.

2 Right-click on the Windows desktop and click Paste. A copy of the LabChip GX icon is created on the desktop.

3 Rename the icon as desired.

4 Right-click on the new icon and click Properties.

5 On the Shortcut tab, enter the following in the Target text box:
6 Click **OK** in the Properties window.

**Creating a New Assay**

The LabChip GX software enables you to create a new assay by opening and editing an existing assay and then saving the assay with a new name.

To create a new assay:

1. On the **LabChip GX Main Window**, select **Tools → Assay Editor**. The Select Assay To Edit window opens.

2. Select the name of the Assay file that you want to edit and click the **OK** button. The **Assay Analysis Window** opens and displays the settings for the open assay.

3. Modify the settings as necessary for the new assay. (See **Modifying Analysis Parameters** or **Reanalyzing a Data File** for information on setting or changing analysis parameters.)

4. Click the **Save Assay** button at the bottom of the Assay Analysis window, specify the desired name for the new assay file, and click the **Save** button.
Running an Assay

If a new chip has been inserted in the instrument, the chip is automatically primed at the start of the first run. Since priming is a lengthy process, you can start priming the chip before you are ready to start the run. (To save time, the sample plate can be prepared while the chip is priming.)

To prime a chip before starting the run:

1. Select **Instrument → Start Prime** to start priming for a specific assay.

2. Select the assay in the Choose Assay for Chip Prime window and then click the OK button. (If the chip is not primed before starting the run, the chip is primed automatically when you click the Run button.)

To start an assay to read a plate:

1. Click the **Run** button on the LabChip GX Main Window (see page 143) to open the **Start Run Window**.

   If the maximum number of samples for the chip have already been run or if the chip was last primed for a different assay, a message displays instructions for resolving the problem.

2. Click the **Run tab** in the Start Run window.

3. Select the type of assay you want to run in the **Assay Type** drop-down list. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)

4. Type the operator's name in the **Operator Name** text box.

5. Select the name of the plate in the **Plate Name** drop-down list. To use a plate that is not listed in the Plate Name list, see “Adding a New Plate” on page 38.

6. To read the plate barcode, select the **Use Barcode** check box. (The plate barcode can be used to name the data file if selected.)
Running an Assay (Continued)

7 On the Plate diagram, select the wells to be sampled.
   • To select all wells and ladders on the plate, click the double-arrow button in the lower-right corner of the plate.
   • To select all rows on the plate, click the double-arrow button at the top left corner of the plate.
   • To select all columns on the plate, click the double-down-arrow button at the top right corner of the plate.
   • To select a single column, click the column number at the top or bottom of the plate.
   • To select or clear all wells in a quadrant, click the Q1, Q2, Q3, or Q4 button.
   • To select a single row, click the row letter on the left or right side of the plate.
   • Clear specific wells by clicking on a selected well.
   • To use a Sample Names file to select the wells, see “Selecting Wells using a Sample Names File” on page 35.

8 Select the desired sipping order for the selected wells, Row-wise, Column-wise, or File Order.

9 Click the Output Tab in the Start Run window.

10 To change the Data Path, either type the desired path or click the Browse button and select the desired location for the data files. Clicking the Default button restores the default data path.

NOTE

Data files should be saved to a local folder on the computer’s hard drive. Saving data files to a network drive may cause loss of data if the network connection is slow or interrupted.

11 If desired, select the Create Daily Sub-Directory check box to create a new sub-directory for data files each day.

12 If the 21 CFR Part 11 option is installed and you want to save a copy of the data files to a folder outside of the CDR or if the 21 CFR Part 11 option is not installed and you want to save a second copy of the data files, see “Automatically Exporting Copies of Data Files” on page 126.
Running an Assay (Continued)

13 To add the **File Prefix, Computer Name, Project Name, Barcode, Date**, and/or **Time** to the data file name, select or clear the desired check boxes or type the desired file prefix and project name. The file name components are added to the data file name in the order in which they are selected. Leave the text box blank to omit the File Prefix or Project Name from the file name.

14 To automatically export data tables, graphs, or gels, select the **Automatic Export** check box, click the **Auto Export Settings** button, and then select the desired Auto Export settings (see page 29).

15 Click the **Advanced Tab** in the Start Run window.

16 To perform the assay multiple times on the same plate, select the desired number of times to run the assay in the **Plate Cycles** text box.

17 To randomly sample a specific percent of the selected wells, select the **Random Selection** check box and specify the percent of wells to sample during the run.

18 To repeatedly run the selected wells and combine the data into one data file, select the **Sample Saver** check box and select the number of times to repeatedly run the selected wells in the **Repeats** text box.

19 To use a file to supply the sample names, click the **Browse** button next to **Sample Names File**, select the name of the .csv file that contains the sample names, and click the Open button. The path and name of the file displays in the text box.

   To use a Sample Names file to select the wells, see "Selecting Wells using a Sample Names File" on page 35.

20 To use a file to supply the Expected Peaks, click the **Browse** button next to **Expected Peaks File**, select the name of the .gep file that contains the expected peaks, and click the Open button. The path and name of the file displays in the text box. (See “Using Expected Fragments/ Expected Proteins/ Expected Glycans” on page 67 for more information.)

21 To use a file to supply the Excluded Peaks, click the **Browse** button next to **Excluded Peaks File**, select the name of the .gep file that contains the excluded peaks, and click the Open button. The path and name of the file displays in the text box.
22 Click the **Start** button to start the assay. A new workspace opens to display the data.

See “Monitoring the Run” on page 30 for information about viewing data during the run.
Select the Auto Export Settings

The Auto Export settings specify which views to automatically export at the end of each run and specifies the format for each view. Click the **Auto Export Settings** button in the **Output Tab** on the **Start Run Window** to open the **Export Window**.

To select the desired views to export:

1. Select the check boxes next to the views to export. Selecting **Export All** selects all check boxes.

2. For each selected view, to change the location for the files, click the **Browse (...)** button and select the desired location.
   
   If the default path is selected, the path displays in blue. If the path is not the default path, the path displays in purple. To set the path to the default, right-click on the path and select **Reset to Default**.

3. If **Raw Data** is selected, click the AIA Format check box to export in Chromatography Data Interchange Format or clear the check box to export in CSV format. If CSV is selected:
   - Select **Include Size Data** to align the data to the well's ladder (for one file per well) or to the first well (for a single data file) and include the size data in the exported data. (Not available for CZE assays.)
   - Select **Export Single Table** to export the data for all wells in the plate to one CSV file. If not selected, the data from each well is exported to a separate CSV file.

4. If **Gel** is selected:
   - a Select either **Single File** to include gels for all wells in the run in the same image file, or select **Separate Files** to export each gel to a separate image file.
   - b To adjust the contrast minimum and maximum values for all gels to a specific lane in the gel, choose the desired well in the Contrast Lane drop-down list. (Only available after the sample wells have been selected on the Run tab.)
   - c If desired, change the height, in pixels, of the exported gel graphics in the Height text box.

5. If either **Electropherogram** or **Gel** is selected, choose the desired format for the image files.

6. Click **OK** to save the Export settings. The specified files are exported at the end of the run.
Monitoring the Run

The following occurs after a run is started in the LabChip GX software:

1. The priming and warming steps are performed.
   - The priming step fills the channels of the chip with reagent. (Only performed if the chip holder has been opened since the last run.)
   - The warming step allows the heater plate located in the chip holder to regulate chip temperature to 30°C.
   - Data collection begins after the warming and priming steps are completed.

2. After the run begins, the **Start** button on the LabChip GX main window changes to **Stop**.

3. The **Active Data Tab** displays the electropherogram of the well currently being read. Data is saved to a file with the name shown above the plate diagram after each well is completed.

4. To view the results for individual wells as data is acquired or after the run is finished, click a well in the **Plate View or Plate List**, a sample name in the **Well Table View**, or a lane in the **Gel View**. Data from the selected well displays in the **Overlay Electropherograms Tab** and the **Peak Table View**. For more information on data analysis, see “Data Analysis” on page 42.

5. To stop the run before it is complete, see **Stopping a Run**.

6. When the assay is complete, **Run Successful** displays in the Status line.

7. If desired, remove the plate and/or remove the chip.

To save the analyzed data:

1. Select **File → Save Workspace**. The **Save Workspace As Window** opens with the default workspace name as the name of the data file.

2. If desired, change the location and/or the name of the workspace file and click the **Save** button. (Workspace files have a .gxw file extension.)

To view or re-analyze the data, see **Data Analysis**.
Stopping a Run

If you need to stop the run before it is complete, click the Stop button.

A message box confirms that you want to stop the run in progress.

Click Yes to stop the run. The Status line displays Run stopped by user.

Data for any completed wells displays in the LabChip GX Main Window.

To continue to read wells from an aborted run, see Continuing a Stopped Run.
Continuing a Stopped Run

If a run is stopped before it is complete, you can restart the run to finish the reading the plate. When you select the wells for the assay, you should select only the wells that were not read so that the reading starts with the well that was not completed.

To continue a run:

1. Click Start in the upper-left corner of the main window to open the Start Run Window.

2. Select the wells that were not read in the previous run, beginning with the well that was in progress when the run was stopped.

3. Select the same options for this run as were selected for the stopped run.

4. Click the Start button to begin.

The run starts with the well that was not completed in the previous run. A separate data file is created for the current run.
Saving Data Files

While running an assay, the raw time series data received from the instrument is automatically saved to the data file (.gxd), one well at a time as each well is completed. If a run is stopped before it is complete, the data for the completed wells is saved in the data file. The name of the data file is specified in the Output Tab on the Start Run Window.

The analysis settings for a plate are saved at the end of the data file (.gxd). If analysis settings are changed in the Assay Analysis Window and the data file is saved, the new settings are added to the end of the data file, but the previous settings are not overwritten. This enables a plate to be restored to previous analysis settings using the Restore Plate button in the Assay Analysis window.

If the 21 CFR Part 11 option is installed, data files are saved in the Centralized Data Repository (CDR). The CDR is a secure folder that can only be accessed by the LabChip GX software. The location of the CDR is specified in the CDR Utility Window.

Updated analysis settings are saved when the plate data file is saved. To save the data file, either:

• select Workspace → Save Plate on the Menu Bar,
• right-click on the plate name in the Plate View and select Save Plate, or
• select File → Save Workspace or File → Save Workspace As on the Menu Bar. (See Saving Workspace Files for more information.)

If the 21 CFR Part 11 option is installed and Require Signature on File Update is selected in the Set Policies tab on the User Administration Window, the user must have signature rights to save an updated data file. If the data file is locked, a user with Unlock rights must unlock the data file before changes can be saved.

To save the data file when the 21 CFR Part 11 option is installed and Require Signature on File Update is selected:

1 The Perform Signature Window opens when you save a data file.
2 Select the name of the user who is signing the data file in the Username drop-down list.
3 Type a Comment that meets the requirements of the compliance policies.
Saving Data Files (Continued)

4 If appropriate, select the desired Approval State.

5 If desired, select the Lock check box to lock the data file and prevent it from being changed.

6 Type the User Password for the signing user.

7 Click the Sign button. The Signature Performed window confirms that the signature has been performed.

8 Click the OK button. The signature is recorded in the data file.

Note

![Warning]

Changing the analysis settings and saving the plate data file does not change the raw data from the run. Only the display of the data is changed.

If you change the analysis settings without saving the new settings, and then try to close the workspace, exit the software, or acquire new data, you are prompted to save the changes. Selecting Yes opens the Save Workspace As Window.

Saving Workspace Files

When viewing plate data in the LabChip GX main window, you view the selected data files in a Workspace. When a new run starts, a new blank workspace opens, which contains the data file for the plate in the run. After the run is complete, saving the workspace saves the data file with the current analysis settings. (See Saving Data Files for more information on the contents of the data files.)

The Data Files are not saved in the Workspace file. The workspace file contains links to the revision of the data file that was last open in the collection. If a Workspace file is moved to another folder or computer, the data files must be moved with the Workspace file. The data files must be in the same location relative to the Workspace file as they were, otherwise you are prompted to find the missing data files when you open the Workspace file. It is a good practice to save the workspace files in the same location as the data files that are included in the workspace.

Saving a Workspace file automatically saves any changes to the data files that are open in the workspace, and the settings for each collection in the workspace.
If the 21 CFR Part 11 option is installed, saving Workspace files does not require permission to save data files unless the data files in the workspace have been modified.

**Selecting Wells using a Sample Names File**

The wells to be sampled during the run can be selected using a Sample Names file. When using a Sample Names file to select the wells, only wells with an entry in the Sample Names file are selected for sampling. The format must match the file format described in “Sample Name File Format (.CSV Format)” on page 65.

The Sample Names file used to select the samples contains one row for each well to be sampled, and does not contain rows for wells that are not sampled.

Using the Sample Names file in Figure 4 to select the wells in the run will select wells A1, A5, A11, A12, B1, B2, F5, and F6 for sampling.

![Figure 4. Sample Names File for Selecting Samples](image)

**Figure 5. Selected Wells on Run tab in Start Run Window**

This Sample Names file cannot be created in the Sample Names Editor window because the files created in the Sample Names Editor window always contain one row for each well in the plate. The Sample Names files for selecting wells are typically created by a LIMS or can be created in Microsoft Excel.
To select the wells using a Sample Names file:

1. Create the sample names file with one row for each well to be sampled.
2. Click the Run button on the LabChip GX Main Window. The Start Run Window opens.
3. Click the Advanced Tab.
4. Click the Browse button (...) next to the Sample Names text box, select the sample names file, and click the Open button.
5. Select the Use this file for sample selection check box.

![Figure 6. Use This File For Sample Selection](image)

6. Click the Run Tab.
7. Select the desired Sipping Order: Row-wise, Column-wise, or File Order. (See page 250 for details.)
8. Select any other run parameters as desired, and then start the run.

**Using a Barcode to Specify the Sample Names File**

When using a LIMS, a Sample Names File can be specified by using the plate barcode as the name of the file. The Sample Names file is read at run-time, after reading the plate barcode.

To use the plate barcode as the name of the Sample Names file:

1. Decide on a location and file name format for the Sample Names files. For example, the Sample Names files can be named “Sample Names” followed immediately by the barcode on the plate.
2. Create a temporary CSV file, using “%barcode%” as a placeholder for the barcode string. For example, create a temporary file named “Sample Names%barcode%.csv” and save it in the location where the actual sample names files for the runs will be saved.
3. In the Run File Editor Window, select the desired run parameters.
4 On the Advanced tab, click the **Browse** button next to **Sample Names File**, and select the CSV file that contains the %barcode% wildcard. The **Use this file for Sample Selection** check box is automatically selected when the sample names file contains the string %barcode%.

5 On the Run tab, select the desired **Sipping Order**: Row-wise, Column-wise, or File Order.

6 Click the Export button and save the Run file.

7 To start the run, click the **Run** button. The **Start Run Window** opens.

8 Click the **Import** button and select the saved Run file.

9 When the run is started, the plate barcode is read and the Sample Names file with the corresponding barcode is used to select the wells to sample. In the example above, if the plate barcode is 12345, then the file named “Sample Names12345.csv” will be used to select the wells in the run.
Adding a New Plate

When using a plate other than the plates specified in the Start Run Window, you must create a new plate in the Plate Information Window. Use caution adding new plates. Entering wrong values in the Add Plate Window can result in damaged chips and broken sippers.

It is best to use the plate specifications provided by the plate manufacturer. If the specifications are not available, measure the plate with a caliper. Many plates have a large variation in the Z-axis location of the well bottom.

Make sure the Sip Height has enough margin to accommodate this variation:

- Minimum Sip Height is 2.5mm.
- Maximum Sip Height depends on the sample volume.
- Sip Height of 4mm is probably safe.

To add a new plate:

1. Select Tools → Plate Editor to open the Plate Information Window.
2. Click the Custom Plates tab.
3. Click the Add Plate button. The Add Plate Window opens.
4. Type the settings for the new plate. The diagram on the Add Plate window shows the location for each measurement. Acceptable plate parameters are:
   - PlateHeight: 0 to 16mm
   - WellDepth: 0 to 36mm
   - SipHeight >= 2mm
   - (WellDepth – SipHeight) <= PlateHeight
5. Click the OK button.
6. Perform a Punch Test from the Plate Information window to verify the new plate settings are acceptable.
   - With a piece of the tape provided by PerkinElmer, cover the corner wells on the plate.
   - Use an old, dead chip with a good sipper.
   - In the Plate Editor, select the new plate name and click the Verify Plate button.
   - Follow the onscreen instructions.
Adding a New Plate (Continued)

• The instrument will move to the specified number of wells in each corner of the plate, punching holes in the tape.
• The Punch test is acceptable if the punched hole is >0.5mm from the edge of the well.

>0.5mm from edge

• Holes will never be perfectly centered.

Possible sources of errors:
• Sipper splay
• Plate tolerances
• Robot alignment error
  • If the holes are too close to the edge (<0.5mm), adjust the X-Margin or Y-Margin values in the Add Plate window.

7 Select the new plate name in the Start Run Window when starting the run.
Placing the Barcode on the Plate

*Figure 7* shows the size limits for the barcode label and the location on the microplate where the label should be placed. The barcode must be located on the short (portrait) end of the microplate, closest to well A1. If the barcode is not positioned properly, the barcode reader will not be able to read the barcode.

![Barcode Label Position Diagram]

*Figure 7. Barcode Label Position*
Calibrating the Optics

The LabChip GX software provides an Optical Calibration function using Test Chip C to calculate a correction factor for each individual LabChip GX instrument. The correction factor is applied to all samples run on the instrument to provide a common absolute fluorescence across different instruments.

See “Maintenance and Service” on page 280 for recommendations on optical calibration frequency. Optics Calibration should also be run if the Optics Calibration Test in the Diagnostics fails.

To calibrate the optics:

1 Insert Test Chip C in the instrument.

2 Select **Tools → Calibrate Optics** to open the **Optics Calibration Window**. The laser and Test Chip warming step starts. Warm-up takes 10 minutes.

3 Wait while the scan is performed. The scan takes 5 minutes. When the scan is complete, the correction factor is calculated and displays in the **New Correction Factor** text box.

4 To apply the new calibration factor to the instrument, click the **Apply** button. All future runs will be scaled by the new calibration factor.

Walk-Away Operation

After the scan has started, you can leave the instrument. At the end of the scan, the chip warming and laser are turned off after one minute, but the correction factor displayed in the window can be applied when the user returns to the instrument.

Correction Factor Beyond Calibration Limits Error

If the New Correction Factor is not within the factory-set limits, the text box displays a red background and an error message displays. Please contact PerkinElmer technical support (see page 3) to determine the problem.

Failed to Find Focus Point

If the focus point cannot be found during a scan, retry the scan. If the error still displays and another Test Chip C is available, try the scan with a different Test Chip C. The laser and chip warming remain on for one minute to allow you to retry the scan.
Data Analysis

After a run is complete, use the LabChip GX software to view and analyze the plate data. The LabChip GX software can open multiple data files in the same workspace to compare the data from different plates. Analysis settings can be changed for single wells, entire plates, or all plates in the workspace.

This section contains the following information:

- How the Software Analyzes DNA Data
- How the Software Analyzes Protein Data
- How the Software Analyzes RNA Data
- How the Software Analyzes Glycan Data
- How the Software Analyzes Protein Charge Variant Data
- How the Software Analyzes Genomic DNA Data
- Organizing, Retrieving, and Backing Up Data Files
- Opening a New Workspace
- Opening a Data File
- Adding a Collection to a Workspace
- Selecting the Wells in a Collection
- Using Sample Names Files
- Using Expected Fragments/ Expected Proteins/ Expected Glycans
- Modifying Analysis Parameters
- Saving and Exporting Assays
- Changing the View of the Data
- Copying Information
- Reanalyzing a Data File
- Printing Workspace Information
- Exporting Data
How the Software Analyzes DNA Data

The LabChip GX DNA Assay Analysis calculates the size and concentration of nucleic acid fragments. Results for each well are calculated after all data for that well has been read.

The data analysis process for DNA assays consists of the following steps:

1. Raw data is read and stored by the system for each individual well.

2. The data is filtered (see “Data Filtering” on page 307) and the resulting electropherograms of all wells are plotted.

3. Peaks are identified (see “Understanding Peak Finding” on page 108) for all wells and are tabulated by migration time. The settings of the peak find algorithm can be changed and the data can be reanalyzed after the run has finished. (See “Reanalyzing a Data File” on page 95.) The peak find settings can be changed for all wells or only for specific wells.

4. A sizing ladder (see Figure 8), which is a mixture of DNA fragments of different known sizes, is run first from the ladder vial. The concentrations and sizes of the individual base pairs in the ladder can be changed on the Analysis Tab.

Figure 8. Ladder Graph - DNA
How the Software Analyzes DNA Data (Continued)

5 The ladder is analyzed (see “Ladder Analysis” on page 311) and a standard curve of migration time versus DNA size is plotted from the DNA ladder by interpolation between the individual DNA fragment size/migration points. The standard curve derived from the data of the ladder well should resemble Figure 9.

Figure 9. Standard Curve Window - DNA

6 Two DNA fragments, the Lower Marker and Upper Marker, are run with each of the samples, bracketing the DNA sizing range. The Lower Marker and Upper Marker are internal standards used to align the ladder data with data from the sample wells. Figure 10 shows an example of assigned marker peaks in a sample well.

Figure 10. Markers - DNA
How the Software Analyzes DNA Data (Continued)

7 The standard curve and the markers are used to calculate DNA fragment sizes for each well from the migration times measured.

8 To calculate the concentration of the individual DNA fragments in all sample wells, the upper marker, in conjunction with a calibration curve plotting assay-specific concentration against base-pair size, is applied to the individual sample peaks in all sample wells.

If a titer is being used, the ladder is not used for quantization. Instead, peak sample areas are normalized using the upper marker and then quantization is performed using the titer standard curve to convert normalized area to concentration; see “Titer” on page 328.

NOTE

The software allows you to define upper and lower markers. Changing the markers causes quantitative changes in the calibration procedure, however, and therefore in the entire data evaluation.

How the Software Analyzes Protein Data

Protein assays are only supported on LabChip GX II instruments.

The LabChip GX Protein Assay Analysis consists of the following steps:

1 Raw data is read and stored by the system for each individual well.

2 The data is filtered (see “Data Filtering” on page 307) and the resulting electropherograms of all wells are plotted.

3 Peaks are identified (see “Understanding Peak Finding” on page 108) for all wells and are tabulated by migration time. The settings of the peak find algorithm can be changed and the data can be reanalyzed after the run has finished. (See “Reanalyzing a Data File” on page 95.) The peak find settings can be changed for all or only certain wells.
How the Software Analyzes Protein Data (Continued)

4 A sizing ladder (see Figure 11), which is a mixture of protein fragments of different known sizes, is run from the ladder vial before and after every 12 samples. The concentration and sizes of the individual proteins (in kDa) in the ladder can be changed on the Analysis Tab.

![Ladder Graph - Protein](image)

**Figure 11. Ladder Graph - Protein**

5 The ladder is analyzed (see “Ladder Analysis” on page 311) and a standard curve of migration time versus mobility is plotted from the ladder by interpolation between the individual protein size/migration points. The standard curve derived from the data of the ladder well should resemble Figure 12.
How the Software Analyzes Protein Data (Continued)

6 A **Lower Marker** is the internal standard used to align the ladder data with data from the sample wells. **Figure 13** shows an example of the assigned **Lower Marker** peak (marked LM) in a sample well.
How the Software Analyzes Protein Data
(Continued)

7 Before calculating either the protein size or concentration, the sample data is processed relative to the two ladders that bracket every 12 samples. First, all of the data is aligned to the lower marker and then stretched, relative to the highest molecular weight protein in the ladder.

8 The concentration of the sample proteins is determined relative to the bracketed ladders. There are seven proteins in the ladder (not including the lower marker). The ladder concentration can be changed on the Analysis Tab (see page 189).

9 If a titer is being used, the ladder is not used for quantization. Instead, peak sample areas are normalized using the lower marker and then quantization is performed using the titer standard curve to convert normalized area to concentration; see "Titer" on page 328.

NOTES

- The seven proteins are assumed to represent the average staining behavior of proteins and are used to determine an average peak area per μg/mL of protein. This factor is used to convert sample peak areas into relative concentration. The total relative concentration of all proteins is calculated by addition of the relative concentration of the individual proteins and is displayed in the Well Table View (see page 172).

- Since the conversion factor is determined for each ladder, the factor can be linearly interpolated for each sample and thus account for any assay drift.

- The software allows you to define the lower marker. Changing the selection of the marker will lead to quantitative changes in the calibration procedure, and therefore in the entire data evaluation.
How the Software Analyzes RNA Data

The LabChip GX RNA Assay Analysis determines the quality of the RNA sample by measuring the relative amounts of known RNA fragments relative to the total RNA present in the sample. Results for each well are calculated after all data for the well has been read.

The data analysis process for RNA assays consists of the following steps:

1. Raw data is read and stored by the system for each individual well.

2. The data is filtered (see “Data Filtering” on page 307) and the resulting electropherograms of all wells are plotted. The filtering algorithm settings can be changed and the data can be reanalyzed after the run is finished. (See “Reanalyzing a Data File” on page 95.)

3. A curve spline fit to the data is performed to generate a baseline above which RNA fragment peaks are detected. This baseline is displayed as a blue line on the electropherogram when Show Peak Baselines is selected in the Graph View Properties (see page 164).

4. Peaks extending above the baseline are identified (see “Understanding Peak Finding” on page 108) for all wells and are tabulated by migration time. The settings of the peak find algorithm can be changed and the data can be reanalyzed after the run has finished. The peak find settings can be changed for all or only certain wells.

5. A sizing ladder (see Figure 14), which is a mixture of RNA fragments of different known sizes, is run first from the ladder vial. The concentrations and sizes of the individual nucleotides in the ladder can be changed on the Analysis Tab.
How the Software Analyzes RNA Data (Continued)

6 The ladder is analyzed (see “Ladder Analysis” on page 311) and a standard curve of migration time versus RNA size is plotted from the RNA ladder by interpolation between individual RNA fragment size/migration points. The standard curve derived from the data of the ladder well should resemble Figure 15.

Figure 14. Ladder Graph - RNA

Figure 15. Standard Curve - RNA
How the Software Analyzes RNA Data (Continued)

7 A dye matching the lowest peak in the ladder is run with each of the samples. This lower marker, labeled LM in the RNA sample (see Figure 16) is used to align the ladder data with data from the sample wells.

8 The standard curve and the markers are used to calculate RNA fragment sizes for each well from the migration times measured.
The Total RNA present is computed by finding the area under the electropherogram trace. The baseline for this integration is a straight line starting at the end of the lower marker and ending at the baseline end time. The height of the baseline endpoints is computed from an average of a five second window around the baseline Start Time and End Time (shown on the Peak Find Tab). View the baseline by selecting Show Peak Baselines in the Graph View Properties. Adjust the Start Time and End Time by dragging the left (Start) and right (End) vertical dashed lines to areas that more properly reflect the signal baseline. (Right-click in the graph, select Set Scale, and change the X axis Minimum and Maximum values if the start and end times are not shown in the graph.)

The Total RNA concentration in the sample is computed from the ratio of the RNA area in the sample to the RNA area in the ladder multiplied by the ladder concentration specified in the assay.

If a titer is being used, the ladder is not used for quantization. Instead, peak sample areas are normalized using the lower marker and then quantization is performed using the titer standard curve to convert normalized area to concentration; see “Titer” on page 328.
How the Software Analyzes RNA Data (Continued)

11 Assay-defined RNA fragments are identified from the peaks in the peak table. Fragments are located by finding the largest peak within a size range associated with the fragment. For Eukaryote RNA assays, 5S, 18S and 28S fragments are located. For Prokaryote assays, 5S, 16S and 23S fragments are identified.

12 The following values are calculated for RNA assays:
   - **Fragment Area**: Area of each rRNA Fragment.
   - **% of Total Area**: Each Fragment area as a percent of total area.
   - **Corrected RNA Area**: Total RNA Area corrected with Lower Marker height.
   - **RNA Concentration (ng/ul)**: Estimated Total RNA Concentration in the sample.
   - **rRNA Area Ratio [28S / 18S]**: 28S area divided by 18S area.
   - **rRNA Height Ratio [28S / 18S]**: 28S height divided by 18S height or 23S height divided by 16S height.
   - **rRNA Fast Area Ratio**: Region between 5S and 18S or 16S, percent of total area.
   - **RNA quality metrics**: rRNA Area and Height Ratios (28S/18S or 23S/16S) and Fast/Total RNA area ratio are computed.

Figure 18. rRNA Graph Analysis

13 **Messenger RNA Assay**: The RNA contamination ratio is computed. This is the ratio of the area of all the fragments to total RNA area.
How the Software Analyzes Glycan Data

Glycan assays are only supported on LabChip GX II instruments.

The LabChip GX Glycan Assay Analysis consists of the following steps:

1. Raw data is read and stored by the system for each individual well.

2. The data is filtered (see “Data Filtering” on page 307) and the resulting electropherograms of all wells are plotted.

3. Peaks are identified (see “Understanding Peak Finding” on page 108) for all wells and are tabulated by migration time. The settings of the peak find algorithm can be changed and the data can be reanalyzed after the run has finished. (See “Reanalyzing a Data File” on page 95.) The peak find settings can be changed for all or only certain wells.

4. A sizing ladder (see Figure 19), which consists of multiples of a basic sugar molecule, is run from the ladder vial before and after every 12 samples. The simplest molecule is assigned a size unit of 1 CGU (Caliper Glucose Unit). The sequence of ladder peaks is assigned integer size values, providing a migration time to size ruler for sizing other sugar molecules.

5. The ladder is analyzed (see “Ladder Analysis” on page 311) and a standard curve of migration time versus mobility is plotted from the ladder by interpolation between the individual glycan/migration points. The standard curve derived from the data of the ladder well should resemble Figure 20.
How the Software Analyzes Glycan Data (Continued)

6 A **Lower Marker** is the internal standard used to align the ladder data with data from the sample wells. Figure 21 shows an example of the assigned **Lower Marker** peak (marked LM) in a sample well.
How the Software Analyzes Glycan Data (Continued)

7 The standard curve and the markers are used to calculate glycan sizes in each well from the migration times measured.

8 The area under each peak is calculated.

9 All the sample peak areas are added together and an area ratio is calculated for the %Area for each peak.

NOTES

• In Glycan assays, the lower marker does not precede all ladder peaks but appears between the 6th and 7th ladder peak. The concentration of the lower marker has been made sufficiently large to avoid confusion with ladder peaks. Since peaks before the lower marker are ignored, the ladder peaks used for the sizing ruler range from 7 to 13 CGU.

• The software allows you to define the lower marker. Changing the selection of the lower marker will lead to quantitative changes in the calibration, and therefore in the entire data evaluation.
How the Software Analyzes Protein Charge Variant Data

Protein Charge Variant assays are only supported on LabChip GX II instruments.

The LabChip GX Protein Charge Variant Assay Analysis consists of the following steps:

1. Raw data is read and stored by the system for each individual well.

2. The data is filtered (see "Data Filtering" on page 307) and the resulting electropherograms of all wells are plotted.

3. A baseline is generated for the data using the settings on the Peak Find tab on the Assay Analysis Window. This baseline is displayed on the electropherogram when Show Peak Baselines is selected in the Graph View Properties (see page 164).

4. Peaks are identified (see "Understanding Peak Finding" on page 108) for all wells and are tabulated by migration time. The settings of the peak find algorithm can be changed and the data can be reanalyzed after the run has finished. (See "Reanalyzing a Data File" on page 95.) The peak find settings can be changed for all or only certain wells.

5. The % Relative Amount for each peak is calculated as a percent of total area.
How the Software Analyzes Genomic DNA Data

The Genomic DNA (gDNA) assay analyzes data similar to the other DNA assays, except that the alignment of the sample data with the ladder data is based solely on the Lower Marker. To improve the accuracy of the alignment of the 12 samples between ladders, gDNA assays use the bracketed alignment described in “How the Software Analyzes Protein Data” on page 45.

For calculating concentration, the Genomic DNA assay uses a GQS Smear, starting at 0.175 kb and extending to 300 kb, by default (see Figure 22). The start size of the gDNA smear can be changed on the Advanced Tab in the Assay Editor window. The calculation of concentration is similar to that used for individual peaks, as described in How the Software Analyzes DNA Data; however, the GQS Smear is used in place of individual sample peaks, and the lower marker is used in place of the upper marker to normalize areas. The Total gDNA Concentration of each sample is reported in the Well Table.

The Genomic DNA assay also reports a Genomic Quality Score (GQS) for each sample in the Well Table. The GQS represents the degree of degradation of a sample, with 5 corresponding to intact gDNA and 0 corresponding to highly degraded gDNA. The GQS is calculated using the size distribution of the sample.

Figure 22. Genomic DNA GQS Smear (in orange)
Organizing, Retrieving, and Backing Up Data Files

As you work in the LabChip GX software, it's a good practice to organize the LabChip GX files.

- Create a folder in which to save the data files. If desired, each person can save data files to their own subfolder to organize the data files.
- Save Workspace files in the same directory as the data files to prevent missing data files in the workspaces.
- Review the files periodically, even if only one person uses the LabChip GX software. Archive files you are no longer using but want to save to a backup disk, and discard unneeded files. Verify there is enough free space on the hard drive to save new plate data files. If you are using the 21 CFR Part 11 option, see “Software Security” on page 114 for backup options.
- Each user in the laboratory can specify a particular data file name prefix to easily differentiate data files.
- A new folder can be created each day to store the data from all runs. To automatically create the folders, select the Create Daily Sub-Directory check box on the Output Tab in the Start Run Window.

Opening a New Workspace

A workspace displays data from one or more plate data files from the same type of assay. Each workspace can contain one or more Collections to display the data.

To open a new workspace:

1 On the menu bar, select File ➔ New Workspace. If changes have been made to an open workspace, you are prompted to save any unsaved changes. A blank workspace opens in the LabChip GX Main Window.

To view data, see:
- Opening a Data File
- Adding a Collection to a Workspace
- Selecting the Wells in a Collection
- Modifying Analysis Parameters
- Saving and Exporting Assays
Opening a Data File

Open a data file to view the data, to compare the data to other data files in the same workspace, or to change analysis setting and view the reanalyzed data. Data files generated by the LabChip GX software have a .gxd file extension. Data files generated by the LabChip HT software, which have a .cla file extension, can also be opened in the LabChip GX software if the 21 CFR Part 11 option is not installed.

To open a data file:

1. Open a new workspace (see page 59) or a workspace that already contains compatible data files.

2. On the menu bar, select File ➔ Import Data File. If the 21 CFR Part 11 option is not installed, the Select a Data File Window opens. If the 21 CFR Part 11 option is installed, the CDR Manager Window opens.

3. Select the name of the data file to open and click the Open button. The selected data file is imported into the open workspace. Use Ctrl+click or Shift+click to select multiple files.
   • To select a .cla file, select CLA from the Files of Type drop-down list in the Select a Data File window. The selected .cla file is converted to a .gxd file, and the new .gxd file is imported into the open workspace. The new .gxd data file is saved in the same folder as the original .cla file. Any changes are saved to the .gxd file. The .cla file cannot be changed.

NOTE

After the .cla file is converted to a .gxd file, use the .gxd file in any workspaces. Re-importing the same .cla file will over-write the existing .gxd file and any analysis changes saved in the .gxd file will be lost.

4. If desired, right-click on the data file name in the Plate View or Plate List and select Rename Plate to change the name of the plate in the display. (If desired, select the Rename File to Match check box to change the name of the data file.)

5. Select the desired wells to view in each collection in the workspace (see page 62).

6. See “Modifying Analysis Parameters” on page 72 for information about changing analysis parameters.
Adding a Collection to a Workspace

Collections are used to specify the wells selected for view in each plate data file, the layout of the views in the Collection tab, and the display properties for each view in each collection.

To add a new collection to an open workspace:

1. On the menu bar, select **Collection → New Collection**. The **New Collection Window** opens.

2. Select the desired option for creating the new collection:
   - **Template** - Opens a new collection with the same settings as a saved collection template file.
   - **Blank Collection** - Opens a new template using the default collection settings.
   - **Current Collection** - Opens a new template based on the current settings in the currently open collection.

3. If no plates are open in the collection, choose the desired Assay Type for the collection: DNA, Protein, RNA, Glycan, CZE, or gDNA. (Protein, Glycan, and CZE are only supported on LabChip GX II instruments.) Only data files from the selected assay type can be imported into the workspace.

4. If desired, type a new name for the collection in the **Name** text box.

5. Click the **OK** button to open the new collection.
Selecting the Wells in a Collection

Each collection can display different wells or the same wells in different orders. To select the wells to display in a collection:

1. Select the collection where the wells will be displayed.

2. In the plate diagram in the Plate View, select the wells to display:

- **Select individual wells**: click on the well.
- **Select a block of wells**: click on the well in one corner and drag to the opposite corner well.
- **Select an entire row**: click the row letter at the left.
- **Select an entire row and the corresponding ladder**: click the row letter at the right (if the plate sip order is row-wise).
- **Select an entire column**: click the column number at the top.
- **Select an entire column and any corresponding ladder**: click the column number at the bottom (if the plate sip order is column-wise).
- **Select all the wells by rows**: click the button in the top left corner of the microplate.
- **Select all the wells by columns**: click the button in the top right corner of the microplate.
- **Select all ladder wells and microplate wells**: click the button at the bottom right corner of the microplate.
- **Select individual ladders**: click on the ladder.
- **Clear individual ladders**: right-click on the ladder and select Remove Ladder.
- **Select all ladder wells**: click the “L” icon at the bottom left corner of the microplate.
- **Clear individual wells**: right-click on the well and select Remove Well.

3. Save the workspace to save the wells selected in the collection.
Using Sample Names Files

Sample Names files are used to import sample names into a data file. The Sample Name file can also contain expected peaks. A sample names file can be selected in the Advanced Tab on the Start Run Window to assign the sample names and expected peaks as the assay is running. Before the run, a Sample Name file can also be used to select the wells and sipping order for the run (see “Selecting Wells using a Sample Names File” on page 35).

After the run is complete, you can use the Sample Name Editor Window to rename the samples or to import an existing sample name file. Sample name files are saved as .CSV files and can be edited with a spreadsheet program such as Microsoft Excel.

The Color, Name, and Display Property for an Expected Peak cannot be set in the Sample Name Editor window. When new Expected Peaks are created in the Sample Name Editor window, default values are assigned for these properties.

Create a Sample Name File

Sample Names files created in the Sample Name Editor contain a row for each well in the plate. To use the Sample Name file to select the wells in the run, manually create the CSV file in Microsoft Excel or use a LIMS to create the Sample Names file.

To create a Sample Names file to specify the sample names, comments, and Expected Peaks:

1. Select Tools → Sample Name Editor on the LabChip GX Main Window. The Sample Name Editor Window opens.

2. Modify the sample names as desired in the Sample Name Editor window.

3. Enter any desired comments for the samples in the Sample Comment column.

4. For DNA, gDNA, Protein, or Glycan assays, if desired, click the Edit Expected Peaks check box and enter the desired Expected Peaks and Window (%) in the columns. Separate each peak size or window value with a semi-colon (;). If only one Window % value is entered, the same value applies to all expected peaks. If multiple values are entered, separated by semi-colons, each expected peak will use the corresponding Window value. If more expected peaks are entered than Window values, the last Window applies to all remaining expected peaks in the list.
5 Click the **Export** button, navigate to the desired location for the file, type the desired name for the file, and click the **Save** button.
To import the sample names into a data file:

1. Open the data file in an open workspace in the LabChip GX Main Window.

2. Select **Tools → Sample Name Editor** on the LabChip GX Main Window. The Sample Name Editor Window opens.

3. Click the **Import** button, navigate to the file location, select the name of the .csv file that contains the sample names, and click the **Open** button.

   If a Sample Names file is imported into the Sample Name Editor window, rows are added for any wells that are not listed in the original Sample Names file. All wells are included in the new Sample Names file.

4. Click the **Apply** button in the Sample Name Editor window to apply the sample names to the active plate.

**Sample Name File Format (.CSV Format)**

The Sample Names created in the Sample Name Editor Window can be exported to a .CSV file. A .CSV file can also be created in Microsoft Excel or generated automatically with a LIMS to import the Sample Names into the data file.

**Figure 24** shows a Sample Names file open in Microsoft Excel.

A Sample Name .CSV file must use the following format:

**Column A:** The well label (A1 to P24). The wells labels can be entered in any order and do not need to cover the entire plate.

**Column B:** The desired sample name for each well.

**Column C:** A user comment to be added to the well properties.

**Column D:** A list of Expected Peak sizes for the well. This list is separated by semi-colons (;).
**Column E:** The search window size for each Expected Peak in column D as a % (10 = +/-10% of Expected Peak size). If all Expected Peaks use the same window size, enter a single value; otherwise enter unique values as a semicolon separated list. If fewer windows than EPs are entered, the last window applies to all remaining EPs in the list.

**Column F...** Any higher columns are ignored.

**Applying Different Window Values to Expected Peaks of the Same Size in Different Wells**

Only one Expected Peak of a particular size can exist in the assay analysis settings. If the same Expected Peak size with a different Expected Peak window is entered in the Sample Name Editor window, only the first Expected Peak is created. All other Expected Peaks of the same size use the same window as the first Expected Peak. To overcome this restriction, use Expected Peaks of slightly different sizes; e.g. 200, 200.1, 200.2, etc. to apply different windows to the same Expected Peak in different wells.

**Sample Name File Import Errors**

Any row in the .CSV file that does not match the expected format and cannot be interpreted is ignored. If none of the rows can be interpreted, usually because the first column does not contain the well label, the following error message displays: “No rows found matching format: label, name, comment, EP, window.”
Using Expected Fragments/ Expected Proteins/ Expected Glycans

You can track expected DNA fragments (EFs), proteins (EPs), Glycans (EGs), or peaks (EPs) for the samples in a DNA, gDNA, Protein, Glycan, or Protein Charge Variant assay, respectively. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.) You enter the EFs, EPs, and EGs in the Assay Analysis Window.

Entering EFs, EPs, or EGs in the Assay Analysis Window

1 Select **Analysis → Analysis Settings** on the Menu Bar. The Assay Analysis Window opens.

2 Click on the **Expected Fragments/Proteins/Glycans Tab**.

3 Click in the bottom (empty) row in the table.

4 In the **Size** column, type the size of the expected fragment (bp for DNA or kb for gDNA), protein (kDa), or glycan (CGU).

5 For CZE assays, type the time of the expected peak, in seconds, in the **Time** Column.

6 In the **Window (%)** column, if desired, change the tolerance value to allow for variations in the expected fragment/protein/glycan size or peak time. This value is specified as a percent of the expected size for that fragment/protein/glycan or time for a peak. The default is 10% for DNA, protein, and CZE, and 2.5% for Glycan.

   **Note:** If there are multiple peaks in the tolerance range, the largest peak is labeled as the expected peak, even if it is not the exact size specified. To change the peak identified as an expected peak, see “Forcing Expected Peaks” on page 69.

7 A default color is automatically assigned. To change the color, click on the color block in the **Color** column and select the desired color in the Color window.

8 If desired, change the name shown in the **Name** column.

9 If desired, change the **Property Displayed in the Well Table**. This setting specifies the property that will be displayed in the Expected Peak column for each expected peak listed in the Well Table View.
10 To align the data to one or more specific peaks, select the **For Aligning** check box. The data is realigned so the selected peaks match their aligned size. Note: Incorrect alignment settings can cause analysis errors.

11 To apply the expected peak only to specific wells, click in the **Apply to Wells** column. The Select Wells window opens. Click (or click and drag) to select the wells that you want to apply the expected peaks to, and then click the OK button.

12 To apply the EFs, EPs, or EGs to the active plate, click the **Apply** button.

13 To apply the EFs, EPs, or EGs to all plates in the workspace, click the **Apply Global** button.

**Exporting EFs, EPs, or EGs**

1 After the EFs, EPs, or EGs are entered in the **Expected Fragments/Proteins/Glycans Tab**, click the **Export** button at the bottom of the window. The Export Expected Fragments/Proteins/Glycans Window opens.

2 Navigate to the desired location for the file, type the desired name for the file in the File Name text box, and then click the **Save** button. A .GEP file is created to save the expected peak settings.

**Importing EFs, EPs, or EGs**

After an Expected Peak file (*.GEP) has been exported, you can import the settings into another plate or workspace.

1 With the plate open in a workspace, in the **Expected Fragments/Proteins/Glycans Tab**, click the **Import** button at the bottom of the window. The Import Expected Fragments/Proteins/Glycans Table window opens.

2 Navigate to the location of the file, select the name of the file to import, and then click the **Open** button. The expected peak settings are imported into the tab.

3 To apply the EFs, EPs, or EGs to the active plate, click the **Apply** button.

4 To apply the EFs, EPs, or EGs to all plates in the workspace, click the **Apply Global** button.
Forcing Expected Peaks

If there are multiple peaks in the tolerance range, the largest peak is labeled as the expected peak, even if it is not the exact size specified. If a different nearby peak should have been selected as the expected peak, you can specify which peak is labeled the expected peak.

1 In the Graph View, right-click on the peak that should be labeled as the expected peak.

2 On the shortcut menu, select Force Expected Fragment/Peak and then select the desired fragment or peak from the menu.

To clear a forced peak and revert to the default expected peak, right-click on the forced expected peak and select Clear Forced EP.

Viewing the EFs/EPs/EGs in the Graph View

Expected Fragments, Expected Proteins, and Expected Glycans are identified in the electropherogram by open triangles over the peaks. The triangles are the same color as specified in the Expected Fragments/Proteins/Glycans Tab.

To display the expected peak indicators in the Graph view:

1 Click the Properties tab on the right side of the Graph view to open the Graph View Properties.

2 To view the size of all expected peaks, select Expected Fragments, Expected Proteins, or Expected Glycan in one of the Annotation list boxes.

Figure 25. Expected Fragments
Viewing the EFs/EPs/EGs in the Gel View

Expected Fragments/Proteins/Glycans are indicated in the Gel View by colored lines. The color of the line matches the color specified in the Expected Fragments/Proteins/Glycans Tab.

To display the expected peaks in the Gel View:

1. Click the Properties tab on the right side of the Gel View to open the Gel View Properties.

2. Select the Show Expected Peaks check box.

To display the legend that identifies the colors and sizes of the expected peaks:

1. Click the Properties tab on the right side of the Gel View to open the Gel View Properties.

2. Select the Show Expected Peaks Legend check box.
Viewing the EFs/EPs/EGs in the Well Table

A column is added to the Well Table for each Expected Peak entered in the Expected Fragments/Proteins/Glycans Tab. The column displays the property selected in the Property Displayed in Well Table list in the Assay Analysis Window.

Viewing the EFs/EPs/EGs in the Peak Table

Expected Fragments, Expected Proteins, and Expected Glycans are identified in the Peak Table with the peak name displayed in the Type column.

![Figure 28. DNA Assay Peak Table](image)
Modifying Analysis Parameters

Some analysis parameters can be changed in the software to modify the data evaluation for sample analysis. The following procedures are included in this section:

• “Changing the Peak Find Parameters” on page 73
• “Adding a Peak” on page 74
• “Splitting a Peak” on page 75
• “Excluding a Peak” on page 74
• “Merging Two Peaks” on page 75
• “Adjusting the Peak Baseline” on page 76
• “Setting the Baseline for a Range of Peaks” on page 76
• “Selecting a Default Ladder” on page 77
• “Using the Default Ladder for Alignment” on page 79
• “Exporting the Default Ladder in an Assay” on page 79
• “Clearing the Default Ladder in a Plate” on page 79
• “Changing the Time Window for Analysis” on page 80
• Aligning or Unaligning the Marker Peaks

These settings can be changed after the run is complete or when reanalyzing a previously saved data file.
Changing the Peak Find Parameters

After data filtering, the peak find algorithm locates the peaks and calculates the local peak baselines. The algorithm begins by finding all the peaks above the noise threshold to determine the baseline, after which any peaks below the noise threshold are rejected. A local baseline is calculated for each peak to allow for baseline drift.

The following Peak Find parameters can be changed:

- Min Peak Height
- Min Peak Width
- Slope Threshold
- Inflection Threshold
- Start Time
- End Time
- Filter Width
- Baseline Plateau

To change the Peak Find parameters for all wells:

1. Select **Analysis → Analysis Settings** to open the Assay Analysis Window, and then click the **Peak Find Tab**.
2. Change the parameters as necessary at the top of the window.
3. Click the **OK** button to save the setting, reanalyze the data, and close the window.
   - Click the **Apply** button to apply the changes and reanalyze the data, but keep the Assay Analysis window open.
   - Click the **Apply Global** button to apply the settings to all plates in the workspace and reanalyze the data, but keep the Assay Analysis window open.

To change peak find settings for individual wells:

1. Select **Analysis → Analysis Settings** to open the Assay Analysis Window, and then click the **Peak Find Tab**.
2. In the Well drop-down list, select the well number that you want to change the settings for.
3. Change the settings at the bottom of the window under **Well Peak Find Settings** to change the settings for the selected well.
4. Click the **OK** button to save the setting, reanalyze the data, and close the window.
   - Click the **Apply** button to apply the changes and reanalyze the data, but keep the Assay Analysis window open.
Adding a Peak

You can manually add a peak in a region where a peak has not been identified.

1. In the Graph View, right-click at the top of the area where the peak is to be added. The area must be outside any previously identified peak and the cursor must be an up arrow.

2. Select Add Manual Peak from the shortcut menu. A new peak centered at the selected location is created.

3. If necessary, adjust the Peak Baseline.

Excluding a Peak

You can exclude any peak or fragment from being used in the analysis.

To exclude a peak:

1. In the Peak Table View, right-click on the peak to be excluded.

2. Select Exclude Peak from the shortcut menu. The Type for the peak changes to X (excluded), and the value is not used in the analysis.

3. Right-click on an Excluded Peak in the peak table and select Include Peak to include the peak in the data analysis.

OR

1. In the Graph View, right-click near the top of the peak to be excluded.

2. Select Exclude Peak from the shortcut menu. The Type for the peak changes to X (excluded), and the value is not used in the analysis.

3. Right-click on an Excluded Peak in the Graph view and select Include Peak to include the peak in the data analysis.
Splitting a Peak

If two poorly resolved peaks have been identified as a single peak, you can split the single peak into two separate peaks.

1. In the Graph View, zoom in as necessary to view the single peak.
2. Position the cursor inside the peak at the horizontal location where you want to split the peak. (The Split Peak option is not available if the cursor is an up arrow. Move the cursor until the peak is not selected.)

3. Right-click on the graph and select Split Peak on the shortcut menu. A new Manual Peak is created abutting the original peak.

Merging Two Peaks

If the analysis has defined two separate peaks, the two distinct adjacent peaks can now be merged into one peak. This will include the area of both peaks in the total concentration and %purity calculations.

To merge two adjacent peaks:

1. Exclude one of the peaks from the analysis, following the procedure “Excluding a Peak” on page 74.
2. Verify that Show Peak Baselines is selected in the Graph View Properties.
3. Click and drag the baseline of the remaining peak to include the area under the excluded peak.
Adjusting the Peak Baseline

The Peak Baseline can be manually adjusted in the Graph View.

1 In the Graph View, zoom in on the peak baseline. (If the peak baselines are not displayed, select Show Peak Baselines in the Graph View Properties to display the baseline for each peak.)

2 Click the triangle at one end of the peak baseline and drag to the desired location.

To reset the baseline to the original position, right-click near the baseline end point and choose Reset to Defaults.

Setting the Baseline for a Range of Peaks

A straight line can be drawn under multiple peaks to create a single baseline for all peaks above the straight line.

To draw a single baseline:

1 In the Graph View, zoom in on the peaks. (If the peak baselines are not displayed, select Show Peak Baselines in the Graph View Properties to display the baseline for each peak.)

2 Holding the SHIFT key, click at the point where the baseline will begin and drag to the desired end point of the baseline.

3 Release the mouse at the end of the baseline. The baselines for peaks that are entirely contained within the baseline span are adjusted to the new baseline.

To draw multiple baselines using Manual Baseline mode:

1 In the Graph View, zoom in on the peaks. (If the peak baselines are not displayed, select Show Peak Baselines in the Graph View Properties to display the baseline for each peak.)

2 Right-click on the graph, away from a peak, and select Manual Baseline on the shortcut menu.

3 Click and drag in the graph to draw manual baselines.

Note: Clicking and dragging in the graph does not zoom in while Manual Baseline mode is on. Clicking and dragging in the Gel View still zooms in when Manual Baseline mode is on.

4 To turn off Manual Baseline mode, right-click on the graph, away from a peak, and select Manual Baseline again.
Removing a Manual Baseline

To reset a manual baseline back to the original analyzed baseline:

1. Right-click on one end of the manual baseline and select **Reset to Analyzed Base** from the shortcut menu.

To reset all manual baselines:

1. Right-click on one end of a manual baseline and select **Reset All Peak Bases**.
2. Click **OK** in the Reset All Peak Bases window.

Selecting a Default Ladder

For DNA, gDNA, and RNA assays, a ladder in an assay can be defined as the default ladder. The default ladder can be used as the ladder for wells on the plate, can be applied to all of the plates in the open collection, or can be saved as the default ladder in a new assay.

To set a specific ladder on a plate as the default ladder for the plate:

1. With the plate data file open, select **Analysis** ➔ **Analysis Settings** to open the Assay Analysis Window, and then click the **Peak Find Tab**.
2. Under **Well Peak Find Settings**, in the **Well** drop-down list, select the ladder that will be defined as the default ladder.
3. Click the **Save as Default Ladder** button. (The Save as Default Ladder button only displays when a ladder is selected.)
4. Click the **Apply** button to save the default ladder settings. The **Analysis Tab** displays the ladder data in the Default Ladder table and the Markers table (see Figure 30 on page 78).
Selecting a Default Ladder (Continued)

5 The Ladder Peak Time and Area settings can be changed in the Default Ladder table, but default ladder peaks cannot be added or deleted and the ladder peak sizes cannot be changed.

6 The Marker Time, Height and Area can be changed in the Markers table.

7 Click the Apply button at the bottom of the window to save the changes to the active plate. Click the Apply Global button to apply the default ladder settings to all open data files in the collection. (This allows you to import the default ladder into a plate that does not include any good ladders on the plate.)

8 See “Using the Default Ladder for Alignment” on page 79 to align wells in the plate using the default ladder.
Using the Default Ladder for Alignment

For DNA, gDNA, and RNA assays, after the default ladder is selected for a data file, the default ladder must be assigned to the desired wells in the plate.

1. With the plate data file open, select Analysis ➤ Analysis Settings to open the Assay Analysis Window, and then click the Alignment Tab.

2. Select the Align Well Groups to Specified Ladder option.

3. For each group of wells under Align Well Group, select Default Ladder in the To Ladder column.

4. Click the Apply button to apply the changes to the active data file or click the Apply Global button to apply the changes to all data files in the current collection.

Exporting the Default Ladder in an Assay

The default ladder in a data file is included in the analysis settings for a new assay when the settings are exported as an assay. Exporting the assay enables you to use the default ladder in future runs.

1. After clicking the Apply or Apply Global button in the Assay Analysis Window, the Export as Assay button displays.

2. Click the Export as Assay button. The Export Assay Settings from Plate to Assay File window opens.

3. Select the desired location for the assay file, type the desired name for the assay file, and click the Save button.

4. Select the new assay in the Run Tab on the Start Run Window. The new data file will include the default ladder.

Clearing the Default Ladder in a Plate

To delete the default ladder for a plate and return the alignment to the ladder settings for the assay type:

1. With the plate data file open, select Analysis ➤ Analysis Settings to open the Assay Analysis Window, and then click the Analysis Tab.

2. Click the Clear Default Ladder button at the bottom of the Default Ladder table.
Changing the Time Window for Analysis

The **Start Time** and **End Time** parameters in the **Peak Find tab** define the time window within which peaks are found.

To change the Start Time and End Time parameters for all wells in the open assay:

1. Select **Analysis → Analysis Settings** to open the **Assay Analysis Window**, and then click the **Peak Find Tab**.
2. Change the parameters as necessary.
3. Click the **OK** button to save the setting, reanalyze the data, and close the window.
   - Click the **Apply** button to apply the changes and reanalyze the data, but keep the Assay Analysis window open.

Aligning or Unaligning the Marker Peaks

To perform data analysis for DNA, Protein, RNA, and Glycan assays, the LabChip GX software aligns marker peaks included in the sample wells with markers from the ladder.

- To view the unaligned data (spike rejected, filtered and baseline corrected), choose **Analysis → Turn Off Analysis**.
- To re-enable analysis, choose **Analysis → Turn On Analysis**.

The default setting for this function is enabled. Turning off the analysis displays the data without aligning the markers in the wells and the ladders.

![Figure 31. Data Before and After Alignment](image)
Upper and Lower Marker Peaks for DNA Assays

For each DNA sample, the upper and lower marker peaks are assigned first and then the data is aligned so that the well markers match the ladder markers in time, allowing the size and concentration of the sample peaks to be determined.

For DNA assays, the first peak is assigned to be the lower marker and is then offset to match the lower marker in the ladder. The upper marker is then assigned to the last peak in the sample well or to the peak nearest the ladder’s upper marker. The Upper Marker and Lower Marker are aligned to the ladder markers by resampling the well data in a linear stretch or compression using a point-to-point fit.

If the sample marker peaks are either more than twice as far apart or less than half as far apart as the ladder markers, they are assumed to be the wrong peaks, and analysis of the well stops, producing the error **Marker peaks not detected**.

In DNA assays, the height of marker peaks is assay dependent. Ladder peaks are analyzed to calculate a marker peak threshold that is used to locate the marker peaks in the sample wells. If the marker peaks found using this calculated method fail to align with those of a sample, the LabChip GX software will use the minimum peak height threshold setting instead (if this value is lower than the value for the marker peak). For example, the calculated threshold might be too high to find the sample's markers if they happen to be very small for some reason. Either no markers will be found or the wrong peaks will be assumed to be markers and these may not align with the ladder markers. Consequently, the software attempts to use the minimum peak height threshold that, if it is set low enough, will catch the real markers, allowing the sample to align.

If you get unexpected peaks in the ladder analysis or the markers have been set incorrectly, you can manually exclude peaks or set a peak to be used as a marker.

**NOTES**

- Excluding a peak or manually setting a peak to be an upper or lower marker for a DNA assay can cause errors with analysis.
- You can move the boundary between the Peak Table and the Graph view up or down to increase or decrease the size of the Peak Table, making it possible to see all of the results at once.

Right-clicking in the Peak Table View of a well of a DNA assay opens a shortcut menu with the following commands:
• Include Peak (only for peak type “?”)
• Exclude Peak
• Force Lower Marker
• Force Upper Marker
• Add Expected Peak

NOTE

You can also right-click on a peak in the Graph View to view the same menu.

Lower Marker Peaks in Protein or RNA Assays

For each protein or RNA sample, the first peak in the sample is designated as the Lower Marker. After all lower markers are assigned, the data is aligned so that the well markers match the ladder markers in time, allowing the size and concentration of the sample peaks to be determined.

If there are unexpected peaks in the ladder analysis or if the marker has been set incorrectly, you can manually exclude peaks or set a peak to be used as a marker.

NOTES

• Excluding a peak or manually setting a peak to be the lower marker can cause analysis errors.
• You can move the boundary between the Peak Table and the Graph view up or down to increase or decrease the size of the Peak Table, making it possible to see all of the results at once.

Right-clicking in the Peak Table View of a well of a Protein or RNA assay opens a shortcut menu with the following commands:
• Include Peak (only for peak type “Xsys” or “?”)
• Exclude Peak
• Force Lower Marker
• Force Expected Peak
Lower Marker Peaks in Glycan Assays

For each Glycan sample, the lower marker is added to the samples and ladders. The lower marker is identified because the concentration is much higher than the sample or ladder. After all lower markers are assigned, the data is aligned so that the well markers match the ladder markers in time, allowing the size and corrected area of the sample peaks to be determined.

If there are unexpected peaks in the ladder analysis or if the marker has been set incorrectly, you can manually exclude peaks or set a peak to be used as a marker.

NOTES

- Excluding a peak or manually setting a peak to be the lower marker can cause analysis errors.
- You can move the boundary between the Peak Table and the Graph view up or down to increase or decrease the size of the Peak Table, making it possible to see all of the results at once.

Right-clicking in the Peak Table View of a well of a Glycan assay opens a shortcut menu with the following commands:

- Include Peak (only for peak type “Xsys” or “?”)
- Exclude Peak
- Force Lower Marker
- Force Expected Peak
Saving and Exporting Assays

Assays are created by PerkinElmer and are included with the LabChip GX software. The instrument and software settings used to run each plate and to analyze the plate are contained in an assay (.asy or .asyx) file, which is selected at the start of the run in the Start Run Window. After each well is complete, the data is analyzed using the analysis settings in the assay file. If the default analysis settings often need to be modified for more optimal analysis, a new assay file can be created with the modified settings to be used on subsequent runs.

To save a modified assay:

1. Run a plate with the original assay file.
2. Modify the analysis settings for the plate as needed.
3. Right-click on the plate title in the Plate View or Plate List, select Export Assay, specify a name and location for the assay file, and click the Save button.
   -- OR --
   On the Assay Analysis Window, click the Export as Assay button, specify a name and location for the assay file, and click the Save button.
4. When running the next plate, select the new assay file in the Start Run window.

The procedure above can also be used to automatically include a set of expected peaks in the assay.
Changing the View of the Data

The views in the LabChip GX Main Window can be customized to display data according to the preferences of the user. These options do not change the raw data but provide different means of displaying the data.

To change the view in the main window, see:
- “Viewing Gels” on page 85
- “Viewing Zero Baselines” on page 86
- “Adjust Pane Widths” on page 87
- “Show or Hide Views” on page 87
- “Zoom In and Zoom Out” on page 88
- “Viewing Graphs in the Overlay Electropherograms Tab” on page 89
- “Viewing Graphs in the Electropherograms Tab” on page 90
- “Viewing Analysis Errors and Warnings” on page 92
- “Viewing Multiple Properties in the Well Table View” on page 93
- “Exporting Data Manually” on page 105

Viewing Gels

To compare the gels generated by the instrument, view the gels in the Gel View.

The color, width, and contrast of the gels can be changed using the Gel View Properties.

To rearrange gels, click on the column header (well name) and drag the well to the desired location. To hide a well, select the well and then click the (X) button on the column header, or right-click on the well in the Plate View or Plate List and select Remove Well.
Viewing Zero Baselines

All electropherograms produced with the instrument show some amount of background fluorescence. By default, the LabChip GX software enables the zero baseline function. To remove the zeroing, select **Analysis → Analysis Settings** to open the **Assay Analysis Window**, click the **Peak Find Tab**, and select the **None** check box under Baseline Algorithm.

![Figure 33. Zero Baseline On](image)

![Figure 34. Zero Baseline Off](image)
**Adjust Pane Widths**

The **LabChip GX Main Window** displays several different views of the data files open in the workspace. You can change the height and width of the views to make the views smaller or larger.

To adjust panes:

1. Place the cursor over the edge of the pane that you want to adjust. The cursor changes to a line with arrows on each end.

2. Click and drag up, down, left, or right. The pane is resized after you release the mouse button. The layout setting is saved as part of the collection.

3. To save the setting, save the workspace. To create new collections with the same settings, the collection can be saved as a collection template (see "Collection Menu" on page 146).

**Show or Hide Views**

The views displayed in the **LabChip GX Main Window** can be hidden to maximize other views in the main window.

To hide a view:

1. Select **Collection → Layout** on the LabChip GX Main window. The **Layout Options Window** opens.

2. Click on the location that is selected for the view to clear the selection. The view is hidden.

3. If a location (Left, Right, or Bottom) does not contain any views, the pane closes and the remaining panes enlarge to fill the space.

Note: The **Gel View** is always displayed and cannot be hidden.

To display a hidden view:

1. Select **Collection → Layout** on the LabChip GX Main window. The **Layout Options Window** opens.

2. Click on the desired location for the hidden view (Left, Right, or Bottom). If multiple views are displayed in the same location, use the tabs at the top of the location to switch between views.
Zoom In and Zoom Out

You can zoom in and out on data displayed in the Gel View and the Graph View. The Graph View and the Gel view both zoom to the same levels when either view is zoomed in.

To zoom in:

- Click and drag to enclose the region of interest. When you release the mouse button, the selected area enlarges to fill the view. In the Gel view, all lanes in the collection zoom to the same level.
- You can continue zooming in until you reach the maximum magnification (the graph will not zoom in any closer).
- Use the horizontal scroll bar under the graph to pan from left to right.

To zoom out:

- Right-click in the Graph view or Gel view and select Unzoom to go to the previous zoom setting or select Unzoom All to zoom out to the default view.

For more information, see Viewing Graphs in the Overlay Electropherograms Tab and Viewing Graphs in the Electropherograms Tab.
Viewing Graphs in the Overlay Electropherograms Tab

If the Overlay Electropherograms Tab is not open, select Collection ➔ Layout on the LabChip GX Main Window, select the location where you want to display the Overlay Electropherograms tab, and click the Apply button. The Overlay Electropherograms tab opens.

Data from multiple wells can be overlaid in the same graph for visual comparison. Click on one well, then hold down the CTRL key and click on the additional wells to view in the graph. Each peak graph is shown in a different color and line style with a legend at the top of the window. You can remove wells from the overlay by CTRL + clicking the corresponding wells (the bounding box disappears).

Use the Overlay Offset text box on the Graph View Properties to offset each of the graphs by the RFU value specified.
To add samples to the Overlay Electropherograms Tab, Ctrl + click on the sample that you want to add in the Plate View or Plate List, Gel View, Well Table View, or Peak Table View. Selected wells are identified by: dashed outlines around the selected gel lanes in the Gel view, light blue wells in the Plate view, and dark gray rows in the Well Table view and Peak Table view.

To remove a specific sample from the graph, Ctrl + click on the sample that you want to remove in the Plate View or Plate List, Gel View, Well Table View, or Peak Table View.

To display only one sample in the Overlay Electropherograms tab, click on one sample in the Plate View or Plate List, Gel View, Well Table View, or Peak Table View.

To view the point coordinates and size of the position of the cursor, hold down the CTRL or Shift key and move the cursor over the graph.

To view the point coordinates and slope of a point on the trace, hold down the ALT key and the CTRL key and move the cursor over the trace.

Viewing Graphs in the Electropherograms Tab

If the Electropherograms Tab is not open, select Collection → Layout on the LabChip GX Main Window, select the location where you want to display the Electropherograms tab, and click the Apply button. The Electropherograms tab opens.

![Figure 37. Electropherograms Tab with Multiple Graphs](image-url)
Data from multiple wells can be displayed in the same tab for visual comparison. A separate graph for each well in the collection is displayed in the Electropherograms tab. The data file name and well name display at the top of each graph. If all of the wells are not visible, use the scroll bar on the tab to scroll through the wells in the collection.

**Zooming in or out** on one graph zooms all of the graphs in the tab to the same zoom level.

**To only display the wells selected in the** Gel View or Well Table View, select the Graph Selected Gels Only check box in the Graph View Properties.

**To move the graphs in the tab,** in the Gel View click and drag the well to the desired position.

**To change the number of graphs displayed in the tab,** select the desired number of Rows and Columns of graphs to display in the Graph View Properties. Selecting 8 Rows by 12 Columns displays an entire 96-well plate.

**To view the point coordinates and size of the position of the cursor,** hold down the CTRL or Shift key and move the cursor over the graph.

**To view the point coordinates and slope of a point on the trace,** hold down the ALT key and the CTRL key and move the cursor over the trace.
Viewing Analysis Errors and Warnings

Analysis errors and warnings are indicated by red or yellow exclamation points in the wells in the Plate View or below the headers in the Gel View. The details of the error or warning can be displayed in the Well Table View. After the Analysis Error column is added to the Well Table, the analysis error text can be displayed in the Electropherograms Tab or the Overlay Electropherograms Tab.

Viewing Analysis Errors and Warnings in the Well Table

To view the details of an analysis error or warning, display the Analysis Error in the Well Table View.

1. Click the Well Table tab.
2. Right-click in the table header. The Select Well Table Columns Window opens.
3. In the Available Columns list, select Analysis Error.
4. Click the Right Arrow button to move Analysis Error to the Selected Columns list.
5. If desired, click and drag Analysis Error to the desired column location. (The top column in the list is the first column in the table.)
6. Click the Save button.

Viewing Analysis Errors and Warnings on the Graphs

The text of analysis errors and warnings can be displayed on the graphs in the Electropherograms Tab or the Overlay Electropherograms Tab. The Analysis Error columns must be displayed in the Well Table to be available for selection in the Graph View Properties.

1. Click the Electropherograms Tab or the Overlay Electropherograms Tab.
2. Click the Properties tab on the right side of the graph. The Graph View Properties tab opens.
3. Select Analysis Error in the Well Annotation drop-down list.
4. If desired, click the Well Annotation Location button to change the location.
5. Click off of the Graph View Properties tab to close the tab.
Viewing Multiple Properties in the Well Table View

Properties for Expected Peaks and Smears display in the Well Table View. When entering the settings in the Expected Fragments/Proteins/Glycans Tab or the Smear Analysis Tab on the Assay Analysis Window, the property to display in the well table is specified in the Property Displayed in Well Table column.

To display multiple properties for the same Expected Peak or Smear in the Well Table:

1. In the Expected Fragments/Proteins/Glycans tab, or the Smear Analysis tab, enter the properties for the expected peak or smear, selecting one of the desired properties in the Property Displayed in Well Table column.

2. Click in the next row and type the same name as an existing EP or smear in the Name field of the table. The row will automatically update with the same entries as the original row. The only field that can be changed is the Property Displayed in Well Table column.

3. Change the Property to the desired selection.

4. Repeat until all desired properties have been added to the table.

5. Click the Apply button to display the new columns in the Well Table. Duplicate properties in the table will be removed when the settings are applied to the plate.
Copy the information

The Edit menu and some of the right-click pop-up menus offer the following choices for copying information from the LabChip GX software for use with other applications, depending on the selection:

- Copy Gel
- Copy Lane
- Copy Graph
- Copy Rows to Clipboard
- Copy Column to Clipboard

Choosing any of these commands places a copy of the selected item on the computer's clipboard. You can then paste the item into a word processing, graphics, or other program.

Choosing Copy Gel copies all of the wells displayed in the Gel View with the labels as part of the graphic. To copy a gel, right-click in the Gel View and choose Copy Gel.

Choosing Copy Lane copies the selected well in the Gel View with the labels as part of the graphic. To copy a gel, right-click in the Gel View and choose Copy Lane.

Choosing Copy Graph copies the graph displayed in the Graph View. The size of the image that is placed on the clipboard when copying a graph is the same size as the graph displayed in the software.

Copying rows from the Peak Table View or the Well Table View places ASCII information from the selected row or rows on the clipboard. To copy a row or multiple rows, select the desired rows in the table, right-click on one of the selected rows, and select Copy Rows to Clipboard.

Copying columns from the Well Table View is only available for certain columns in the table. To copy a column, select a single cell in the column, right-click on the cell, and select Copy Column to Clipboard.
Reanalyzing a Data File

Occasionally you may need to open and view or reanalyze a data file that was run and saved previously. The raw data values are saved in the plate data file, along with the original analysis settings that were chosen for the run and any changed analysis settings. This enables you to reanalyze the data with new settings or to view previously saved settings.

The following analysis parameters can be changed:

- Plate peak find settings and Well peak find settings (see “Changing the Peak Find Parameters” on page 73)
- Sample names and comments (see “Using Sample Names Files” on page 63)
- Add a Peak (see “Adding a Peak” on page 74)
- Exclude peaks from analysis (see “Excluding a Peak” on page 74)
- Reassign upper/lower markers (see “Upper and Lower Marker Peaks for DNA Assays” on page 81 or “Lower Marker Peaks in Protein or RNA Assays” on page 82)
- Alignment or no alignment with ladder peaks (see “Aligning or Unaligning the Marker Peaks” on page 80)
- Assay - you can save the changed settings under a new assay name, if desired (see “Saving and Exporting Assays” on page 84)

To reanalyze a data file:

1. Open the workspace that contains the plate data (see page 59).
2. Change the analysis parameters (see list above) as needed.
3. When you click the Apply, Apply Global, or OK buttons in the Assay Analysis Window, the data is automatically re-analyzed and the updated information is displayed.
4. To view previous analysis settings, click the Restore Plate button at the bottom of the Assay Analysis window and select the version to view.
Printing Workspace Information

Choosing File → Print opens the Print Window to select the information to print from the open workspace. The selected information can be printed to a printer or to a PDF file. If the workspace contains multiple collections, information from the active (selected) collection is printed.

The header of each printout contains the workspace name, the collection name, and the page number. The footer of each printout contains information about the LabChip GX software, data file, assay, and instrument. If the 21 CFR Part 11 option is installed, the footer also includes the data file version, signed state, and lock state.

The following information can be printed for the open workspace:

- **Print All**
- “Gel” on page 97
- “Electropherogram” on page 97
- “Overlay Electropherogram” on page 98
- “Well Table” on page 99
- “Peak Table” on page 100
- “Multiple Electropherogram” on page 101

See below for descriptions of each option.

**Print All**

This option prints the results of the assay in all of the available formats. The page layout depends on the options selected in Print Settings.
Gel

This option prints a gel image with the lanes marked by the sample name.

![Figure 38. Printed Gel](image)

Electropherogram

Choosing this option prints an individual electropherogram of each of the selected wells.

![Figure 39. Printed Electropherogram](image)
Overlay Electropherogram

Choosing this option prints one graph with the electropherograms for all of the selected wells overlaid onto a single graph.

**Figure 40. Printed Overlay Electropherogram**
Well Table

Choosing this option prints the columns displayed in the Well Table View. To change the columns that are printed or the order of the columns, change the columns in the Well Table View.

- Selecting the **Add Border** check box prints the table with a border around each cell in the table.
- Selecting the **Add Well Name as Header** check box prints the well name, well label, and sample name at the top of the page.
- Selecting both the Well Table and the Peak Table prints each well on a separate page with the Well Table row at the top of the page and the Peak Table for the well below it.

![Printed Well Table](image)

**Figure 41. Printed Well Table**
Peak Table

Choosing this option prints the columns displayed in the Peak Table View. To change the columns that are printed or the order of the columns, change the columns in the Peak Table View.

- Selecting the **Exclude Marker** check box removes all markers from the printout.
- Selecting the **Add Border** check box prints the table with a border around each cell in the table.
- Selecting the **Add Well Name as Header** check box prints a well header (plate name, well name, and sample name) before the peaks in each well.
- Selecting the **Per Page** or **Per Well** option for the Column Header specifies whether the Peak Table column headers are printed only at the top of each page (default), or if the headers are also printed at the beginning of each new well table.
- Selecting both the Well Table and the Peak Table prints each well on a separate page with the Well Table row at the top of the page and the Peak Table for the well below it.

![Figure 42. Printed Peak Table](image-url)
Multiple Electropherogram

Choosing this option prints the selected electropherograms or the entire collection of electropherograms, in the specified number of rows and columns per page.

Figure 43. Printed Multiple Electropherograms
Exporting Data

Data from a Peak Table, Well Table, Gel, or Graph can be exported automatically and/or manually. Options selected for automatic export do not affect manual export options, and vice versa.

- To automatically export data during the run, select the desired settings in the Start Run Window as described in “Select the Auto Export Settings” on page 29.
- To manually export data, see “Exporting Data Manually” on page 105.

Peak Tables, Well Tables, and Raw Data are exported to .CSV files, which can be imported into a spreadsheet program such as Microsoft Excel.

Gel and Graph data is exported to the selected image format.

This section shows export examples for the following:

- Peak Table
- “Raw Data” on page 103
- “Gel” on page 104

Peak Table

ASCII text file that contains the data in all columns in the Peak Table. Figure 44 is an example of part of a Peak Table file exported from a DNA assay (data truncated for this example):

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Plate Name</td>
<td>Sample Name</td>
<td>Size [BP]</td>
<td>Conc. (ng)</td>
<td>% Purity</td>
<td>Expected</td>
<td>Type</td>
<td>Molarity (nmol/L)</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>?</td>
<td>?</td>
<td>?</td>
<td>?</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>15</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>25.14</td>
<td>25.14</td>
<td>25.14</td>
<td>25.14</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>50.50</td>
<td>50.50</td>
<td>50.50</td>
<td>50.50</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>100.00</td>
<td>100.00</td>
<td>100.00</td>
<td>100.00</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>150.40</td>
<td>150.40</td>
<td>150.40</td>
<td>150.40</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>200.97</td>
<td>200.97</td>
<td>200.97</td>
<td>200.97</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>300.44</td>
<td>300.44</td>
<td>300.44</td>
<td>300.44</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>400.34</td>
<td>400.34</td>
<td>400.34</td>
<td>400.34</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>500.41</td>
<td>500.41</td>
<td>500.41</td>
<td>500.41</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>699.62</td>
<td>699.62</td>
<td>699.62</td>
<td>699.62</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>849.92</td>
<td>849.92</td>
<td>849.92</td>
<td>849.92</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>1004.27</td>
<td>1004.27</td>
<td>1004.27</td>
<td>1004.27</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>DNA1K_LP5_F1x1Lad</td>
<td>1500.00</td>
<td>1500.00</td>
<td>1500.00</td>
<td>1500.00</td>
<td>505.05</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 44. Exported Peak Table

Peaks that are excluded are not exported and are missing in the exported file. For example, if peaks 3, 5, and 7 are excluded, when the data is exported into Microsoft Excel, peaks 3, 5, and 7 are not included.
Raw Data

ASCII text file that contains the signal data from the run as one file per well or multiple wells in the same file. Note that data that is exported has been smoothed using the polynomial filter.

In addition to exporting time and value information, you can choose to export Size information. This information is determined based on aligned data and is used to correlate the peaks across different runs or from one row to another.

When Include Size Data is not checked and only time and values are exported, the state of the analysis function (peaks aligned or not aligned with the ladder data) determines whether or not data that is exported is or is not aligned. The same is true for the Zero Baseline function: if enabled, data that is exported is also zeroed to the baseline.

Below is an example of part of a raw data file exported from a DNA assay (header not included and data truncated in this example):

```
DATA
Time, Size, Value
0.000,-158.365,0.80
0.017,-158.269,0.86
0.033,-158.173,0.53
0.050,-158.077,0.63
0.067,-157.981,0.45
0.083,-157.885,0.28
0.100,-157.788,-0.05
0.117,-157.692,-0.38
0.133,-157.596,-0.66
0.150,-157.500,-1.06
0.167,-157.404,-1.45
0.183,-157.308,-1.70
...
```

Raw data can also be exported in a Chromatography Data Interchange Format (formerly AIA format), which is used by some graphical analysis software tools. The Include Size Data and Export Single Table options are not available with Chromatography Data Interchange Format.
Gel

Exports the selected gel(s) in the selected image format. Options are available to export the entire collection or only the selected gels. Gels can be exported into the same image file or into separate files for each gel.

Figure 45 shows multiple selected gels exported to the same image file.

![Exported Gel](image-url)
Exporting Data Manually

If the workspace contains multiple collections, the data exported is from the active/selected collection.

1. Open the file that you want to export the data from.

2. Select Export from the File menu. The Export Window opens.

3. Select the check boxes next to the views to export. Selecting Export All selects all check boxes.

4. For each selected view, to change the location for the files, click the Browse (...) button and select the desired location. If the path is the default path, the path displays in blue. If the path is not the default path, the path displays in purple. The default path is the location of the data file for the first well in the collection. To reset the path to the default, right-click on the path and select Reset to Default. (Changing the first well in the collection changes the default path to the location of the appropriate data file.)

5. If Raw Data is selected, choose the desired export options:
   - Select the AIA Format check box to export in Chromatography Data Interchange Format, which is used by some graphical analysis software tools. The Include Size Data and Export Single Table options are not available with AIA Format.
   - Select Include Size Data to align the data to the well's ladder (for one file per well) or to the first well (for a single data file) and include the size data in the exported data.
   - Select Export Single Table to export the data for all wells in the plate to one .CSV file. If not selected, the data from each well is exported to a separate .CSV file.

6. If Electropherogram is selected, select either Entire Collection to export a separate graph for each well in the collection or select Selected Wells to export a separate graph for only the selected wells.

7. If Gel is selected, choose the desired export options:
   - Select either Entire Collection to export all of the wells in the collection or select Selected Wells to export only the wells that are selected in the Gel view.
   - Select either Single File to include gels for all wells in the same image file, or select Separate Files to export each gel to a separate image file.
• If desired, change the height of the exported graphic in the **Height** text box.

8 If either **Electropherogram** or **Gel** is selected, choose the desired format for the image files.

9 Click **OK** to export the data to the specified location.
Using the GX Software to Analyze GX Touch Data

After a GX Touch run is complete, you can use the LabChip GX software or the LabChip GX software in Reviewer mode to view and analyze the plate data. The LabChip GX software can open multiple data files in the same workspace to compare the data from different plates. Analysis settings can be changed for single wells, entire plates, or all plates in the workspace.

1. Open the LabChip GX software in Reviewer mode.

2. Open a new workspace (see page 59).

3. Open the GXT data file (see page 60). The data file (*.gxd) may be in a network location or on the GX Touch computer. To select multiple data files, CTRL + click the data file names.

4. Select wells in the plate diagram to add wells to the collection (see page 62).

5. Change the analysis settings as desired. See "Modifying Analysis Parameters" on page 72 for details.
Understanding Peak Finding

Peak finding is the complex data analysis process of converting the raw data signal into a list of meaningful peaks. It involves smoothing the data signal, applying the selected baseline algorithm, identifying the peak baseline, detecting peaks within the smoothed signal, and discarding peaks failing to meet user specified thresholds. This process is controlled by the Peak Find analysis parameters selected in the Assay Analysis Window on the Peak Find Tab.

Data Smoothing

The raw data signal is initially smoothed using the Filter Width and Polynomial Order parameters. This filter removes high frequency noise from the data by performing a local weighted averaging of the data using a Savitzky-Golay convolution kernel. The filter width defines the range over which the averaging takes place; a 0.3 sec filter width averages over 0.3 seconds of data or more precisely, the data is convolved with a weight array that is 0.3 seconds wide. At the typical sampling rate of 60 HZ, this kernel is 0.3 * 60 = 18 + 1 = 19 points wide (forced to be odd by algorithm requirements).

Using a very large filter width to try and reduce signal noise will have an adverse effect on sharp peaks. Typically, the over-filtering of sharp peaks causes side-lode artifacts to appear. The sample shown below has both sharp peaks and signal noise, particularly near the end of the trace. Removing the noise in the broad tail of the upper marker by setting the filter width to 1.0 sec causes the early sharp peaks to lose height and become distorted.

Figure 46. Filtering Examples
Because peaks tend to broaden as time progresses, use a short filter width initially and then switch to a wider filter near the end of the signal for this type of signal. The High Size filter on the Peak Find Tab can be used to smooth the tail of the upper marker without affecting the earlier peaks. Ultimately, some noise may have to be tolerated to avoid distorting the peak shape.

![Figure 47. High Size Filtering](image)

**Peak Detection - Slope Threshold**

Peak baseline and Peak detection are controlled primarily through the Slope Threshold property on the Peak Find Tab. The signal slope increases rapidly at the start of the peak, becomes negative after crossing the peak apex, and then returns to a small value at the end of the peak. The slope threshold is the slope value used to identify the start and end of the peak. The regions outside the zone where the absolute value of the slope exceeds the slope threshold are deemed baseline.

The slope threshold determines the peak start point and end point:

- The first point with local derivative above the slope threshold indicates the Start Point of a peak.
- The first point where the negative slope on the falling edge of the peak drops below the slope threshold indicates the End Point of a peak.

A baseline is drawn under each peak region using a signal average in the baseline regions on each side of the peak.
The Baseline Plateau property defines the minimum length of baseline region needed for computation of this average. Often, the region between peaks may not be long enough to qualify as baseline, in which case the baseline is drawn from the nearest qualifying baseline region on each side of the peaks.

In Figure 48, the orange trace shows the signal slope superimposed over the data. The light blue traces are the peak baseline. The scale for the slope is the same as for the data but with units of /sec. For these well defined peaks, a threshold of 15 /sec clearly extracts the full peak signal.

![Figure 48. Slope Threshold](image)

The Slope Threshold is used to distinguish between baseline and peak regions, so it should be set with care. A common mistake is to set the threshold too low, making it difficult for the analysis to find the baseline. On the same data signal, near the lower marker there is sufficient noise to create variation in the slope values as shown in Figure 49 on page 111.
Although the region before 23 sec is baseline, the slope ranges between ±15 /sec. Setting the slope threshold much below 15/sec causes the analysis to detect these noise bumps as peaks. The bumps will not be identified as peaks because they do not meet the Minimum Height and/or Minimum Width thresholds, but the analysis runs much slower as it carefully explores each bump. Also, the analysis will have difficulty finding baseline regions of qualifying width.
Peak Splitting - Inflection Threshold

In situations where peaks overlap, the signal does not return to the baseline and the slope may or may not change sign, depending on the how close the peaks are to each other. Two peaks with a valley in the middle is normally split into two peaks, but if a peak appears as a shoulder on another peak, splitting does not normally occur. A shoulder is recognized in the analysis as an inflection point. The slope reverses direction but does not change sign. The slope trace shows peaks and valleys - the valleys being the location of the inflection points. The peak in Figure 50 is normally identified as a single peak although the orange slope trace shows three distinct inflection points.

Setting the inflection threshold above the value of the valleys in the slope splits the peak shoulders into separate peaks. The higher the inflection threshold, the more peak splitting occurs. In this example, a value of 150/sec splits off both shoulders. A value of 110/sec only splits off the left shoulder. (See Figure 51 on page 113.)
Peak Identification

Peak identification involves generation of a peak baseline using the Slope Threshold and Baseline Plateau, detection of each peak using Slope and Inflection Thresholds, and then discarding peaks using the Minimum Height and Minimum Width thresholds. This process only occurs between the Start Time and End Time peak find properties. The Minimum Height threshold sets the minimum peak baseline-to-peak apex value needed for a peak to be identified by the analysis. The Minimum Width is the minimum left edge-to-right edge value needed for a peak to be identified.
Software Security

A 21 CFR Part 11 Compliance option is available for the LabChip GX software. This option ensures that assays, output data, analysis settings, event data, and backup data files are not available for editing or tampering. Data is stored in a secure folder on the local computer. To create and maintain the Audit Log and LabChip GX user accounts, Microsoft SQL Server 2005 Express is provided with the LabChip 21 CFR Part 11 option.

The following procedures are included in this section:

“Locking and Unlocking the Software” on page 116

“Managing User Accounts” on page 117
• “Adding New Users” on page 118
• “Changing User Information” on page 119
• “Printing User Information” on page 120
• “Activating and Deactivating User Accounts” on page 120
• “Changing Access Rights” on page 121
• “Printing Access Rights” on page 122
• “Setting Policies for User Accounts” on page 123
• “Printing User Policies” on page 124

“Electronic Signatures” on page 125

“Automatically Exporting Copies of Data Files” on page 126

“Reverting to a Specific Data File Revision” on page 126

“Audit Trail” on page 127
• “Viewing the Audit Trail” on page 128
• “Exporting the Audit Trail” on page 129

“Central Data Repository (CDR)” on page 130
• “CDR Security Suggestions” on page 130
• “Creating New Data Folders” on page 131
• “Moving Data Files into Folders” on page 131
• “Deleting Data Folders” on page 131
• “Hiding Data Files in the CDR Manager Window” on page 132
• “Showing Hidden Data Files in the CDR Manager Window” on page 132
“Remote CDR Server Backup” on page 133
  • “Setting Up the Remote CDR Server” on page 133
  • “Backing Up Data Files to the Remote CDR” on page 135
  • “Restoring Data Files from the Remote CDR” on page 136
  • “Viewing the Files in the Remote CDR Folder” on page 137

“Manually Backing Up and Restoring the CFR Files” on page 138
  • “Backing Up CFR Files” on page 138
  • “Restoring CFR Files” on page 140
Locking and Unlocking the Software

The LabChip GX software with the CFR option installed allows you to lock the LabChip GX software. This prevents unauthorized users from accessing the software while you are away from the computer. After the software is locked, only the logged in user or a LabChip GX Administrator can unlock the software.

To lock the LabChip GX software:

1. On the LabChip GX Main Window, click Security → Lock Application. The Unlock Application Window opens on top of the LabChip GX Main Window and displays the Username of the current user.

![Unlock Application Window](image)

Figure 52. Unlock Application Window

To unlock the LabChip GX software:

1. On the Unlock Application Window, type the user password for the logged in user in the Password text box and click the OK button.

2. If the password for the current user is not available, type a LabChip GX Administrator username and password in the Unlock Application Window and click the OK button. The Administrator is logged into the LabChip GX software.

3. To change the user to a non-administrator user, close and restart the LabChip GX software and then log in as the desired user.
Managing User Accounts

Access to the LabChip GX software is controlled by user names when the 21 CFR Part 11 Security option is installed. Each user must sign into the LabChip GX software. The user’s Access Level controls which options are available for each user name.

The following procedures are included in this section:

- “Adding New Users” on page 118
- “Changing User Information” on page 119
- “Printing User Information” on page 120
- “Activating and Deactivating User Accounts” on page 120
- “Changing Access Rights” on page 121
- “Printing Access Rights” on page 122
- “Setting Policies for User Accounts” on page 123
- “Printing User Policies” on page 124
Adding New Users

Each person who uses the LabChip GX should have a unique LabChip GX user account.

To add a new user:

1. On the LabChip GX Main Window, select Security → User and System Administration. The User Administration Window opens.

2. Click the Create User button.

3. Type the desired Username.

4. Type the First, Middle, and Last Name for user.

5. Type the user’s Position if desired.

6. Select the Access Level for the user. The Access Level controls which rights the user has. The following access levels are available:
   - Restricted User
   - Operator
   - Supervisor
   - Administrator
   - Service

7. Type the desired User Password*.

8. Type the User Password again.

9. Select whether the user can perform a signature.

10. Select whether the user can Accept/Reject/Lock data files.

11. Select whether the user can Unlock data files.

12. Click the Save button.

* Passwords must be at least 5 characters long and must contain at least one uppercase letter and at least one number.
Changing User Information

After a user account is created, the user details can be edited.

To change the user information:

1. On the LabChip GX Main Window, select **Security → User and System Administration**. The **User Administration Window** opens.

2. Click the **Edit Users** button.

3. Select the user to edit from the **User** drop-down list.

4. Change the User Information as necessary:
   - First Name
   - Middle Name
   - Last Name
   - Position
   - Access Level
   - User Can Perform Signature
   - Accept/Reject/Lock Data File
   - Unlock Data File
   - User Password

5. Click the **Save** button to save the updated user information.
**Printing User Information**

After editing a user account, the user details can be printed for record-keeping purposes.

To print the user information:

1. On the **LabChip GX Main Window**, select **Security → User and System Administration**. The **User Administration Window** opens.

2. Click the **Show User Info** button.

3. To print the information for a single user, select the user name in the **Select User to Display** list box.

4. To print the information for all users, select the **Print All Users** check box.

5. To preview the printout, click the **Print Preview** button.

6. To print the selected information, click the **Print** button.

**Activating and Deactivating User Accounts**

If a user name is not going to be used, the user account can be deactivated. The user name is not removed from the system, but cannot be used to log into the LabChip GX software. User names cannot be deleted. A deactivated user name can be activated to continue to be used.

1. On the **LabChip GX Main Window**, select **Security → User and System Administration**. The **User Administration Window** opens.

2. Click the **De/Activate User** button.

3. Select the Username in the **Select User** drop-down list.

4. Click the **Deactivate** button.

To reactivate a user name, select the deactivated user and click the **Activate** button to return the user to active status. The user name can now log into the LabChip GX software.
Changing Access Rights

The rights assigned to each Access Level control the actions that a user is allowed to perform in the LabChip GX software. The rights apply to any user name assigned to the access level. Rights cannot be assigned to an individual user name. The Define Access tab is not available while an assay is running.

To change the rights for an Access level:

1. On the LabChip GX Main Window, select **Security → User and System Administration**. The User Administration Window opens.
2. Click the **Define Access** button.
3. Enable or Disable the desired rights for each Access Level:
   - **User Administration** - Allows users to create, edit, activate and deactivate users, or to change policies.
   - **Run Assay** - Allows users to run assays and save the new data files that are created by the run. Users are not permitted to save changes to existing data files.
   - **Save Existing Data File** - Allows users to save changes to existing data files.
   - **Save Workspace** - Allows users to save new and existing workspaces. If Save Existing Data Files is not selected, users can only save workspaces where the data files have not changed.
   - **Plate Editor** - Allows users to add or edit plate dimensions in the Plate database.
   - **Hide/Show in CDR** - Allows users to hide and show data files in the CDR.
   - **Manage CDR Folders** - Allows users to create, rename, and delete folders in the CDR Manager window. This permission is not required for automatically creating daily subdirectories or to move data files in the CDR.
   - **Perform Validation** - Allows users to perform IQ (Installation Qualifications), OQ (Operation Qualifications), Teaching the robot, and Optics Calibration.
   - **Print/Export Analysis Results** - Allows users to print or export analysis results.
   - **Audit Trail Access** - Allows users to view the Audit Trail in the Audit Trail Window.
   - **Assay Editor** - Allows users to edit and save assays.
4. Click the **Save** button.
Printing Access Rights

After changing the user rights, the access rights can be printed for record-keeping purposes.

To print the access rights:

1. On the LabChip GX Main Window, select Security → User and System Administration. The User Administration Window opens.

2. Click the Define Access button.

3. To preview the printout, click the Print Preview button.

4. To print the selected information, click the Print button.
Setting Policies for User Accounts

User Account Policies specify properties such as password options and whether to require a signature when updating data files.

1 On the LabChip GX Main Window, select Security → User and System Administration. The User Administration Window opens.

2 Click the Set Policies button.

3 Set the options as desired:
   • **Password Expires After** - The number of days until each password expires. Range is 1 to 1000 days.
   • **Number of Retired Passwords to Remember** - User cannot reuse the specified number of old passwords. Range is from 0 to 5.
   • **Minimum Password Length** - The minimum length of each password. Range is from 5 to 30 characters.
   • **Maximum Login Attempts** - The maximum number of times the user can attempt to log in before being locked out of the LabChip GX software. Range is from 3 to 20. This option can be disabled to allow unlimited retries without locking the user out.
   • **Minutes to Automatic Lock** - The number of minutes that the software is inactive until the LabChip GX software locks automatically. Range is from 5 to 4320 minutes (3 days). To disable this option, clear the check box. To unlock the software, see “Locking and Unlocking the Software” on page 116.
   • **Require Signature on File Update** - If selected, an electronic signature is required to save modified data files. Signatures can be performed by any user who has the Perform Signature option selected in the User Administration Window.

4 Click the Save button.
Printing User Policies

After changing the user policies, the user policies can be printed for record-keeping purposes.

To print the user policies:

1. On the LabChip GX Main Window, select Security → User and System Administration. The User Administration Window opens.

2. Click the Set Policies button.

3. To preview the printout, click the Print Preview button.

4. To print the selected information, click the Print button.
Electronic Signatures

Based on a company’s procedural requirements, creating and saving data files may require a superior’s signature. To sign a data file, a user with signature permissions must enter a valid username, password, and comment to explain the purpose of the signature. When signing a data file, options are also available to set the file’s approval state to Unreviewed, Accepted, or Rejected, and to lock or unlock the data file. (These options are only available if the signing user has the appropriate permissions.) A signature can be added to the data file any time, except while the assay is running.

NOTE

To change user signature permissions, see “Changing User Information” on page 119.

To electronically sign a data file:

1. On the LabChip GX Main Window, click Security → Perform Signature. The Perform Signature Window opens on top of the LabChip GX Main Window.

2. Select the username of the user that is signing the data file in the Username drop-down list.

3. Type a comment describing the reason for the signature, approval state, or lock state in the Enter Comment text box.

4. As required, set the Approval State by selecting the Unreviewed, Accept, or Reject option.

5. To lock the data file, select the Lock check box. Locking a data file prevents the data file from being saved until after it is unlocked.

6. Type the User Password for the signing user in the User Password text box.

7. Click the Sign button. The Signature Performed window opens to confirm the signature was performed.

8. Click the OK button in the Signature Performed window. The Perform Signature window closes. Signature information is embedded in the data file and the signature is logged in the Audit Trail.
Automatically Exporting Copies of Data Files

The LabChip GX software provides the option of automatically exporting a copy of the data file (.gxd) to a folder outside the CDR. The data file is copied to the specified folder after the run is complete.

To automatically export a copy of each data file:

1. On the Output Tab on the Start Run Window, select the Copy To check box.
2. Click the Browse (...) button. The Browse for Folder Window opens.
3. Navigate to the folder where you want to save the exported copies of the data files.
4. Click the OK button to choose the selected folder. The path displays in the Copy To text box on the Output Tab.
5. To continue setting the assay options in the Start Run Window, see “Running an Assay” on page 25.

Reverting to a Specific Data File Revision

Each time a data file is changed, a new version of the data file is created and saved. The LabChip GX software enables you to revert to a previous version of a data file.

To revert to a previous data file version:

1. On the LabChip GX Main Window, select Analysis → Analysis Settings on the main menu. The Assay Analysis Window opens.
2. Click the Restore Plate button at the bottom of the window. The Restore Plate Settings to Version window opens.
3. Select the data file version that you want to restore to.
4. Click the OK button. The Assay Analysis Window displays the settings for the selected data file version.
5. Click the OK button to display the data file with the selected settings.
Audit Trail

LabChip GX software uses secured, computer-generated, time-stamped audit trails to independently record the date and time of operator entries and actions that create, modify, or delete electronic records. The audit trails can be printed out for documentation purpose. The audit trail documents can be made available for agency review and copying.

The audit trail is a log of all of the following events that have occurred in the LabChip GX software:

- Administration and user management (create/edit/deactivate user, policy settings, access level modifications, login and lock events)
- Data file run events (prime, run started, run finished, run stopped, run aborted, wash started, wash finished)
- Data file signing events
- Data file hide/show events
- Instrument error events
- Data file version changes
- IQ events
- Application errors related to main database failures

In Windows XP, the “Computer User Role” records the Windows role of the user logged in to the LabChip GX software.

In Windows 7, the “Computer User Role” records either User or Administrator, depending on how the LabChip GX software is started. If the LabChip GX software is started by right-clicking on the icon and selecting Run as Administrator, the Computer User Role is Administrator. If the software is started by double-clicking on the icon, the Computer User Role is User. The Computer User Role reflects the privilege that was used to start the LabChip GX software.

This section includes the following Audit Trail procedures:

- Viewing the Audit Trail
- Exporting the Audit Trail
Viewing the Audit Trail

To view events in the Audit Trail Log:


2. Select the desired data range:
   - Select whether to view most recent entries, entries between specific dates, or the entire database.
   - Select the number of entries or dates to search if Entire Database is not selected.

3. If desired, select a user name to view only events performed by a specific user.

4. To view events for a specific data file, select the name of the data file.

5. To search only specific types of events select the desired Event Category in the Event Category drop-down list. Default shows all events.

6. To change the columns that are displayed, click the green arrow button next to Event Category and select or hide the desired columns.

7. Click the Search button to search the database.
Exporting the Audit Trail

The events displayed in the Audit Trail Window can be exported to a file. The following formats are available:

- Text
- XML
- Excel

To export the events:

1. On the LabChip GX Main Window, select **Security → Audit Trail Log**. The Audit Trail Window opens.
2. Click the **Export** button in the Audit Trail Window. The Audit Trail Export Window opens.
3. Select the desired export file format.
4. Click the **Export** button. The Save As window opens.
5. Choose the desired location for the file, type the desired file name, and click the **Save** button.

By default, the file name is `ATexport_<date>_<time>`, where `<date>` and `<time>` are the current date and time.
Central Data Repository (CDR)

The Central Data Repository (CDR) is a protected folder located on the local computer. All data files (.gxd) are saved in the default CDR folder on the local computer. The CDR folder is protected from changes by unauthorized users. The CDR is only used when the 21 CFR Part 11 option is installed.

The CDR Manager Window enables you to organize data files into virtual folders. The folders are not actually created in the CDR folder on the local computer, but are displayed in the CDR Manager Window to organize the data files. The CDR Manager Window enables you to create new folders, rename existing folders, and delete empty folders.

The following procedures are included in this section:

- “CDR Security Suggestions” on page 130
- “Creating New Data Folders” on page 131
- “Moving Data Files into Folders” on page 131
- “Deleting Data Folders” on page 131
- “Hiding Data Files in the CDR Manager Window” on page 132
- “Showing Hidden Data Files in the CDR Manager Window” on page 132

CDR Security Suggestions

To ensure proper security of data files, the LabChip GX Administrator should:

1. Change the LabChip GX Administrator password. Make sure to keep a copy of the password in a safe place. This password cannot be reset if forgotten. To change the administrator password:
   - Log into the LabChip GX software as the administrator.
   - Select Security → Change Password.
   - Type the current password.
   - Type the new password in both the New Password and Confirm Password text boxes.
   - Click the OK button.

2. To enable remote CDR, install and set up the Remote CDR Server (see page 133), then start the CDR Utility and enable remote CDR Backup (see page 135).
Creating New Data Folders

To create a new CDR data folder:

1. Select File → Import Data File. The CDR Manager Window opens.
2. Click on the upper-level CDR folder.
3. Click the New Folder button on the left side of the window. A new folder named New Folder is created and the name is selected for update.
4. Type the desired name for the folder and then press the Enter key.
5. Close the CDR Manager Window.

Moving Data Files into Folders

To move a data file into a CDR data folder:

1. Select File → Import Data File. The CDR Manager Window opens.
2. Click on the name of the data file.
3. Drag and drop the file into the desired folder.
4. Close the CDR Manager Window.

Deleting Data Folders

To delete a CDR data folder:

1. Select File → Import Data File. The CDR Manager Window opens.
2. Verify the folder is empty.
3. Click on the folder name.
4. Click the Delete button on the left side of the window or at the top of the window.
5. Close the CDR Manager Window.
Hiding Data Files in the CDR Manager Window

The CDR Manager window enables users to hide or show specific data files or folders in the CDR Manager window. This functionality can be used to reduce the number of data files displayed in the CDR Manager window when certain files or folders are not used. The user must have Hide/Show in CDR rights in the Define Access tab in the User Administration Window.

Hiding data files or folders does not change the data file or folder, they are just not displayed in the CDR Manager Window.

To hide data files or folders:

1. Select **File → Import Data File**. The CDR Manager Window opens.
2. Select the name of the data file or folder that you want to hide. If you select a folder name, all data files and folders in the selected folder will also be hidden.
3. Click the Hide button on the left side of the CDR Manager Window.
4. Close the CDR Manager Window.

Showing Hidden Data Files in the CDR Manager Window

To set hidden data files back to unhidden (show):

1. Click the **Show Hidden Files** button at the top right of the CDR Manager Window. All hidden files and folders show in the CDR Manager window. The file or folder icon indicates if the file or folder is hidden.
2. Click the name of the file or folder that you want to show and click the **Show** button on the right side of the CDR Manager Window.

**NOTE**

*Files and folders in a hidden folder do not show in the CDR Manager Window, even if the files are not set to hidden. To show files, the folder cannot be set to hidden.*

1. Click the **Hide Hidden Files** button at the top right of the CDR Manager Window.
2. Close the CDR Manager Window.
Remote CDR Server Backup

The LabChip GX software with the 21 CFR Part 11 option installed supports backing up data files to a remote server using Subversion (SVN). Subversion is a third-party database application used to copy data files to a remote server within the intranet. To use remote backup, Subversion must be installed on the remote server using the CDRServerUtilitySetup.exe included on the LabChip GX Installation CD.

The LabChip GX software can be set up to automatically back up all new and modified data files to the Remote CDR Server. Automatic backup ensures that secure versions of all data files are available and synchronized, even in the event of failure of the instrument computer.

The following procedures are included in this section:

- “Setting Up the Remote CDR Server” on page 133
- “Backing Up Data Files to the Remote CDR” on page 135
- “Restoring Data Files from the Remote CDR” on page 136
- “Viewing the Files in the Remote CDR Folder” on page 137

To back up the Remote CDR Server, either back up the entire C:\drive on the remote server, or back up the C:\RemoteCDR folder.

The LabChip GX software also contains an option to copy the data files to an unsecured location on the local hard drive. These data files do not meet 21 CFR Part 11 security requirements after they are copied out of the CDR. To copy data files to a non-secure location, use the Copy button on the CDR Manager Window.

Setting Up the Remote CDR Server

To back up copies of LabChip GX data files on 21 CFR Part 11 compliant systems, and keep the copies of the data files secure, back up the files to a Remote CDR Server. To set up the Remote CDR Server:

1. If the CDR Server Utility is not already installed on the remote server, see the Readme.htm file on the LabChip GX Installation CD for instructions on running CDRServerUtilitySetup.exe.
Setting Up the Remote CDR Server (Continued)

3 If the Server has not been created on the computer yet, click the Create Server button to create the server. The default folder name and location (C:\RemoteCDR) cannot be changed. Wait for the Create Server button to be disabled and the text boxes to be active.

**NOTE**

Server name, folder name, username, and password are case sensitive.

4 A folder must be created on the server to store the database. To create a new folder on the remote server:
   - Type the desired folder name in the **Folder Name** text box.
   - Type a Username for the folder in the **Username** text box. (This is a separate username from the user names created in the LabChip GX software. This username is only used to access the data folder on the Remote CDR Server.)
   - Type the desired password in the **Password** and **Confirm Password** text boxes.
   - If Get Folder Details is checked, a text file specifying the folder details is created and saved in C:\Program Files\Caliper Life Sciences\LabChip GX\CDRServer\ServerDetails\.
   - Click the **Apply** button to create the folder.

5 Close the CDR Server Utility Window after the desired folders have been created.
Back up Data Files to the Remote CDR

Remote CDR Backup copies each data file to the Remote CDR server and stores a copy of the data file in a database. Each time a data file is created or modified, the changes are copied into the remote database.

Remote CDR Backup can only be enabled by the LabChip GX default Administrator.

To set up Remote CDR Backup:

1. Verify that the Remote CDR Server is set up on an accessible network server.
2. Log into the LabChip GX software using the default administrator user name and password.
4. Select the Enable Remote CDR Backup check box.

**NOTE**

Server name, folder name, username, and password are case sensitive.

5. Type the computer name of the Remote CDR server in the Remote Computer Name/IP Address text box. If the remote computer and the local computer are not in the same Windows workgroup, type the IP address of the remote computer.
6. In the Folder text box, type the name of the folder to use in the remote CDR server to store the LabChip GX data. (The folder must have already been created using the CDR Server Utility on the remote computer.)
7. Type the folder username in the User Name text box. This username is the same username that was used to create the CDR Server folder.
8. Type the folder password in the Password text box. This is the same password that was used to create the CDR Server folder.
9. Click the Apply button.
10. Click the Close button to close the CDR Utility Window.
Restoring Data Files from the Remote CDR

The last backed up copies of data files can be restored from the backup database on the remote CDR Server if the LabChip GX computer is replaced.

To restore the data files from the backup database:

1. Verify that the Remote CDR Server is accessible on the network.
2. Log into the LabChip GX software using the default administrator user name and password.
4. Select the Enable Remote CDR Backup check box.

**NOTE**

- Server name, folder name, username, and password are case sensitive.

5. Type the computer name of the Remote CDR server in the **Remote Computer Name/IP Address** text box. If the remote computer and the local computer are not in the same Windows workgroup, type the IP address of the remote computer.

6. In the **Folder** text box, type the name of the folder in the remote CDR server that you want to restore the LabChip GX data from. (Make sure to select the same folder to which the data was backed up.)

7. Type the folder username in the **User Name** text box. This username is the same username that was used to create the CDR Server folder.

8. Type the folder password in the **Password** text box. This is the same password that was used to create the CDR Server folder.

9. Click the **Apply** button. The progress bar display the status of the restoration process and a confirmation displays when the restore is complete.

10. Click the **Close** button to close the CDR Utility Window.
Viewing the Files in the Remote CDR Folder

The Remote CDR Folder contains backup copies of the data files in the local CDR. To view files in the Remote CDR, you must be logged into the remote computer and know the user name and password to access the CDR folder.

To view the data files in the Remote CDR:


2. Click the View Contents button. The CDR Server Viewer opens.

3. Click on the desired folder and type the Username and Password in the Authentication window. The CDR Viewer displays the folders and files in the Remote CDR. The total number of files displays at the bottom of the window. Any files that are in the Remote CDR but are not in the local CDR are indicated by a red error icon as shown below.

![Figure 53. CDR Server Viewer](image-url)
Manually Backing Up and Restoring the CFR Files

The LabChip GX software with the 21 CFR Part 11 option installed supports backing up data files to a remote server (see "Remote CDR Server Backup" on page 133). The CDR data files and the Audit Trail database can also be backed up manually to another secure location. Manual backup does not update the backup copies with any changes to the files. The backup copies can be stored on another computer or on a removable storage drive. The data files and Audit Trail database can only be restored to the point when the files were backed up.

Backing Up CFR Files

To manually back up the CFR Files, you must back up both the CDR data files and the Audit Trail database.

Setting the CDR folder as accessible

1. Log in to the computer with a User Name in the Administrator group.
2. For Windows 7: Right-click on the LabChip GX icon on the Windows desktop and select Run as Administrator.
   For Windows XP: Double-click on the LabChip GX icon on the Windows desktop
3. Log in to the LabChip GX CFR software as the Administrator user.
5. Select the Accessible by Windows Administrator Level Users check box and then click the Apply button.
6. Click OK in the Confirmation window.
7. Click the Close button on the CDR Utility Window.
8. Close the LabChip GX software.

Copying the CDR Folder

1. In Windows Explorer, navigate to C:\Program Files\Caliper Life Sciences\.
2. Copy the entire \CDR\ folder to the desired location for the backup files.
Setting the CDR folder back to not accessible

1 **For Windows 7:** Right-click on the LabChip GX icon on the Windows desktop and select **Run as Administrator.**

   **For Windows XP:** Double-click on the LabChip GX icon on the Windows desktop

2 Log in to the LabChip GX CFR software as the Administrator user.

3 On the LabChip GX main window, select **Tools → CDR Utility.** The CDR Utility Window opens.

4 Clear the **Accessible by Windows Administrator Level Users** check box and then click the **Apply** button.

5 Click **OK** in the Confirmation window.

6 Click the **Close** button on the CDR Utility Window.

7 Close the LabChip GX software.

Backing up the Audit Trail Database

1 In Windows Explorer, navigate to C:\Program Files\Caliper Life Sciences\LabChip GX.

2 Double-click the **BackupDB.bat** file. A backup copy of the database, named **DBback.bak**, is created.

3 In Windows Explorer, navigate to C:\Program Files\Caliper Life Sciences\LabChip GX\Database\.

4 Copy the DBback.bak file to the desired location for the backup files.
Restoring CFR Files

To restore the CFR files from a manual backup point, you must restore both the CDR data files and the Audit Trail database. If restoring the files to a new computer, install the LabChip GX software and then restore the CFR files.

Setting the CDR folder as accessible

1. Log in to the computer with a User Name in the Administrator group.

2. **For Windows 7**: Right-click on the LabChip GX icon on the Windows desktop and select *Run as Administrator*.

   **For Windows XP**: Double-click on the LabChip GX icon on the Windows desktop

3. Log in to the LabChip GX CFR software as the Administrator user.


5. Select the *Accessible by Windows Administrator Level Users* check box and then click the *Apply* button.

6. Click *OK* in the Confirmation window.

7. Click the *Close* button on the CDR Utility Window.

8. Close the LabChip GX software.

Restoring the CDR Folder

1. In Windows Explorer, navigate to C:\Program Files\Caliper Life Sciences\.

2. Delete the existing \CDR\ folder.

3. Copy the backed up \CDR\ folder into the folder. (See “Backing Up CFR Files” on page 138.)
Setting the CDR folder back to not accessible

1 **For Windows 7**: Right-click on the LabChip GX icon on the Windows desktop and select *Run as Administrator*.

   **For Windows XP**: Double-click on the LabChip GX icon on the Windows desktop

2 Log in to the LabChip GX CFR software as the Administrator user.

3 On the LabChip GX main window, select **Tools → CDR Utility**. The CDR Utility Window opens.

4 Clear the **Accessible by Windows Administrator Level Users** check box and then click the **Apply** button.

5 Click **OK** in the Confirmation window.

6 Click the **Close** button on the CDR Utility Window.

7 Close the LabChip GX software.

**Restoring the Audit Trail Database**

1 In Windows Explorer, navigate to C:\Program Files\Caliper Life Sciences\LabChip GX\Database\. 

2 Copy the backed up database (DBback.bak) into the folder.

3 In Windows Explorer, navigate to C:\Program Files\Caliper Life Sciences\LabChip GX\. 

4 Double-click the **RestoreDB.bat** file. The Audit Trail database is restored to the backup point.
Software Reference

This section describes the windows in the LabChip GX software. Each topic describes the options and buttons on the window, and how to open the window. This section includes:

- “LabChip GX Main Window” on page 143
- “About LabChip GX Window” on page 183
- “Add New Expected Peak Window” on page 184
- “Add Plate Window” on page 185
- “Assay Analysis Window” on page 186
- “Audit Trail Window” on page 208
- “Audit Trail Export Window” on page 209
- “Audit Trail Manage Columns Window” on page 210
- “CDR Manager Window” on page 211
- “CDR Server Utility Window” on page 213
- “CDR Utility Window” on page 214
- “Change Password Window” on page 216
- “Data File Version Window” on page 217
- “Event Viewer Window” on page 218
- “Export Window” on page 219
- “Installation Qualification Window” on page 222
- “Layout Options Window” on page 223
- “Login Window” on page 224
- “New Collection Window” on page 225
- “Optics Calibration Window” on page 226
- “Perform Signature Window” on page 228
- “Plate Information Window” on page 229
- “Print Window” on page 230
- “Print Validation Reports Window” on page 232
- “Rename Collection Window” on page 233
- “Robot Teaching Wizard” on page 234
- “Run File Editor Window” on page 243
- “Run Info Window” on page 244
- “Sample Name Editor Window” on page 245
- “Save Workspace As Window” on page 247
- “Select a Data File Window” on page 248
- “Start Run Window” on page 249
- “System Diagnostics Window” on page 256
- “Unlock Application Window” on page 258
- “Unlock Data File Window” on page 259
- “User Administration Window” on page 260
LabChip GX Main Window

The main window of the LabChip GX software includes:

- “Menu Bar” on page 144
- “Chip Status and Run Status” on page 151
- “Error Message Area” on page 153
- “Plate View or Plate List” on page 154
- “Collection Pane” on page 157
- “Graph View” on page 158
- “Graph View Properties” on page 164
- “Gel View” on page 167
- “Gel View Properties” on page 170
- “Well Table View” on page 172
- “Peak Table View” on page 174
- “Peak Table Properties” on page 179
- “Filter View” on page 180

Clicking and dragging the borders between the views changes the size of the views in the collection. To change the location of the views, see “Changing the View of the Data” on page 85.
Menu Bar

The menu bar is directly below the title bar on the LabChip GX Main Window. Clicking a menu name displays a list of commands to access software functions.

The LabChip GX software contains the following menus:

- “File Menu” on page 145
- “Workspace Menu” on page 145
- “Collection Menu” on page 146
- “Analysis Menu” on page 146
- “Instrument Menu” on page 147 (Only displays in Instrument and Simulation modes)
- “Tools Menu” on page 147
- “Security Menu” on page 148 (Only displays if the 21 CFR Part 11 option is installed)
- “View Menu” on page 149
- “Validation Menu” on page 149
- “Window Menu” on page 149
- “Help Menu” on page 150
File Menu

The File menu contains the following commands:

**New Workspace** - Creates a new, blank workspace.

**Open Workspace** - Opens a saved workspace.

**NOTE**

You can open multiple data files, but you cannot mix DNA, Protein, RNA, Glycan, Protein Charge Variant, or gDNA data files in the same workspace.

**Import Data File** - Opens a saved DNA, Protein, RNA, Glycan, Protein Charge Variant, or gDNA data file for a specific microplate. If the 21 CFR Part 11 option is installed, opens the CDR Manager Window. A graphical representation of the microplate displays. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.) Data files can be .GXD (LabChip GX) or .CLA (LabChip HT software).

**Export** - Opens the Export Window to choose the type of data to export. Exports a Peak Table, Well Table, Gel, Single Graph, or all open graphs in the current Collection to a file, depending on the options selected.

**Print** - Opens the Print Window to choose the data to print.

**Save Workspace** - Saves the current workspace.

**Save Workspace As** - Saves the current workspace with a new filename.

**Exit** - Closes the LabChip GX software.

Workspace Menu

The Workspace menu contains the following commands:

**Remove Plate** - Removes the selected plate data file from the workspace.

**Save Plate** - Saves the plate data file (*.gxd). Changes to the analysis settings (in the Assay Analysis Window) are saved at the end of the plate data file. Previous analysis settings are not overwritten, enabling you to use the **Restore Plate** button on the Assay Analysis Window to go back to any previously saved settings. Plate data files are automatically saved when the Workspace is saved.
Collection Menu

The Collection menu contains the following commands:

**Undo** - Undoes changes to the collection view settings and filter settings. Changes made in pop-up windows, such as analysis settings, export settings, etc., are not affected by this Undo.

**New Collection** - Opens the New Collection Window where you choose whether to create a new Collection from a saved Collection Template, a Blank Collection, or the Current Collection.

**Rename Collection** - Opens the Rename Collection Window to rename the currently selected Collection.

**Delete Collection** - Deletes the current Collection.

**Save As Template** - Opens the Save Template As window to save the display and filter settings currently displayed in the Collection tab as a collection template.

**Apply Template** - Opens the Apply Template window to open a saved collection template and apply it to the current Collection.

**Layout** - Opens the Layout Options Window to change where tabs are displayed by default on the main window.

Analysis Menu

The Analysis menu contains the following commands:

**Turn On/Off Analysis** - Toggles analysis on and off. When analysis is on, the data displayed in the main window uses the analysis settings in the Assay Analysis Window. When analysis is off, the unaligned data (spike rejected, filtered, and baseline corrected) displays.

**Scale to Sample Peaks** - Scales the view to the minimum and maximum X values of the current sample peaks. Marker and/or system peaks are ignored.

**Scale to All Peaks** - Scales the view to the minimum and maximum X values of the all peaks, including marker peaks and system peaks.

**Analysis Settings** - Opens the Assay Analysis Window to choose analysis parameters for the selected plate. These settings apply to all wells in the microplate. Use these settings to change the analysis and peak finding parameters to help resolve hard-to-decipher data.
**Standard Curve** - Opens the Standard Curve Window to view the ladder as a curve with a point-to-point fit. (Not available for Protein Charge Variant assays.)

**Instrument Menu**

The instrument menu only displays when the software is in either Instrument or Simulation mode. The Instrument menu contains the following commands:

**Start Run** - Opens the Start Run Window to prime the chip if it has not already been primed, and then begin running a sample plate. See the *Assay User Guide* for chip and sample prep instructions.

**Start Prime** - Primes the chip for a selected assay without running the assay. Opens the Choose Assay for Chip Prime window to select the assay for which to prime the chip. The chip must be primed for the same assay (or assay family) as the assay that will run on the chip. To use the chip for a different assay, wash and re-prime the chip by selecting the correct assay and using the appropriate reagents. This option is only available if a new chip has been inserted and has not been primed yet.

**Start Wash** - Begins a sequence of steps to wash the chip. See the *Assay User Guide* for chip prep instructions.

**NOTE**

The Instrument menu does not display if the software was installed in Reviewer mode.

**Tools Menu**

The Tools menu contains the following commands:

**Run File Editor** – Opens the Run File Editor window to create Run files. Run files contain the settings to run an assay using Caliper’s automation control software, such as iLink Pro.

**Sample Name Editor** - Opens the Sample Name Editor Window to change, import, or export the sample names assigned to the wells of the plate.

**Assay Editor** - Opens the Select Assay To Edit window. Selecting an assay opens the Assay Analysis Window to make changes to the selected assay.
Teaching Utility - Opens the Robot Teaching Wizard to teach the robot. Reteach the robot if the sipper is not accessing the plate properly. Also includes a plate puncture test to verify the taught location. (If the CFR Support option is installed, only displays if the user has Perform Validation access right.) Does not display in Reviewer Mode.

Calibrate Optics - Opens the Optics Calibration Window to calibrate the system optics using Test Chip C. (If the CFR Support option is installed, only displays if the user has Perform Validation access right.) Does not display in Reviewer Mode.

Plate Editor - Opens the Plate Information Window to add, edit, or delete plates from the LabChip GX software.

CDR Utility - Opens the CDR Utility Window to set or change the CDR options or Remote CDR Backup options. This command is only available when the CFR Support option is installed and the default Administrator is logged into the LabChip GX software.

**Security Menu**

The Security menu only displays if the CFR Support option is installed with the LabChip GX software.

User and System Administration - Opens the User Administration Window to create, edit, and view user login information, activate or deactivate users, define user access, and set user policies.

Change Password - Opens the Change Password Window to change the Login Password for the current user.

Perform Signature - Opens the Perform Signature Window to sign a data file.

Unlock Data File - Opens the Unlock Data File Window to unlock a locked data file.

Audit Trail Log - Opens the Audit Trail Window to view, search, export, and print the audit trail.

Lock Application - Opens the Unlock Application Window to lock the LabChip GX software and prevent other users from using the software until the software is unlocked by the current user or an Administrator.
View Menu

The View menu contains the following commands:

**Event Viewer** - Opens the Event Viewer Window to view events and errors that occur during the current run or during a previous run.

**Run Info** - Opens the Run Info Window to view information about the run.

**Version Change Details** - Displays the Data File Version Change Details window to view changed versions of the selected open data file.

Validation Menu

The Validation menu contains the following commands:

**Software IQ** - Opens the Installation Qualification Window to perform the IQ.

**Diagnostics** - Opens the System Diagnostics Window to run diagnostic tests to verify system operation and performance. Does not display in Reviewer Mode.

**Reports** - Opens the Print Validation Reports Window to view or print IQ/OQ results.

Window Menu

The Window menu contains the following commands:

**Cascade** - Displays each Collection in a separate, cascading window in the Collection Pane.

**Tile Vertical** - Displays each Collection in separate side by side windows in the Collection Pane.

**Tile Horizontal** - Displays each Collection in separate top to bottom windows in the Collection Pane.

**Tabbed** - Displays each Collection in a separate tab in the Collection Pane.
Help Menu

The Help menu contains the following commands:

**LabChip GX Help**
Opens the Contents/Index page for the LabChip GX Help file.

**About LabChip GX**
Opens the About LabChip GX Window, showing the software version number and firmware version number.
Chip Status and Run Status

The Chip Status and Run Status areas on the LabChip GX Main Window display the status of the system, information about the Chip in the instrument, and information about the assay that is currently running.

NOTE

*The Chip status and Run status area does not display if the LabChip GX software is in Reviewer mode.*

System Status - Displays the status of the system. Displays **Ready** when the system is ready to run an assay. While an assay is running, each stage of the assay displays: Priming, Warming, Running, etc.

**Run Button** - Opens the Start Run Window to begin to run an assay. See the Assay User Guide for chip preparation instructions. While an assay is running, the Run button changes to a Stop button as shown above. Click the Stop button to stop a running assay. Assays that have been stopped cannot automatically be continued. See “Continuing a Stopped Run” on page 32 for details on restarting a stopped assay.

**Wash Button** - Begins a sequence of steps to wash the chip. See the Assay User Guide for chip preparation instructions.
Chip Status and Run Status (Continued)

**Chip Status**

**Assay** - The name of the assay file that is being run or that generated the data.

**Chip Reagent Status** - Displays the time and number of samples (whichever comes first) until the chip reagents expire. Reagent expiration depends on the type of chip inserted in the instrument. The LabChip GX automatically detects the chip type from an embedded RF ID tag in each chip. The expiration time and number of samples reset whenever the chip holder is ejected.

**Chip Life Status** - Displays the date and number of samples (whichever comes first) until the chip expires. Chip expiration depends on the type of chip inserted in the instrument. The LabChip GX automatically detects the chip type from an embedded RF ID tag in each chip. The sample count and chip expiration date reset whenever the chip holder is ejected.

**Run Status**

**Run Time Left** - Displays the time remaining until the assay is complete.

**Plate Name** - The name of the plate being used in the assay.

**Auto Export** - Displays Yes if Auto Export was selected in the Output Tab on the Start Run Window. Displays No if Auto Export was not selected.

**Barcode** - If Use Barcode was selected in the Run Tab or Output Tab on the Start Run Window, displays the barcode that was read from the plate. If Use Barcode was not selected, displays N/A.

**Cycles** - Displays <CurrentPlateCycle>/ <TotalPlateCycle>, where CurrentPlateCycle is the number of the plate cycle currently executing and TotalPlateCycle is the total number of plate cycles specified in the Advanced Tab on the Start Run Window. CurrentPlateCycle displays 0 during the priming/warming steps before reading the first well.

**Status** - Displays the action the system is performing and the time remaining in the step. Run Time Left (above) displays the time remaining in the entire assay.

**Errors** - If an error occurs during an assay, a line of red text displays a description of the error below the Run Status area in the Error Message Area. Click the red text to view details about the error.
Error Message Area

Error messages are displayed below the Chip Status and Run Status on the LabChip GX Main Window.

Error messages can result from hardware or software problems. Most are the result of peaks not being located by the analysis algorithms of the software. This can be due to a sample or ladder peak not appearing as expected. The software settings (in the Peak Find Tab) can also cause peaks to be undetected, which can cause errors. Additionally, manually excluding a peak (see page 74) from analysis (in the Peak Table View) or changing the start or end times for a run can cause errors with the peak find algorithm.

See “Error Messages” on page 285 for a list of errors and tips on preventing or resolving errors.
Plate View or Plate List

The Plate View or Plate List View displays on the left side of the LabChip GX Main Window.

The Plate View or List View displays the data files in the open collection and enables you to select specific wells of microplate data. Click the tabs at the bottom of the view to switch between Plate View and List View.

Plate View

The Plate View displays a graphical representation of the microplates in the collection and indicates selected wells and ladders, filtered wells, and wells with errors. Wells included in the collection are colored blue. Ladder wells display on the left side of the plate if the sip order was row-wise, or along the top of the plate if the sip order was column-wise. The wells selected to view in the Gel View and Well Table View are outlined in black. Select the Plates tab at the bottom of the Workspace pane to see the Plates view.

![Plate View, Row-wise and Column-wise](image)

Figure 55. Plate View, Row-wise and Column-wise

To select the wells to view in the Collection Pane, see “Selecting the Wells in a Collection” on page 62.

Plate View Right-Click Menu

Right-click on the plate name in the Plate view to display the following options in the shortcut menu:

- **Keep Gel in Sip Order** - If selected, keeps the gel in sip order when selecting wells in the plate view. If not selected, the gel displays the wells in the order in which the wells were selected.
- **Save Plate** - Saves the current data file.
- **Copy Plate** - Saves a copy of the plate data file (.gxd) to the selected folder.
• **Export Assay** - Saves a copy of the assay settings for the plate to an assay file (.asy) in the selected folder.

• **Rename Plate** - Renames the plate in the workspace. If desired, the original data file can be renamed by selecting the Rename File to Match check box.

• **Remove Plate** - Removes the plate data file from the workspace. The data file is not deleted, only the workspace view changes.

• **Analysis Settings** - Displays the Assay Analysis Window to change the analysis settings for the data file.

• **Version Change Details** - Displays the Data File Version Window to view a different version of the data file in the workspace.

• **Run Info** - Displays the Run Info Window to view the run information and Event Log.

**Plate Well Color Code**

- **White** - Wells are not included in the open collection.
- **Gray** - Wells were not read.
- **Blue** - Wells are included in the open collection.
- **Any Other Color** - Wells are selected by a Filter. See the Filter View to determine which color represents each filter. If a well is selected by multiple filters, the colors are combined in the well. (In the figure above, light green wells are selected by a filter.)
- **Black Outline** - Wells are selected in the Gel View and Well Table View.
- **Red Exclamation Point in Well** - An analysis error has occurred in the well, such as no lower marker detected (well C1 above).
- **Yellow Exclamation Point in Well** - An analysis warning has occurred in the well (well C7 above).
List View

The List View displays a list of all the wells in the currently open data files. Select the List tab at the bottom of the Workspace pane to see the List view.

- Dark Blue well names are included in the open collection.
- Black well names are not included in the open collection.
- Light Blue well names are selected in the Gel View and Well Table View.
- Well names outlined in Yellow have an analysis warning.
- Well names outlines in Red have an analysis error.

![Figure 56. List View](image)
Collection Pane

The Collection Pane in the LabChip GX Main Window displays a tab for each collection in the workspace. Each collection displays the information from the data files that are open in the Plate View or Plate List.

The Collection Tabs each contain the following views:
- Graph View
- Gel View
- Well Table View
- Peak Table View
- Filter View

The views in the Collection pane are synchronized with each other.
- Selecting a graph on the Graph tab automatically selects the same well on the Gel tab.
- Selecting a peak in the Peak Table automatically selects the same peak in the Graph tab and the Gel tab.
- Closing a gel on the Gel tab closes the graph for the well and removes the well data from the Peak Table and Well Table tabs.
Graph View

The Graph view in the Collection Pane is a visual representation of the data from each well as an electropherogram.

The Graph view contains the Active Data Tab while a run is in progress. Use the Overlay Electropherograms Tab and the Electropherograms Tab to view data from completed wells. To change the view in the Overlay Electropherograms tab, see “Viewing Graphs in the Overlay Electropherograms Tab” on page 89. To change the view in the Electropherograms tab, see “Viewing Graphs in the Electropherograms Tab” on page 90.

If Type is selected as an annotation, the lower (and upper for DNA) markers are displayed in the graph view with large green arrows labeled LM and UM respectively. The currently selected peak in the Gel view or Peak Table displays a small blue arrow above the peak.

You can zoom in and zoom out the Graph View of the wells. Zoom in by clicking and dragging over a region of an electropherogram. Zoom out by right clicking on a graph, and selecting either Unzoom or Unzoom All from the shortcut menu. Double-clicking in the graph will zoom out to the previous zoom level.

Graph data can be exported to a graphic file by choosing Export on the File menu. (See “Exporting Data” on page 102 for details.) If the workspace contains multiple collections, the data exported is from the active/selected collection.
Graph View (Continued)

To show or change the labels on the peaks in the graph, show the data points on the graph, show peak baselines, show smears, or change the graph colors, see “Graph View Properties” on page 164.

To select a peak on the graph, move the cursor near the peak and click. A blue arrow above the peak shows that the peak is selected, and the cursor changes to an up arrow. The Gel View and Peak Table View also select the corresponding entry.

To adjust the peak baselines from the graph view, see “Adjusting the Peak Baseline” on page 76.

While a run is in progress, the Active Data Tab displays the raw (unanalyzed) data as it is being read from the chip. As data is acquired, the selected well increments to the well that is currently being run, and the data displays in real time.

Graph View Shortcut Menus

Right-Click Menu (not near a peak)
Right-click away from a peak in the graph to display a shortcut menu containing the following commands:

Synchronize Zoom - If selected, the zoom is synchronized for all graphs displayed in the Electropherograms Tab, all gels in the Gel View, and data in the Peak Table View. If not selected, each view and graph can be zoomed independently.

Unzoom - Zooms out to the previous zoom level.

Unzoom All - Zooms out and returns to the standard view.

Set Scale - Opens the Set Graph Scales window to specify the X and Y ranges to show on the graph.

Scale to Sample Peaks - Scales the view to the minimum and maximum X values of the current sample peaks. Marker and/or system peaks are ignored.

Scale to All Peaks - Scales the view to the minimum and maximum X values of the all peaks, including marker peaks and system peaks.

Manual Baseline - Turns Manual Baseline mode on or off. If checked, clicking and dragging on the graph creates a new manual baseline for the peaks within the baseline.

Copy - Copies the selected graph to the clipboard in a BMP format.

Analysis Settings - Opens the Assay Analysis Window to change the analysis settings.
Graph View (Continued)

Right-Click Menu (near a peak)
Right-click above or below a peak in the graph to display a shortcut menu containing the following commands:

Exclude Peak - Excludes the peak from the analysis. (The Peak Type label displays X.)

Include Peak - Includes an excluded peak in the analysis. Only available when the selected peak is already excluded or is type System Peak or “?”. Including the peak will compute the peak properties, populate the peak table, and include the peak in the area total used for the %Purity calculation.

Force Lower Marker - Defines the selected peak as the Lower Marker. (The Peak Type label displays LM*.)

Clear Forced Lower Marker - Allows the analysis to determine the lower marker. (The Peak Type label for the calculated lower marker displays LM.) Only available when the selected peak is a Forced Lower Marker.

Force Upper Marker - (DNA Assays only) Defines the selected peak as the Upper Marker. (The Peak Type label displays UM*.)

Clear Forced Upper Marker - (DNA Assays only) Allows the analysis to determine the upper marker. (The Peak Type label for the calculated upper marker displays UM.) Only available when the selected peak is a Forced Upper Marker.

Add Expected Peak - Opens the Add New Expected Peak Window to add a new Expected Peak to the specified wells.

Force Expected Peak - Defines the selected peak as the specified Expected Fragment or Protein. A list of all of the defined Expected Peaks displays beside the shortcut menu. Select the desired Expected Peak from the list.

Clear Forced EP - Clears the forced peak and allows the analysis to determine the expected peak.

Right-Click Menu (at the bottom of an RNA peak)
Right-click near the bottom of a peak in the graph for an RNA assay to display a shortcut menu containing the following commands:

Reset to Defaults - Sets the Peak Baseline endpoints back to the default values.
Active Data Tab

The Active Data tab on the Graph View displays the raw (unanalyzed) data as it is being read from the chip. The Active Data tab only displays while a run is in progress. After a well is read, view the data in the Overlay Electropherograms Tab.

![Figure 58. Active Data Tab](image)

The Active Data tab does not show any peak labels or marker indicators. The labels and markers are identified during analysis, which occurs after all data from the well is collected.
Overlay Electropherograms Tab

Use the Overlay Electropherograms tab on the Graph View to view a single graph or multiple graphs overlaid on top of each other.

![Overlay Electropherograms Tab](image)

**Figure 59. Overlay Electropherograms Tab**

The sample list at the upper right displays the name of each sample and the color assigned to the graph for each sample. If only one graph is displayed, the Gel View, Well Table View, and Plate View or Plate List all show the same selected well.

The gel lanes selected in the Gel View are synchronized with the graphs displayed in the Overlay Electropherograms tab.

For information on changing the view in the Overlay Electropherograms tab, see “Viewing Graphs in the Overlay Electropherograms Tab” on page 89.

See “Graph View Properties” on page 164 for descriptions of the properties that can be set for the Overlay Electropherograms tab.
Electropherograms Tab

Use the Electropherograms tab on the Graph View to view a single graph or multiple graphs in the same tab.

Each graph displays the data file name and well name at the top of the graph.

For information on changing the view properties in the Electropherograms tab, see “Viewing Graphs in the Electropherograms Tab” on page 90.

See “Graph View Properties” on page 164 for descriptions of the properties that can be set for the Electropherograms tab.
Graph View Properties

To view the Properties for the Electropherograms Tab or the Overlay Electropherograms Tab, click the Properties tab on the right side of the Graph View.

![Image of Graph View Properties window]

**Figure 61. Electropherograms Properties and Overlay Electropherograms Properties**

This window contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>Specifies the number of rows and columns of graphs displayed on the Electropherograms Tab. (Only displayed when the Electropherograms tab is selected.)</td>
</tr>
<tr>
<td>Annotation 1</td>
<td>Labels each peak in the graph with the peak property selected from the drop down list. Default is Type. The Annotations available depend on the columns selected in the Peak Table View.</td>
</tr>
<tr>
<td>Text Orientation (A) button</td>
<td>Specifies the orientation of the text for the annotation: horizontal, vertical up, or vertical down.</td>
</tr>
<tr>
<td>Option</td>
<td>Function</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set Font button</td>
<td>Opens the Font window to choose the font, style, and size of the text for all annotations.</td>
</tr>
<tr>
<td>Annotation 2</td>
<td>Labels each peak in the graph with a peak property selected from the drop down list. Default is None.</td>
</tr>
<tr>
<td>Peak Annotation Legend</td>
<td>If selected, the types of the annotations display in the upper left corner of the graph.</td>
</tr>
<tr>
<td>Well Annotation</td>
<td>Displays the selected well property outside the graph. Only the columns displayed in the Well Table View are available for selection.</td>
</tr>
<tr>
<td>Well Annotation Location Button (arrow)</td>
<td>The location of the well annotation. Click the button to change the location: upper right, upper left, lower left, or lower right.</td>
</tr>
<tr>
<td>Show Data Points</td>
<td>If selected, displays a dot on the graph at the location of each data point.</td>
</tr>
<tr>
<td>Show Peak Baselines</td>
<td>If selected, displays the baseline for each peak on the graph.</td>
</tr>
<tr>
<td>Show Smears</td>
<td>If selected, displays smears as a colored line on the trace and displays the smear baseline. This option only displays if smears are defined in the Assay Analysis Window.</td>
</tr>
<tr>
<td>Only Annotate Expected Peaks</td>
<td>If selected, only the peaks that are labeled as Expected Fragments, Expected Proteins or Expected Glycans display the annotations. If not selected, all peaks display the annotations.</td>
</tr>
<tr>
<td>Graph Selected Gels Only</td>
<td>If selected, only the wells selected in the Gel View or Well Table View are displayed in the Electropherograms tab. If not selected, all wells in the collection are displayed. (Only displayed when the Electropherograms tab is selected.)</td>
</tr>
<tr>
<td>Sample Name/Color Table</td>
<td>Displays the names of the samples (well names) on the graph and the color associated with each sample (well). Click on the color to choose a different color for a sample.</td>
</tr>
<tr>
<td>X Axis Scale</td>
<td>Specifies the units displayed on the X Axis, either Time, Size, or Log Size. Log Size displays the size on a logarithmic scale.</td>
</tr>
<tr>
<td>Grid Style</td>
<td>Displays grid lines on the graph: vertical, horizontal, both, or none. Click the button to cycle through the grid options.</td>
</tr>
<tr>
<td>Data Legend Location</td>
<td>If multiple wells are displayed in the Overlay Electropherograms tab, specifies the location where the legend displays on the graph. The legend shows the color used for each well. (Only for the Overlay Electropherograms Tab.)</td>
</tr>
<tr>
<td>Overlay Offset</td>
<td>Offsets each of the graphs by the RFU value specified.</td>
</tr>
<tr>
<td>Option</td>
<td>Function</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Title Font</td>
<td>Opens the Font window to select the Font, Font Style, Font Size, and Effects for the title above the graphs in the Electropherograms tab or the Overlay Electropherograms tab. The selected font is also used when exporting the graphs.</td>
</tr>
<tr>
<td>Pin icon</td>
<td>In the top right corner, this is used to lock in place or unlock the Properties tab. If locked in place, the Graph is resized to accommodate the tab.</td>
</tr>
</tbody>
</table>
Gel View

The Gel view in the Collection Pane is a visual representation of the data formatted to look like the Gel slabs that were originally used to provide DNA, Protein, or RNA data. The data is shown in Time vs. Fluorescence (or digital form). (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)

Click on a gel lane (well) to select the well. Ctrl + click to select multiple wells. Selected wells are outlined with a dotted gray line. Wells selected in the Gel view are also selected in the Well Table View and are displayed in the Overlay Electropherograms Tab.

![Figure 62. Gel View](image)

Moving the cursor over a band in the Gel view displays a tool tip that includes the same information about the peak as the Peak Table View. (Changing the columns displayed in the Peak Table will change the contents of the tool tip in the Gel view.)

For DNA assays, the upper and lower markers of all wells are aligned to the upper and lower markers of the first well in the gel view. For Protein and RNA assays, the lower markers of all wells are aligned to the markers of the first well in the gel view.

![Figure 63. Gel Headers](image)
Gel View (Continued)

A colored column header indicates that the well is selected by a filter. Click the Filter View to view the color of each filter. A red exclamation point under the header indicates an analysis error occurred in the well. A yellow exclamation point under the header indicates an analysis warning occurred in the well. A gray header indicates a normal well. To change the size of the gel header, click on the border between the header and the well and drag the header to the desired size.

Expected Peaks are indicated on the gel by colored horizontal lines.

The graphs displayed in the Graph View are synchronized with the lanes selected in the Gel tab.

You can drag-and-drop the gel lanes to change the order of the wells for comparing two or more gel wells. To drag-and-drop a gel lane, click in the header of the lane to be moved and drag the gel lane to the desired location.

Double-click in the Gel view to zoom out to the previous zoom level.

Gel data can be exported to a graphic file by choosing Export on the File Menu (see “Exporting Data” on page 102 for details). If the workspace contains multiple collections, data is exported from the active/selected collection.

To change the Lane Width or Gel Contrast Range, see Gel View Properties.

Right-Click Menu

Right-click anywhere in a gel to display a shortcut menu containing the following commands:

Unzoom - Zooms out to the previous zoom level.

Unzoom All - Zooms out completely and returns to the standard view.

Scale Gel Contrast to this Lane - If selected for a lane, the minimum and maximum RFU values for all lanes in the collection are set to the minimum and maximum RFU values in the selected lane.

Scale Gel Contrast to Collection - Restores the minimum and maximum RFU values for all lanes in the collection to the default values. (Only available when Scale Gel Contrast to This Lane has been selected for a lane.)
Gel View (Continued)

**Remove** - Removes the sample from the collection.

**Copy Gel** - Copies all of the open lanes (wells) to the clipboard in a .bmp format.

**Copy Lane** - Copies the selected lane (well) to the clipboard in a .bmp format.

**Analysis Settings** - Opens the Assay Analysis Window to change the analysis settings.

**Edit Sample Name** - Opens the Sample Name Editor Window to change the well name or add a comment to the well. The comment displays in the Well Table View and in printed reports.

**Rename Plate** - Opens the Rename Plate window to specify a new name for the plate.
Gel View Properties

To view the Gel View Properties, click the **Properties** tab on the right side of the **Gel View**.

![Gel View Properties](image)

**Figure 64. Gel View Properties**

The following properties can be set for the Gel view:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lane Width</td>
<td>Sets the width of the Collection column. Select <strong>Auto Fit</strong> to have the software automatically fit all the data, or use the slider to manually set the width.</td>
</tr>
<tr>
<td>Gel Contrast Range</td>
<td>Sets the minimum and maximum Gel Band Contrast for the bands in each well. Use the sliders to change the min and max values.</td>
</tr>
<tr>
<td>Gel Color</td>
<td>Click on the Foreground color or the Background color to open the Color window to choose the desired colors for the gel.</td>
</tr>
<tr>
<td>Set Lane Label Font button</td>
<td>Opens the Font window to change the font or size of the labels in the gel headers.</td>
</tr>
<tr>
<td>Show Peak Information</td>
<td>If selected, displays peak information in a tool tip when the cursor moves over a peak. If not selected, the tool tip does not display when the cursor is over a peak.</td>
</tr>
<tr>
<td>Show EPs and Smears</td>
<td>If selected, expected peaks are indicated in the gel by colored horizontal lines and smears are indicated by bands of translucent color.</td>
</tr>
<tr>
<td>Show EP/Smear Legend</td>
<td>Displays a legend of the band colors and expected peak sizes or smear sizes in the Gel view. Click and drag to move the legend.</td>
</tr>
<tr>
<td>Option/Button</td>
<td>Function</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Filter Legend</td>
<td>Displays a legend of the colors assigned to each filter. Click and drag to move the legend. Only displays if at least one filter is defined in the Filter tab.</td>
</tr>
<tr>
<td>Pin icon</td>
<td>In the top right corner, this is used to lock in place or unlock the Properties tab. If locked in place, the Gel display panel is resized to accommodate the tab.</td>
</tr>
</tbody>
</table>
Well Table View

The Well Table view in the Collection Pane contains a summary of analysis results for the wells selected from the microplates in the collection.

![Well Table View](image)

**Figure 65. Well Table View**

To change the order of columns in the table, click on a column header and drag the column to the desired position in the table. Click a column header to sort the table in ascending/descending/original order.

Double-click on a **Plate Name** to open the **Rename Plate** window to rename the plate.

Double-click on a **Sample Name** to edit the well name.

Double-click on a **User Comment** to add or edit the User Comment.

For gDNA assays, the Total gDNA Concentration in the Well Table is the concentration of the entire smear region from 0.175kb to 300kb. Use the **Smear Analysis Tab** to change settings or display columns in the Well Table.

The output of an exported Well Table includes the columns in the order displayed in the Well Table at export time. A Well Table is exported to a CSV format, which can be opened in a program such as Microsoft Excel. If the workspace contains multiple collections, the data is exported from the active/selected collection.
Select Well Table Columns Window

Use the Select Well Table Columns window to show or hide columns in the Well Table View. To open the Select Well Table window, right-click on a column header in the Well Table.

The Select Well Table Columns window displays all available columns with the current selections in the Selected Columns list. The columns available depend on the type of data file that is open and the selected analysis settings.

![Select Well Table Columns Window](image)

**Figure 66. Select Well Table Columns Window**

Show or hide columns in the well table by moving the column names between the Available Columns list and the Selected Columns list.

To change the order of the columns displayed in the Well Table, drag and drop the column names in the Selected Columns list. The columns display on the order listed in the Selected Columns list.
Peak Table View

The Peak Table view in the Collection Pane is a text-based representation of all the information about each peak. The Peak Table View is hidden by default for gDNA assays.

![Figure 67. Peak Table View](image)

Change the order of columns in the table by clicking on a column header and dragging the column to the desired position in the table. Click a column header to sort the table in ascending/descending/original order.

To view or hide columns in the Peak Table view, right-click on the column headers in the table. The Select Peak Table Columns window displays all available columns in the Selected Columns list. Show or hide columns in the Peak Table by moving the column names between the Available Columns list and the Selected Columns list in the Select Peak Table Columns window. Drag and drop the column names in the Selected Columns list to change the order of the columns displayed in the Peak Table.
Peak Table View (Continued)

The analysis normally labels the upper marker (UM) (DNA Assays only) and lower marker (LM) in each sample and in the ladder. The labels display in the Type column of the table. If the analysis has misidentified the markers, the correct marker can be selected manually by right-clicking on the peak row to open a shortcut menu of possible peak types for the peak. This can also be used to label a peak as Excluded (X). The concentration of an excluded peak is forced to zero so that it does not affect the total well concentration and the %Purity calculation.

Expected Peaks are indicated by the Expected Peak Name in the Type column.

The output of an exported Peak Table includes the columns in the order displayed in the Peak Table at export time. A Peak Table is exported to a CSV format, which can be imported into a program such as Microsoft Excel. If the workspace contains multiple collections, the data is exported from the active/selected collection.

To show only filtered peaks, sort within each well, or hide excluded peaks, see Peak Table Properties.

Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments. DNA, RNA, and gDNA assays are supported on LabChip GX, and GX II instruments.

Peak Table Columns

The Peak Table can display the following columns:

%Area - (Glycan assay only) The peak's area as a percentage of the total area of peaks within the sample range (> 6.6 CGU).

% of Total Area - (RNA assays only) The area of the RNA fragment divided by the total area. The total RNA area is computed using trapezoidal integration of the electropherogram from the end of the lower marker to the baseline end time. The baseline for the total area is a straight line drawn from the baseline start time to the baseline end time. The height of the baseline at these points is the average signal value over a 5 second region around these points.

% Purity - (Protein assay only) The quantity of protein, expressed as a percentage of the total protein, found in a particular peak.

Aligned Area - If the sample has been aligned, the area of the aligned peaks is reported.
Peak Table View (Continued)

**Area** - The peak area is calculated as the sum of the parallelograms of a point-to-point fit down to absolute zero minus the parallelogram of the local baseline down to absolute zero. Data points are 0.05 seconds apart.

**Barcode** - The barcode on the plate used in the run.

**Baseline** - The center average height of the peak baseline, measured in RFUs.

**Chip ID** - The ID number of the Chip used to run the plate.

**Comment** - Displays any comments associated with the well, either from the Sample Name File selected in the Advanced Tab on the Start Run Window or from the Sample Name Editor Window.

**Conc. (ng/μL)** - (DNA and Protein assays only) The concentration calculated relative to the ladder and marker peak concentrations. The ladder concentration is displayed in the Analysis Tab of the Assay Analysis Window.

**Corr. Area** (Glycan assays) and **Time Corr. Area** (Protein assays) - Displays the mobility corrected area. The area of a peak should represent the total area of the compound responsible for the fluorescence. In the LabChip instruments, the fluorescence of the compound moving past the detector is sampled at constant time intervals unlike the conventional slab gel where the compound is spread out spatially and imaged at a single time. To convert from a peak area integrated in the time dimension to one integrated in the space dimension, we use the fact that $x$ is proportional to $\mu t$ so $\Delta x \propto \mu \Delta t$ and the mobility $\mu$ is proportional to $1/T$ where $T$ is the migration time of the peak. So the Time Corr Area = 100 * Area/T. The 100 is an arbitrary constant designed to keep the corrected area in a range similar to the original area computed from the time series data.

**Date_Time** - The date and time that the plate data file was created.

**Expected Fragment (BP or kb)/ Expected Protein (kDa)/ Expected Glycan (CGU)** - Displays the size of the Expected Fragments, Expected Proteins, or Expected Glycan.

**Fragment Area** - (RNA assays only) The sum of the trapezoids between the fragment start and end times. The trapezoid base is a line drawn across the fragment base from the start point to the end point.
Peak Table View (Continued)

**Fragment End (sec)** - (RNA assays only) Amount of time from injection to the falling edge of the fragment in seconds.

**Fragment Start (sec)** - (RNA assays only) Amount of time from injection to the leading edge of the fragment in seconds.

**FWHM** - The width of the peak (Full Width at Half Maximum), measured in seconds.

**Height** - The value at the apex of the peak minus the local baseline start value.

**Instrument Name** - The name of the instrument that was used to run the plate and create the data file.

**Molarity (nmol/l)** - (DNA and gDNA assays only) Displays the molarity of the peak.

**Migration Time - Center** - The time from injection to the peak apex in seconds.

**Peak Index** - The index number of the peaks in the sample. Marker peaks, peaks before the lower marker, and peaks after the upper marker are not numbered.

**Peak Number** - The order in which the peaks were detected for each well. All peaks in each well are numbered, starting at 1.

**Plate File** - The name of the original plate data file. This name cannot be changed.

**Plate Name** - The name of the plate defined in the workspace.

**Plate Number** - The number of the plate in the same order as the plates are displayed in the Plate View or Plate List.

**RNA Fragment** - (RNA assays only) The name of the fragment based on its size falling within a certain range set in the assay definition. (These definitions are visible only to assay developers).

**Sample Name** - The sample name defined in the Sample Name File selected in the Advanced Tab on the Start Run Window. The Sample name can also be changed in the Well Table View or the Gel View.

**Signal Noise** - The statistical standard deviation of 1 second of data just before the Peak Find Start Time.
Peak Table View (Continued)

Size (BP for DNA assays, kb for gDNA assays, KDa for Protein assays, nt for RNA assays, CGU for Glycan assays) - The size of the peak based on the ladder sizes specified in the assay.

Type - Displays the type of peak for markers or expected peaks.

Well Label - The row letter and column number of the well (A1 - H12 for 96-well plates, or A1 - P24 for 384-well plates).

Well Number - The number of the well in the same order as the wells were selected in the collection. See Selecting the Wells in a Collection.

Peak Table View Shortcut Menus

Right-click on a peak in the peak table to display a shortcut menu containing the following commands:

- Exclude Peak
- Include Peak (for excluded peaks, peaks of type "?", or System Peaks in Protein assays)
- Force Lower Marker
- Force Upper Marker (DNA assays only)
- Force Expected Peak

NOTE: Excluding a peak or manually setting a peak to be an upper or lower marker can cause analysis errors.
Peak Table Properties

To view the Peak Table Properties, click the Properties tab on the right side of the Peak Table View.

Figure 68. Peak Table Properties

This window contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort within each well</td>
<td>If selected (default), sorting occurs only within each well rather than across the entire table. Click a column header to sort the table rows by the column value. If cleared, uses conventional sorting, which mixes together peaks from all wells. Clicking the column header sorts in ascending/descending/original order.</td>
</tr>
<tr>
<td>Hide excluded peaks</td>
<td>If selected, excluded peaks and unknown peaks are hidden in the Peak Table view. In protein assays, the analysis excludes system peaks, which are compounds that are artifacts of the assay chemistry and not generally of interest.</td>
</tr>
<tr>
<td>Expected Peaks only</td>
<td>If selected, only peaks identified as Expected Peaks display in the Peak Table.</td>
</tr>
<tr>
<td>Filtered peaks only</td>
<td>If selected, the Peak Table displays only peaks that match the filter criteria. Useful when generating a collection based on a filter whose selection criteria are peak specific, such as Area, Concentration, %Purity, Expected Peaks, and Size.</td>
</tr>
<tr>
<td>Selected in Gel</td>
<td>If selected, only the gel lanes selected in the Gel View display. To select multiple wells, Ctrl + click on the lanes in the Gel view.</td>
</tr>
<tr>
<td>Entire Collection</td>
<td>If selected, all wells in all plates that are included in the collection are displayed.</td>
</tr>
<tr>
<td>Pin icon</td>
<td>In the top right corner, used to lock in place or unlock the Properties tab. If locked in place, the Peak Table display panel is resized to accommodate the tab.</td>
</tr>
</tbody>
</table>
Filter View

The Filter view in the Collection Pane is used to define criteria to select wells for a collection automatically. The filter types available depend on the type of assay that was used to create the data. Each filter can be assigned a different color to determine which filter applies to each well. See Example: Expected Peaks Filter for an example of a filter.

One or more filters can be defined independently by selecting the appropriate filter type, range mode, and range values, and then clicking the Add button. The Available Filters list box displays all of the filters that are part of the current collection. The check box next to each filter in the list is used to include or exclude that filter from the analysis.

The Filter Options selection determines how multiple filters are logically combined. The options available are OR, AND(Peak), and AND(Well).

- **OR** - Selects any well that contains a peak that matches any of the filters selected in the Available Filters list.
- **AND(Peak)** - Selects any well that contains a single peak that matches all of the filters selected in the Available Filters list.
- **AND(Well)** - Selects any well that contains peaks that match all of the filters selected in the Available Filters list. Different peaks in the same well can match different filters, as long as all filter conditions are met in the same well.
Filter View (Continued)

The **Quadrant Select** panel specifies which quadrants of all plates in the collection will have the specified filters applied to them. Selecting a quadrant check box applies the specified filters to that quadrant. Clearing a quadrant check box excludes that quadrant from the specified filters.

**Example: Expected Peaks Filter**

In the example below, the sizes 100 +/- 10%, 300 +/- 10%, and 500 +/- 10% are selected, with each expected peak size identified by a different color. This filter will select any wells that contain all three expected peaks: 100, 300, AND 500. Note that the filter is selected (checked) under Available Filters, indicating that the filter is being applied to the data.

To select wells that contain any of the three peaks, create a separate filter for each peak and select OR as shown below.
Filter View (Continued)

When using multiple filters that include peak properties, if AND(Peak) is selected, a single peak in the well must meet all selected filter properties. See the examples below, which each use two filters:

- Height > 100 AND(Peak) Conc > 50 selects any well that contains a single peak that meets both criteria.
- Height > 100 OR Conc > 50 selects any well that contains a peak that meets either (or both) criteria.
- Height > 100 AND(Peak) Height < 50 does not select any wells because no peak can have a height that is both less than 50 and greater than 100. Use OR to select wells that have peaks that match either criteria. Use AND(Well) to select wells that contain peaks that match both criteria.

Expected Peak Filters can contain multiple size peaks in the same filter as shown above. Expected Peak filters with multiple peak sizes in the same filter always select only wells that contain all the peaks listed.
Filter View (Continued)

In the Plate diagram (above), the pink and black wells are the wells that meet the filter criteria. To see the gels of each well, click on the well in the Plate diagram and view the gel in the Gel view. To see the graph for each well, click on the well in the Plate diagram and view the graph in the Graphs view.

The gel (above) shows the expected peaks marked with colored lines on the Gel view. The well header is pink if the well meets the filter criteria for the first filter, and black if it meets the filter criteria for both the first and second filters.

About LabChip GX Window

The About LabChip GX window displays the software and firmware versions. Selecting About LabChip GX on the Help Menu opens this window.

![Figure 70. About LabChip GX Window](image)
Add New Expected Peak Window

Use the Add New Expected Peak Window to add an expected peak to specific wells. To open this window, right-click near a peak in the Graph View and select Add Expected Peak.

![Figure 71. Add New Expected Peak Window](image)

| **Size** | Specifies the expected size of the peak in BP for DNA assays, kb for gDNA assays, kDa for Protein assays, and CGU for Glycan assays. The default size is the size of the peak that was selected. |
| **Time** | Specifies the expected time of the peak in seconds. The default is the time of the peak that was selected. (Only for CZE assays.) |
| **Window (%)** | Specifies the tolerance window as a percent of the expected size for the fragment/protein/glycan to allow for small variations in expected peak size. |
| **Color** | Displays the color to use to mark the peak in the Graph View or the Gel View. |
| **Name** | Specifies a name to display in the Type description for the peak. |
| **Property Displayed in Well Table** | Specifies the content of a column added to the well table for each expected peak. |
| **For Aligning** | If selected, the data signal is realigned so the selected expected peaks match their aligned size. Note that incorrect alignment settings can cause analysis errors. |
| **Apply to Wells** | Specifies the wells that the expected peak is applied to. <All> specifies that the expected peak applies to all wells. Clicking on the column opens the Select Wells window to choose the specific wells to apply the expected peak to. |
Add Plate Window

Use the Add Plate window to add new plates to the system. To open the Add Plate window, click the **Add Plate** button on the **Plate Information Window**.

![Add Plate Window](image)

**Figure 72. Add Plate Window**

The Add Plate window contains the following settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Plate Name</strong></td>
<td>Specifies the plate name that displays in the Start Run Window.</td>
</tr>
<tr>
<td><strong>Plate Type</strong></td>
<td>Specifies the number of wells in the plate, either 96 or 384.</td>
</tr>
<tr>
<td><strong>X Margin</strong></td>
<td>The distance from the outer edge of the plate to the center of well A1 in the X direction.</td>
</tr>
<tr>
<td><strong>Y Margin</strong></td>
<td>The distance from the outer edge of the plate to the center of well A1 in the Y direction.</td>
</tr>
<tr>
<td><strong>Plate Height</strong></td>
<td>The distance from the bottom of the plate to the top of the plate.</td>
</tr>
<tr>
<td><strong>Well Depth</strong></td>
<td>The distance from the top of the plate to the bottom of the well.</td>
</tr>
<tr>
<td><strong>Sip Height</strong></td>
<td>The distance from the bottom of the well to the bottom of the sipper when the sipper is positioned to sip sample from the well.</td>
</tr>
</tbody>
</table>
Assay Analysis Window

The Assay Analysis window specifies the analysis parameters. These settings are used to display assay settings and change the analysis and peak finding parameters to help resolve hard-to-decipher data. To open the Assay Analysis window, select **Analysis** \(\rightarrow\) **Analysis Settings** on the main menu.

The Assay Analysis window contains the following tabs:

- Assay Information Tab
- Alignment Tab
- Analysis Tab
- Peak Find Tab
- Expected Fragments/Proteins/Glycans Tab
- Excluded Peaks Tab
- Smear Analysis Tab
- Titer Tab
- Advanced Tab

The following buttons at the bottom of the Assay Analysis window are used to save, apply, or cancel changes:

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply</td>
<td>Apply setting changes and re-analyze the plate but keep the Assay Analysis window open.</td>
</tr>
<tr>
<td>Apply Global</td>
<td>Applies the selected analysis settings to all plates in the open workspace.</td>
</tr>
<tr>
<td>Export As Assay</td>
<td>Opens the Export Assay Settings from Plate to Assay file window to specify a name and location for a new assay file (*.asy or *.asyx). Clicking Save creates a new assay file with the settings in the Assay Analysis Window.</td>
</tr>
<tr>
<td>Restore Plate</td>
<td>Opens the Restore Plate Settings To Version window to restore the data file to the selected version.</td>
</tr>
<tr>
<td>OK</td>
<td>Apply changes in the Assay Analysis window and re-analyze the plate with these new settings.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Opens the Print Preview window to view the analysis settings before printing.</td>
</tr>
<tr>
<td>Print</td>
<td>Opens the Print window to print the analysis settings.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Restores the settings that were selected when the window was opened or when the last Apply was performed. No re-analysis is performed because the settings were used for the last analysis performed.</td>
</tr>
</tbody>
</table>
Assay Information Tab

The Assay Information tab on the Assay Analysis Window displays the header information for the current plate. The information displayed was specified when the assay was run and cannot be changed.

![Assay Analysis Window - Assay Info Tab](image)

**Figure 73. Assay Analysis Window - Assay Info Tab**

The following read-only information is displayed:

**Assay Class** - Either DNA, gDNA, Protein, RNA, or Glycan. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)

**Name** - The name of the assay.

**Title** - The title of the assay.

**Comments** - Comments from the assay that was run.

**Version** - The version of the assay that was run.

**Format** - The format of the data file.

**Compatibility** - The version of LabChip GX software that supports the assay.

**Plate** - The name of the plate in the workspace. Usually the same as the name of the data file that was created when the plate was run, unless the name is changed after it is added to the workspace.
Alignment Tab

The Alignment tab on the Assay Analysis Window is used to assign alternate ladders to a specified group of wells in the event of a faulty ladder result. The default assignment for full rows uses the ladder adjacent to the row where the sample is located. If this ladder cannot be analyzed, the software automatically looks for another nearby ladder to perform the analysis. The actual ladder used for the analysis is shown in the Well Peak Find Settings panel of the Peak Find Tab. It can be changed by selecting the “Align Well Groups to Specified Ladder” option and then selecting a different ladder in the “To Ladder” column corresponding to the row to be changed.

For Protein, Glycan, and gDNA assays, which do not use an upper marker, alignment is normally performed with ladders on each end of the row to compensate for drift between start and end of each row. This feature can be disabled by selecting “Align Well Groups to Previous Ladder” or “Align Well Groups to Specified Ladder” instead of “Align Well Groups to Bracketed Ladder”.

Protein Charge Variant assays do not use ladders to align the data. The Alignment tab is not shown for Protein Charge Variant assays.

![Figure 74. Assay Analysis Window - Alignment Tab](image)

The Alignment tab contains the following settings:

- **Align Well Groups to Previous Ladder** - If selected, each row is aligned to the ladder at the beginning of the row.
- **Align Well Groups to Bracketing Ladders** - (Protein, Glycan, and gDNA assays only.) If selected, each row is aligned with the ladder at the beginning of the row and a ladder at the end of the row. (Protein and Glycan assays are only supported on LabChip GX II instruments.)
Alignment Tab (Continued)

- **Align Well Groups to Specified Ladders** - If selected, each row is aligned with the ladder selected in the table.

**Markers** - Displays the markers that are used for alignment. This setting is determined by the assay type and cannot be modified.

**Ladder Rejection Threshold** - Specifies the minimum Ladder Quality Score required to accept a ladder. If a ladder is below this threshold, the ladder is flagged as an error well and is not used for sizing or quantization. Set the value to 0 to turn off this feature.

To view the unaligned data (spike rejected, filtered, and baseline corrected), select **Turn Off Analysis** from the Analysis menu.

Analysis Tab

Use the Analysis tab on the Assay Analysis Window to view the Upper and/or Lower marker peak designation (this setting cannot be changed) or to view or change the Ladder Sizes, Ladder Concentration, Standard Curve (not available for CZE assays), Data Range, Marker Concentration (DNA) Dilution Ratio (Protein), and System Peak Exclusion (Protein). Protein Charge Variant assays only show the Data Range. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)

![Figure 75. Assay Analysis Window - Analysis Tab](image)

**Ladder Sizes**

A table showing the sizes of the ladder peaks in bp (base pairs) for DNA, kDa (kiloDaltons) for protein, nt (nucleotides) for RNA, or kb (kilo base pairs) for gDNA assays. Click in the Size column and type the desired size to change the ladder size. (Not available for Protein Charge Variant assays.)
Analysis Tab (Continued)

**Clear Default Ladder button**
Displays at the bottom of the Ladder Sizes if a default ladder is defined for the plate. (Not available for Protein Charge Variant assays.)

**Ladder Concentration**
The concentration (in ng/uL) for the ladder peaks. (Not available for Glycan or Protein Charge Variant assays.)

**Standard Curve**
Determines whether the fit for the standard curve used to calibrate migration time to size will be done on a point-to-point, logarithmic, or Polynomial fit of the ladder. DNA, gDNA, and Glycan assays are set to point-to-point curve fits but can be changed to Polynomial. RNA assays are set to point-to-point curve fits but can be changed to Logarithmic. Protein assays are set to Log and cannot be changed. (Not available for Protein Charge Variant assays.)

**Data Range**
- **Baseline** - Specifies the time in seconds after the start of the run when the first peak can appear (any peaks appearing before this time are ignored).
- **Well End** - Specifies the time when peak detection stops. The graph ends at this time.

**Dilution Ratio (Protein assays only)**
Used to compensate for differences between sample and ladder dilutions in the computation of the sample peak concentrations.
- **Ladder** - Reflects a dilution of ladder in a total volume of ladder and sample buffer according to the LabChip GX/GXII Assay User Guide.
- **Sample** - Reflects a dilution of sample in a total volume of sample, water, and sample buffer according to the LabChip GX/GXII Assay User Guide.

**System Peak Exclusion (Protein and Glycan assays only)**
Used to specify the region where System peaks are to be tagged and excluded from the analysis.
- **Ladder Ratio** - Time at which ladder peaks are detected as ladder peaks rather than system peaks. For example, if the ladder ratio is set to 1.5, the software multiplies the lower marker migration time x 1.5 and then begins ladder peak identification. In this example, if the lower marker elutes at six seconds, the ladder peak detection starts at 6x1.5 or 9 seconds.
Analysis Tab (Continued)

- **Min. Sample Size (kDa or CGU)** - Size at which peaks are identified as sample peaks rather than system peaks (except the Lower Marker).

**Markers (DNA, gDNA, and Glycan assays only)**
- DNA and gDNA assays: The concentration (ng/uL) and size for the upper and lower markers for the assay.
- Glycan assays: The size of the lower marker.
- If a default Ladder is defined for the plate, the Marker Migration Time, Height, and Area are available for editing.
Peak Find Tab

Use the Peak Find tab on the Assay Analysis Window to adjust parameters to detect peaks for individual wells, rows, columns, a single plate, or the entire plate specified in the Plate field.

![Figure 76. Assay Analysis Window - Peak Find Tab](image)

Initial individual plate and well selections are made by right-clicking on a well in the Gel View or the graph in the Graph View and selecting the Analysis Settings option. The corresponding well settings are displayed in the Well Peak Find Settings fields. Subsequent well selections in a plate can be made using the Well drop-down list. The well list includes all the wells on the current plate that are selected. The Plate and Well Name fields are read only, and cannot be changed from the Peak Find Tab. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)
Peak Find Tab (Continued)

This window contains the following options:

Table 1. Plate Peak Find Settings

<table>
<thead>
<tr>
<th>Plate Settings</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Peak Height</td>
<td>Specifies the height limit below which a peak is not detected. For each peak, the difference between the peak start time and the peak apex must be greater than the Min Peak Height value.</td>
</tr>
<tr>
<td>Minimum Peak Width</td>
<td>Specifies the limit (in seconds) for the peak width. Peaks narrower in time than this value are not detected.</td>
</tr>
<tr>
<td>Slope Threshold</td>
<td>Represents the amount of change in absorbance units over time required to indicate that a peak has occurred. This setting is used to detect the start and end of a peak. Increasing this setting may cause broad rolling bumps to be ignored or merge multiple bumps into a single peak. Decreasing this setting will broaden the peaks' width and potentially pick up broad bumps as peaks. See “Understanding Peak Finding” on page 108 for more information.</td>
</tr>
<tr>
<td>Inflection Threshold</td>
<td>Represents the value that the slope minimum must be below to trigger a splitting of the peak. As the threshold is increased, more peak splitting occurs. See “Understanding Peak Finding” on page 108 for more information.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Specifies the time after the start of a run when the first peak will be detected (any peaks appearing before this time are ignored). The Gel and Graph views will not plot data earlier than this time.</td>
</tr>
<tr>
<td>End Time</td>
<td>Specifies the time after which peak detection stops. The Gel and Graph views will not plot data beyond this time.</td>
</tr>
<tr>
<td>Filter Width</td>
<td>Specifies the width, in seconds, of the low pass filter to be convolved with the data. The width of this filter should be about 6 samples wide (i.e. 0.1 sec for 60 Hz sampling). If this setting is too large, peaks will develop spurious side lobes (ringing) due to over-filtering.</td>
</tr>
<tr>
<td>Baseline Plateau</td>
<td>Specifies a baseline selection parameter for peak finding. The signal is at baseline whenever the slope of the data is less than the slope threshold setting (positive or negative) for longer than the Baseline Plateau. This rejects brief, low slope areas such as in between non-baseline-resolved peaks.</td>
</tr>
<tr>
<td>Polynomial Order</td>
<td>A filter algorithm is used to filter the data, increasing the signal-to-noise ratio. The data is convolved with a polynomial of this order to produce filter data and a filter slope and decrease the background or baseline noise and/or spikes in the signal. This value is read only.</td>
</tr>
</tbody>
</table>
Table 1. Plate Peak Find Settings

<table>
<thead>
<tr>
<th>Plate Settings</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude System Peaks</td>
<td>(Protein and Glycan assays only) If selected, excludes the system peak (peak due to buffer constituent) from any changes to the peak find settings (the most recent custom ladder settings are used instead).</td>
</tr>
<tr>
<td>Baseline Curve</td>
<td>• <strong>None</strong> - No correction.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Zero Baseline</strong> - Offsets all graphs to zero baseline but does not affect analysis.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Baseline Subtraction</strong> - A dynamic subtraction of the baseline that corrects for drifting Baseline. Select the desired method for generating the baseline curve:</td>
</tr>
<tr>
<td></td>
<td>— <strong>Spline</strong> - Creates a smooth line fit to the baseline data points and subtracts this smooth fit from the data. The Threshold determines how much the baseline fit follows changes in the data.</td>
</tr>
<tr>
<td></td>
<td>— <strong>Rolling Ball</strong> - Generates a smooth baseline curve by mathematically rolling a ball under the sample signal, keeping it in contact with the closest signal point without crossing into the signal. Time Diameter and Signal Diameter determine the smoothness of the curve in the Time and Signal axes.</td>
</tr>
<tr>
<td>High Size Filtering</td>
<td>If selected, a second, larger filter is applied to the data after the specified time. This is useful for assays where the peaks are narrow at the start of the assay and become broad and noisy for larger sizes of DNA, protein or Glycan. If not selected, the same size filter is used for all data.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Filter Width (sec)</strong> - The width of the second filter to be applied after the specified transition time. Filter Width must be greater than the Sample Well Filter width and less than or equal to 3.0 seconds.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Transition Time (sec)</strong> - The time at which to transition to the larger filter size. Transition time must be greater than the Baseline Time on the Analysis tab and less than the Well End time.</td>
</tr>
</tbody>
</table>

Table 2. Well Peak Find Settings

<table>
<thead>
<tr>
<th>Well Settings</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well</td>
<td>Displays the well being edited. Select any well or ladder on the plate belonging to the current collection.</td>
</tr>
</tbody>
</table>
### Table 2. Well Peak Find Settings

<table>
<thead>
<tr>
<th>Well Settings</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ladder</td>
<td>Read only. Displays the ladder used for aligning this well. Use the Alignment tab to edit. New value displays here after clicking Apply. (Not available for Protein Charge Variant assays.)</td>
</tr>
<tr>
<td>Bracket</td>
<td>Read only. Displays the bracket ladder used for aligning this well. Use the Alignment tab to edit. New selection displays here after clicking Apply. (Only for gDNA and Protein assays if Align Well Groups to Bracketed Ladders is selected on the Alignment tab.)</td>
</tr>
<tr>
<td>Minimum Peak Height</td>
<td>Specifies an override to the Peak Find Settings for Minimum Peak Height for the entire plate. Specify a valid numeric value to override, or clear the field to reset to the Global setting.</td>
</tr>
<tr>
<td>Minimum Peak Width</td>
<td>Specifies an override to the Peak Find Setting for Minimum Peak Width for the entire plate. Specify a valid numeric value to override, or clear the field to reset to the Global setting.</td>
</tr>
<tr>
<td>Slope Threshold</td>
<td>Specifies an override to the Peak Find Setting for Slope threshold for the entire plate. Specify a valid numeric value to override, or clear the field to reset to the Global setting.</td>
</tr>
<tr>
<td>Use Plate Value button</td>
<td>Sets Min Peak Height, Min Peak Width, and Slope Threshold text boxes to &lt;Uses plate value&gt; settings.</td>
</tr>
<tr>
<td>Save as Default Ladder</td>
<td>Sets the selected ladder to the default ladder for the plate. Does not align any wells to the default ladder. (Only available for DNA and RNA assays.)</td>
</tr>
<tr>
<td>Apply Well/Ladder</td>
<td>Apply well-specific peak find settings only to the well or ladder showing in the Well field.</td>
</tr>
<tr>
<td>Apply Row</td>
<td>Apply well-specific peak find settings to all wells in the same row as the selected well.</td>
</tr>
<tr>
<td>Apply Column</td>
<td>Apply well-specific peak find settings to all wells in the same column as the selected well.</td>
</tr>
<tr>
<td>Apply All Ladders</td>
<td>(Displays only if a ladder is selected in the Well field.) Applies peak find settings to all ladders in the plate.</td>
</tr>
<tr>
<td>Apply Plate</td>
<td>Apply well-specific peak find settings to all wells on the same plate.</td>
</tr>
</tbody>
</table>

---

**Software Reference** 195

V4.2  LabChip GX User Manual  PerkinElmer
Expected Fragments/Proteins/Glycans Tab

Use the Expected Fragments/Proteins/Glycans tab on the Assay Analysis Window to enter Expected Fragments for DNA or gDNA assays, Expected Proteins for Protein assays, Expected Glycans for Glycan assays, or Expected Peaks for Protein Charge Variant assays. (See “Using Expected Fragments/ Expected Proteins/ Expected Glycans” on page 67 for more information.) After the data is analyzed, any peaks matching the expected fragments, proteins, or glycans are shown in the Peak Table View, Well Table View, Gel View, and Graph View (if Type is selected as an Annotation in the Graph View Properties). (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GXII instruments.)

Figure 77. Assay Analysis Window - Expected Fragments Tab

The Expected Fragments/Proteins/Glycan tab contains the following options and buttons:

Expected Peak Table - Lists the expected peaks for the assay analysis.

- **Size** - Specifies the expected size of the peak in BP (DNA), kb (gDNA), kDa (Protein), or CGU (Glycan).
- **Time** - Specifies the expected time of the peak (Protein Charge Variant only).
- **Window (%)** - Specifies the tolerance window as a percent of the expected size for the peak to allow for small variations in expected peak size.
Expected Fragments/Proteins/Glycans Tab (Continued)

- **Color** - Displays the color to use to mark the peak in the Graph View or the Gel View.
- **Name** - Specifies a name to display in the Type description for the peak.
- **Property Displayed in Well Table** - Specifies the content of a column added to the well table for each expected peak.
- **For Aligning check box** - If selected, the data signal is realigned so the selected expected peaks match the specified size or time. Note that incorrect alignment settings can cause analysis errors.
- **Apply to Wells** - Specifies the wells that the expected peak is applied to. <All> specifies that the expected peak applies to all wells. Clicking on the column opens the Select Wells window to choose the specific wells to apply the expected peak to.

**Import button** - Opens the Import Expected Fragments/Proteins/Glycan Table window to select an Expected Peak File (.gep) to import. The .gep file is created by exporting expected peaks from another assay.

**Clear button** - Deletes all Expected Peaks from the table.

**Restore button** - Restores the settings to the last saved settings for expected peaks.

**Export button** - Opens the Export Expected Fragments/Proteins/Glycans window to create an Expected Peak File (.gep) from the current settings in the tab. Import the .gep file into another assay to use the same expected peaks in another assay.
Excluded Peaks Tab

Use the Excluded Peaks tab on the Assay Analysis Window to enter Excluded Fragments for DNA or gDNA assays, Excluded Proteins for Protein assays, Excluded Glycans for Glycan assays, or Excluded Peaks for Protein Charge Variant assays. After the data is analyzed, any peaks matching the excluded peaks are excluded from the analysis. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)

The Excluded Peaks tab contains the following options and buttons:

**Excluded Peak Table** - Lists the excluded peaks for the assay analysis.

- **Size** - Specifies the size of the excluded peaks in BP(DNA), kb (gDNA), kDa (Protein), or CGU (Glycan).
- **Time** - Specifies the expected time of the peak (Protein Charge Variant only).
- **Window (%)** - Specifies the tolerance window as a percent of the size of the peak to allow for small variations in peak size.
- **Color** - Displays the color to use to mark the peak in the Graph View or the Gel View.
- **Name** - Specifies a name to display in the Type description for the peak.
Excluded Peaks Tab (Continued)

- **For Aligning check box** - If selected, the data signal is realigned so the selected excluded peaks match the specified size or time. Note that incorrect alignment settings can cause analysis errors.

- **Exclude All** - If selected, all peaks in the specified range are excluded from analysis.

- **Apply to Wells** - Specifies the wells that the excluded peak is applied to. <All> specifies that the excluded peak applies to all wells. Clicking on the column opens the Select Wells window to choose the specific wells to apply the excluded peak to.

**Export button** - Opens the Export Excluded Peaks window to create an Excluded Peaks File (.gep) from the current settings in the tab. Import the .gep file into another assay to use the same excluded peaks in another assay.

**Restore button** - Restores the settings to the last saved settings for excluded peaks.

**Import button** - Opens the Import Excluded Peaks window to select an Excluded Peak File (.gep) to import. The .gep file is created by exporting excluded peaks from another assay.

**Clear button** - Deletes all Excluded Peaks from the table.
Smear Analysis Tab

Use the Smear Analysis tab on the Assay Analysis Window to define Smears. After the data is analyzed, the area matching the smear is shown in the Well Table View, Gel View (if Show EPs and Smears is selected in the Gel View Properties), and Graph View (if Show Smears is selected in the Graph View Properties).

Figure 79. Assay Analysis Window - Smear Tab

The Smear Analysis tab contains the following options and buttons:

**Smear Table** - Lists the smears for the assay analysis.

- **Start Size/Time** - Specifies the starting size (time for Protein Charge Variant) of the area to be included in the smear.
- **End Size/Time** - Specifies the ending size (time for Protein Charge Variant) of the area to be included in the smear.
- **Color** - Displays the color to use to mark the smear in the Graph View or the Gel View.
- **Name** - Specifies a name to display in the Well Table View.
- **Property Displayed in Well Table** - Specifies the content of a column added to the Well Table for each smear.

For gDNA assays, the Total gDNA Concentration in the Well Table is the concentration of the entire smear region from 0.175kb (or the specified smear start size) to 300kb.

- **Apply to Wells** - Specifies the wells that the smear is applied to. <All> specifies that the smear applies to all wells. Clicking on the column opens the Select Wells window to choose the specific wells to apply the smear to.
Smear Analysis Tab (Continued)

**Export button** - Opens the Export Smear Analysis Table window to create a Smear Analysis Export File (.sma) from the current settings in the tab. Import the .sma file into another assay to use the same smear in another assay.

**Restore button** - Restores the settings to the last saved settings for smears.

**Import button** - Opens the Import Smear Analysis Table window to select an Smear Analysis Import File (.sma) to import. The .sma file is created by exporting smears from another assay.

**Clear button** - Deletes all smears from the table.
Titer Tab

Use the Titer tab on the Assay Analysis Window to specify the wells in the plate that contains the standard to be used as the calibration standard. The Titer is used for calibration instead of the ladder. (Titer is not available for Glycan or Protein Charge Variant assays.)

The Titer tab contains the following options and buttons:

**Titer Table** - Lists the standard size, well locations, and concentrations for the titer on the plate.

- **Size** - Specifies the size of the standard in BP for DNA, kb for gDNA, nt for RNA, or kDa for Protein assays.
- **Window (%)** - Specifies the tolerance window as a percent of the size for the standard to allow for small variations in size.
- **Found in Well** - Specifies the location of the standard in the plate. Type the well number or double-click to select the well in the plate diagram. (Not displayed for imported titers.)
- **Normalized Area** - Specifies the titer peak normalized area for imported titers. The table for imported titers is Read Only and cannot be edited. (Not displayed for manually entered titers.)
- **Concentration** - Specifies the concentration of the standard in the specified well.
Titer Tab (Continued)

- **Name** - Specifies a name to display in the Type description for the peak.

**Import Titer from Another Plate** - Selecting the check box opens the Select Plate For Titer Import window to select the desired titer from another plate. The plate must be open in the collection, the titer curve must be analyzed, and the normalization peak must match. The normalization peak is set in the Analysis tab: Lower Marker, Upper Marker (DNA only), or Sample Peak. If the Sample Peak option is used, the peak size specified must also match. If no compatible plate is found in the workspace, a message displays and the Import is cancelled. Clearing the check box returns to the manually entered titer.

**Concentration to Favor in Fit** - Adjusts the weight of the points in the linear fit for the Titer Standard Curve. The points are weighted by raising the concentration to a power depending on the slider position. Each line on the slider represents a ½ power increment, with the center position equal to 0. The left most position raises the concentration to the power -2.5. The right most position raises the concentration to the power of 2.5 to weight each point.

**Force Fit through Origin check box** - If selected, the Titer Standard Curve is forced to include the origin (0,0). This prevents very small peaks from generating negative concentrations.

**Fit Model** - Choose Linear or Quadratic to fit the Standard Curve to the Titer. Linear: \( y = a + bx \). Quadratic: \( y = a + bx + cx^2 \).

**Plot Titer Curve button** - Plots the Titer Standard Curve using linear regression to fit the data to a straight line and displays the User Titer Window. Printing the Titer from the User Titer Window prints a report that contains the Titer graph, the fit parameters (fit model, concentration weight, origin option), fit coefficients, fit quality (\( R^2 \)), and the data table (normalized area vs concentration).
Titer Tab (Continued)

**Select Titer Plate button** - Opens the Select Plate For Titer Import window to select a different plate from which to import a titer. The plate must be open in the collection, the titer curve must be analyzed, and the normalization peak must match. The normalization peak is set in the Analysis tab: Lower Marker, Upper Marker (DNA only), or Sample Peak. If the Sample Peak option is used, the peak size specified must also match. Only displays after a titer has been imported.

**Export button** - Opens the Export Titer Table window to create a Titer Export File (.ttr) from the current settings in the tab. The exported titer contains the entries in the titer table, Concentration to Favor in Fit, Force Fit through Origin, and Fit Model. Import the .ttr file into another assay to use the same titer in another assay.

**Restore button** - Restores the settings to the last saved titer settings.

**Import button** - Opens the Import Titer Table window to select an Titer Import File (.ttr) to import. The .ttr file is created by exporting a titer from another assay.

**Clear button** - Deletes all entries from the table. Clear the entries to use the default Standard Curve instead of the Titer Standard Curve.
Advanced Tab

Use the Advanced tab on the Assay Analysis Window to select the Quantification, Peak Size Calibration point, Concentration Size Correction, Peak Integration Mode, and Marker Find settings.

Figure 81. Assay Analysis Window - Advanced Tab

Quantification
Determines whether the upper marker, lower marker, or a sample peak is used for quantitation. Protein, RNA, and gDNA assays use the lower marker. DNA assays use the upper marker. DNA and RNA settings cannot be changed. For Protein and gDNA assays, selecting Sample Peak uses the Peak Size and Concentration of the User Standard instead of the default ladder settings. Not available for Glycan or Protein Charge Variant assays. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)

Peak Size Calibration Point
Specifies which part of the peak is used as the size calibration point.
- Leading Edge - If selected, uses the start of the peak. (May be better when sample peaks are broader than ladder peaks.)
- Center - If selected, uses the top of the peak. (May be better when the leading edge is not well-defined.)

Concentration Size Correction (Protein assays only)
Protein concentration is size-corrected to account for differences in the amount of protein injected into the separation channel based on its size. The correction is obtained using the formula:
- Conc(Size Corrected) = Conc(Time Corrected Area) * Amplitude * (Size)^Power

The default values for the Concentration Size Correction were determined empirically by measuring a wide range of proteins of known size and concentration. This correction can be bypassed by setting Amplitude = 1.0, Power = 0.0.
Advanced Tab (Continued)

**Peak Integration Mode**
Specifies the mode for determining the baseline.

- **Peak Baseline** - A global peak baseline is used as the baseline for all peaks. This baseline is determined by stitching together regions of low variance across the data signal.
- **Valley to Valley** - Each peak is assigned a baseline by drawing a line under the peak joining the start and end of the peak at the data signal values.

**Smear Baseline**
Specifies the method for determining the Smear Baseline. This option only displays after a smear has been added in the Smear Analysis tab. Not available for Protein Charge Variant assays.

- **Two Point** - The baseline is a single straight line between the flat baseline areas at the beginning and end of the trace. This option is preferred for very shallow smears where the signal slope does not rise above the Peak Slope Threshold.
- **Peak Baseline** - The Smear baseline uses the local peak baseline for the start and end points of the smear baseline. If the signal slope is below the peak slope threshold, the local peak baseline follows the signal.

**High Conc Size Corr**
Specifies the method of correction for the ladder migration time when the sample concentration is significantly higher than the ladder concentration. The ladder migration time is corrected independently for each well to compensate for the increased migration speed of high concentration samples. The desired option can be selected in the Assay Editor window before the sample is run, and cannot be changed after the sample is run.

- **Disabled** - The ladder migration time is not corrected
- **Linear** - The ladder migration time correction is proportional to the sample to ladder concentration ratio.
- **Nonlinear** - The ladder migration time correction is a function of the ratio of sample and ladder concentrations and saturates at very high sample concentrations. (Default)
Advanced Tab (Continued)

**Smear Smoothing**
Fits a smooth spline curve to the smear and replaces the actual data signal with the spline curve. Smear smoothing smooths out rough smears that can be generated by the DNA High Sensitivity assay when evaluating very low concentration samples. If the smear is very rough and a minor peak or noise spike is significantly higher than the smear, the Size at Maximum property may be the height of the spike, instead of the height of the smear. Use Smear Smoothing and adjust the Threshold until the smear is smooth.

- **Disabled** - The actual data signal is used to calculate the smear properties. (Default)
- **Spline** - A spline curve is fit to the data and replaces the actual data signal for analysis.
  - **Threshold** - Specifies how closely the spline curve follows the data signal in the smear. The higher the Threshold, the more closely the curve follows the data.

**Marker Find**
The Marker Drift Tolerance specifies a percent of migration time to use when determining the correct marker peak. See (“Marker Drift Tolerance” on page 313) for details. Not available for Protein Charge Variant assays.

**Smear Molarity Integration**
The Integration Step Size specifies the time, in seconds at which to divide a smear into segments. The size at the center of each segment and the concentration of each segment is used to calculate the smear molarity.

**GQS Smear Start Size (gDNA Assays only)**
Specifies the start size of the GQS Smear used to calculate Total gDNA Concentration and Genomic Quality Score (GQS). Only editable in the Assay Editor window when creating an assay.

After the sample is run, edit the start time in the Smear Analysis Tab on the Assay Analysis window or by drag the start of the smear in the Graph View.
Audit Trail Window

The Audit Trail Window enables you to search the Audit Trail Log for specific events, to export the events, or to print events.

To open the Audit Trail window, select **Security → Audit Trail Log** on the LabChip GX Main Window.

![Audit Trail Window](image)

**Figure 82. Audit Trail Window**

The Audit Trail Window contains the following options:

|��索最近条目 | If selected, the specified most recent number of entries is searched for entries matching the selected criteria. |
|数量 | Specifies the number of most recent entries to search. |
|搜索日期 | If selected, entries between the specified dates are searched for entries matching the selected criteria. |
|从和到文本框 | Select the dates that contain the events that you want to view. |
|搜索整个数据库 | If selected, all entries in the database are searched. |
|用户名文本框 | Select a specific user name to view only events performed under the specified user name. Select All Users to view events performed by any user. |
|文件名文本框 | Clicking the Browse (...) button opens the Audit Trail CDR Browser window to open the audit trail for a different data file. |
|事件类别 | Specifies the Event Category of events to search for. Default selects all event categories. |
Audit Trail Export Window

Use the Audit Trail Export Window to export the contents of the Audit Trail Window to either an ASCII text file, and XML file, or a Microsoft Excel file. Only the events displayed in the Audit Trail Window are exported. Events filtered out of the view are not exported.

To open the Audit Trail Export Window, click the Export button in the Audit Trail Window.

The Audit Trail Export Window contains the following options:

**File Formats** - Select the desired format for the exported file:
- **ASCII Text File** - If selected, the file is saved as a .txt file.
- **XML File** - If selected, the file is saved as a .xml file.
- **MS Excel** - If selected, the file is saved as a .xls file.

**Number of Events Included** - Displays the number of events that will be exported.
Audit Trail Manage Columns Window

Use the Audit Trail Manage Columns Window to select the columns to view at the bottom of the Audit Trail Window.

To open the Audit Trail Manage Columns Window, click the Green Arrow button next to the Event Category text box in the Audit Trail Window.

![Audit Trail Manage Columns Window](image)

Figure 84. Audit Trail Manage Columns Window

The Audit Trail Manage Columns window contains the following parts:

<table>
<thead>
<tr>
<th>Show All check box</th>
<th>Selecting the check box selects all of the listed columns to display at the bottom of the Audit Trail window. Clearing the check box clears all of the column check boxes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column list</td>
<td>Only the selected columns display at the bottom of the Audit Trail window. Cleared (unselected) columns are hidden.</td>
</tr>
<tr>
<td>Green Up and Down Arrows</td>
<td>Moves the selected column up or down in the list. The columns display in the Audit Trail window in order from the top column on the left to the bottom column on the right.</td>
</tr>
<tr>
<td>Save button</td>
<td>Saves the selections and applies the current column view to the Audit Trails window.</td>
</tr>
<tr>
<td>Close button</td>
<td>Closes the window without saving changes to the selections.</td>
</tr>
</tbody>
</table>
CDR Manager Window

Use the CDR Manager Window to select a data file to open, to create, rename, or delete CDR data folders, and to show or hide data files from view in the CDR Manager Window.

To open the CDR Manager Window, select File → Import Data File on the LabChip GX Main Window. The CDR Manager window only opens if the 21 CFR Part 11 Security option is installed. If the 21 CFR Part 11 Security option is not installed, see “Select a Data File Window” on page 248.

Figure 85. CDR Manager Window

The CDR Manager Window contains the following options

<table>
<thead>
<tr>
<th>Left Side Buttons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Button</td>
<td>Imports a CDR data file into the open workspace.</td>
</tr>
<tr>
<td>Copy Button</td>
<td>Copies the selected data file to another location. The copy of the data file will not be part of the CDR and will not be change-controlled.</td>
</tr>
<tr>
<td>New Button</td>
<td>Creates a new folder in the CDR.</td>
</tr>
<tr>
<td>Rename Button</td>
<td>Renames the selected folder in the CDR. (Data files in the CDR cannot be renamed.</td>
</tr>
</tbody>
</table>
The icon next to the data file name indicates whether the data file is Accepted/Rejected and Locked as shown in the table below:

<table>
<thead>
<tr>
<th>File Status</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked</td>
<td></td>
</tr>
<tr>
<td>Accepted</td>
<td></td>
</tr>
<tr>
<td>Accepted and Locked</td>
<td></td>
</tr>
<tr>
<td>Rejected</td>
<td></td>
</tr>
<tr>
<td>Rejected and Locked</td>
<td></td>
</tr>
</tbody>
</table>
CDR Server Utility Window

Use the CDR Server Utility Window to create a repository (the Remote CDR Server Folder) on a remote computer to back up the CDR. The repository stores secure backup copies of data files. The CDR Server Utility Window is only available if the CDR Server Utility is installed on the remote computer.

To open the CDR Server Utility Window, double-click the CDR Server Utility icon on the remote computer desktop.

![Figure 86. CDR Server Utility Window](image)

The CDR Server Utility Window contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Folder</td>
<td>The name of the repository that will contain the data folders.</td>
</tr>
<tr>
<td>Create Server</td>
<td>Creates the repository for backup data in C:\RemoteCDR.</td>
</tr>
<tr>
<td>Folder Name</td>
<td>Specifies the name of the data folder to create in the repository.</td>
</tr>
<tr>
<td>Username</td>
<td>Specifies the user name to use when accessing the data folder.</td>
</tr>
<tr>
<td>Password</td>
<td>Specifies the password to use when accessing the data folder.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>The same password as typed in the Password text box.</td>
</tr>
<tr>
<td>Get Folder Details check box</td>
<td>If selected, creates a text file containing the URL, Folder Name, Username, and Password for the new data folder.</td>
</tr>
<tr>
<td>Apply button</td>
<td>Creates the specified data folder.</td>
</tr>
<tr>
<td>View Contents button</td>
<td>Opens the CDR Server Viewer to view contents of the Remote CDR folders on the computer.</td>
</tr>
</tbody>
</table>
CDR Utility Window

Use the CDR Utility Window to view the location of the local CDR folder, specify whether the CDR folder is accessible by Windows Administrators, and to enable Remote CDR Backup. Before enabling remote CDR Backup, the remote CDR server and folder must be set up (see page 133).

To open the CDR Utility Window, select **Tools → CDR Utility** on the **LabChip GX Main Window**. The CDR Utility command is only available if the 21 CFR Part 11 Security option is installed.

![Figure 87. CDR Utility Window](image)

The CDR Window contains the following options:

<table>
<thead>
<tr>
<th>CDR Folder</th>
<th>Displays the location of the CDR folder where the LabChip GX data files will be saved. This location cannot be changed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessible by Windows Administrator</td>
<td><strong>Windows XP</strong>: If selected, Windows Administrators who are logged into the computer can access the CDR folder. If not selected, access is denied to all users and only the LabChip GX software can access the folder. <strong>Windows 7</strong>: To access the check box, right-click on the LabChip GX icon on the Windows desktop and select <strong>Run as Administrator</strong>. If selected, Windows Administrators who are logged into the computer can access the CDR folder. If not selected, Windows Administrators are prompted to set full permission when opening the folder.</td>
</tr>
<tr>
<td>Enable Remote CDR Backup</td>
<td>If selected, all new or edited data files are automatically copied to the specified remote database.</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Remote CDR Database</td>
<td>Specifies the path to the remote database.</td>
</tr>
<tr>
<td>Folder Name</td>
<td>Specifies the name of the folder in the database in which to save copies of the data files.</td>
</tr>
<tr>
<td>User Name</td>
<td>Specifies the user name assigned to the folder when the folder was created.</td>
</tr>
<tr>
<td>Password</td>
<td>Specifies the password assigned to the folder when the folder was created.</td>
</tr>
<tr>
<td>Apply button</td>
<td>Applies the changes and closes the window.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Closes the window without saving any changes.</td>
</tr>
</tbody>
</table>
Change Password Window

Use the Change Password Window to change the password for the current user. (To change passwords for other users, see User Administration Window.) This window is only available if the CFR Support option is installed with the LabChip GX software.

To open the Change Password Window, select Security → Change Password on the LabChip GX Main Window.

![Figure 88. Change Password Window](image)

The Change Password Window contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Displays the user name for the current user.</td>
</tr>
<tr>
<td>Current Password</td>
<td>Type the current password for the current user.</td>
</tr>
<tr>
<td>New Password</td>
<td>Type the new password for the current user.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Retype the new password for the current user.</td>
</tr>
<tr>
<td>OK button</td>
<td>Saves the new password and closes the window.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Closes the window without saving changes to the password.</td>
</tr>
</tbody>
</table>
Data File Version Window

Use the Data File Version Window to view the saved versions of the data file. Also displays when the data file was signed.

To open the Data File Version Window, select **View → Version Change Details** on the main menu.

![Data File Version Window](image)

**Figure 89. Data File Version Window**

The Data File Version Window lists each version of the plate data file and describes the changes that were performed for each version change. Each time the data file is signed, the Data File Version Window lists the details of the signature. (To open a different version of the data file, click the **Restore Plate** button in the Assay Analysis Window.)

The Data File Version Window contains the following options:

<table>
<thead>
<tr>
<th>List of Versions</th>
<th>Displays the list of all saved data file versions and electronic signatures.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Displays the details of the changes or signature.</td>
</tr>
</tbody>
</table>
| Print Options    | All Versions: If selected, version information and details for all data versions is printed.  
                   Selected Version: If selected, version information and details for only the selected version is printed. |
| Print Preview    | Opens the Print Preview window to preview the printed version information. |
| Print            | Opens the Print window to print the data file version information.   |
| Close            | Closes the Data File Version window.                                |
Event Viewer Window

Use the Event Viewer window to view events and errors that occur during the current run or during a previous run. To open the Event Viewer window, select View → Event Viewer on the LabChip GX Main Window.

![Event Viewer Window](image)

**Figure 90. Event Viewer Window**

The Event Viewer window contains the following tabs:

- **Current Events tab** - Displays the events that occurred during the current session.

- **Past Events tab** - Displays all events from previous sessions.

- **Search Results tab** - Enables you to search for specified text in past events, current events, or all events.

The tabs on the Event Viewer window contain the following columns:

<table>
<thead>
<tr>
<th>Column Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>The data and time the event or error occurred.</td>
</tr>
<tr>
<td>Source</td>
<td>The system component that generated the event or error.</td>
</tr>
<tr>
<td>Event Code</td>
<td>The event/error ID number used by PerkinElmer to troubleshoot errors.</td>
</tr>
<tr>
<td>Description</td>
<td>Text describing the event or error.</td>
</tr>
</tbody>
</table>

Click the **OK** button to close the Event Viewer window.
Export Window

Use the Export window to export data manually. To open the Export window, select File → Export on the main Menu Bar.

The Auto Export window contains the same options and is used to automatically export data at the end of each run. To automatically export data, click the Settings button next to Automatic Export in the Output Tab on the Start Run Window.

Peak Tables and Well Tables are exported to .CSV files, which can be imported into a spreadsheet program such as Microsoft Excel. Raw Data can be exported to either a .CSV file or to a Chromatography Data Interchange Format file (formerly AIA), which is used by some graphical analysis software tools. Electropherogram and Gel data are exported to the selected image format. See "Exporting Data" on page 102 for instructions.

Figure 91. Export Window

Peak Table
If selected, the data in the Peak Table View is exported to a .CSV file. Click the Browse (...) button to specify the desired path and file name for the .CSV file.
Export Window (Continued)

Well Table
If selected, the data in the Well Table View is exported to a .CSV file. Click the Browse (...) button to specify the desired path and file name for the .CSV file.

Raw Data
If selected, the raw (unanalyzed) data from the run is exported.

- If the AIA Format check box is selected, the raw data is exported to a file in the Chromatography Data Interchange Format (formerly AIA). (Include Size Data and Export Single Table are not available.)
- If the AIA Format check box is NOT selected, the raw data is exported to a .CSV file. Click the Browse (...) button to specify the desired path and file name for the .CSV file. The following options are available:
  - Include Size Data: If selected, the data is aligned to the well's ladder (for one file per well) or to the first well (for a single data file) and the size data is included in the exported data. If not selected, the data is not aligned to a ladder. (Not available for CZE assays.)
  - Export Single Table: If selected, the data for all wells in the plate is exported to one .CSV file. If not selected, the data from each well is exported to a separate .CSV file.

Electropherogram
If selected, the graph displayed in the Graph View is exported to the specified folder in the selected image format. Click the Browse (...) button to specify the desired path for the image file. The file names are <plate name>_Egram_<well number>. The following options are available on the Export window. (These options are not available on the Auto Export window.)

- Entire Collection: If selected, a separate graph is exported for each well in the collection.
- Selected Wells: If selected, a separate graph is exported for each of the wells selected in the Gel View or Plate View or Plate List.
Export Window (Continued)

Gel
If selected, the gels selected in the Gel View are exported to the specified folder in the selected image format. Click the Browse (...) button to specify the desired path for the image file. The file names are <plate name>_Gel_<well number>. The following options are available on the Export window.

- **Entire Collection**: If selected, a gel is exported for each well in the collection. (Not available on the Auto Export window.)
- **Selected Wells**: If selected, a gel is exported for each of the wells selected in the Gel View or Plate View or Plate List. (Not available on the Auto Export window.)
- **Single File**: If selected, the selected gels are all included in the same image file.
- **Separate Files**: If selected, the selected gels are each exported to a separate image file.
- **Contrast Lane**: Specifies the gel lane to use to set the minimum and maximum RFU values for all lanes in the collection or selected wells before exporting the gels. All exported gels are set to the minimum and maximum RFU values in the selected lane. The contrast lane option only displays in the Auto Export window after the sample wells have been selected. (Not available on the Auto Export window.)
- **Height**: Specifies the desired height, in pixels, of the gel graphic.

Image Format for Gel and Electropherogram
Select the desired format for the exported image files.
Installation Qualification Window

Use the Installation Qualification Window to perform the IQ test. The IQ test verifies proper installation of the LabChip GX software and verifies no unauthorized changes have been made to the software. To open the Installation Qualification Window, select Validation → Software IQ on the LabChip GX Main Window.

![Figure 92. Installation Qualification Window](image)

The Installation Qualification Window contains the following information:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Verifies that the LabChip GX registry entries exist. If all expected</td>
</tr>
<tr>
<td>Information</td>
<td>registry entries are found, displays Passed. If any problems are found,</td>
</tr>
<tr>
<td></td>
<td>displays Failed.</td>
</tr>
<tr>
<td>Directory Structure</td>
<td>Verifies that all folders exist. If all expected folders exist, displays</td>
</tr>
<tr>
<td></td>
<td>Passed. If any folders are not found, displays Failed.</td>
</tr>
<tr>
<td>Files</td>
<td>Verifies that all files that were installed by the LabChip GX software still</td>
</tr>
<tr>
<td></td>
<td>exist. If all file exist, displays Passed. If any files are not found,</td>
</tr>
<tr>
<td></td>
<td>displays Failed.</td>
</tr>
<tr>
<td>Summary</td>
<td>Displays Passed if all tests passed. Displays Failed if any of the IQ tests</td>
</tr>
<tr>
<td></td>
<td>failed.</td>
</tr>
<tr>
<td>Progress</td>
<td>Displays a progress bar while the IQ test is running.</td>
</tr>
<tr>
<td>View Details Button</td>
<td>Displays the detailed results of the current IQ. (Only displays after the</td>
</tr>
<tr>
<td></td>
<td>IQ has been completed.)</td>
</tr>
<tr>
<td>Previous Result</td>
<td>Displays the results of the last IQ that was completed. (Only available</td>
</tr>
<tr>
<td>button</td>
<td>before another IQ test is run.)</td>
</tr>
<tr>
<td>Save As button</td>
<td>Saves the results of the IQ in an .xml file.</td>
</tr>
<tr>
<td>Start IQ button</td>
<td>Begins running the IQ.</td>
</tr>
<tr>
<td>Close button</td>
<td>Closes the Installation Qualification Window.</td>
</tr>
</tbody>
</table>
Layout Options Window

Use the Layout Options window to change the location of the views in a collection. To open the Layout Options window, select **Collection → Layout** on the **LabChip GX Main Window**.

![Figure 93. Layout Options Window](image)

**Viewer** - Lists the viewers available to display in the **Collection Pane**.

**Left** - If selected, the view displays on the right side of the Collection pane. (The view displays at the top if any view is selected to display at the bottom of the pane.)

**Right** - If selected, the view displays on the left side of the Collection pane. (The view displays at the top if any view is selected to display at the bottom of the pane.)

**Bottom** - If selected, the view displays at the bottom of the Collection pane. (The view displays at the top if there are no views displayed at the top left or right in the pane.)

**Apply button** - Applies the selections to the active collection and closes the Layout Options window.

**Restore to Factory Defaults button** - Restores the active collection to the default Layout options, table views, table columns, and viewer properties.

**Cancel button** - Closes the Layout Properties window without changing the collection layout.
Layout Options Window (Continued)

NOTES

- A view can only be displayed in one location. Selecting a location automatically clears any other selected location.
- To hide a view, click on the selected location to clear the selection.
- A location is hidden if it contains no views.
- The Gel View is always displayed and cannot be hidden.

Login Window

Use the Login Window to log into the LabChip GX software when the 21 CFR Part 11 option is installed. The LabChip GX software will not start until a valid user name and password are entered.

The Login Window opens when you start the LabChip GX software with the 21 CFR Part 11 option is installed.

![Login Window](Image)

Figure 94. Login Window

The Login Window contains the following options:

<table>
<thead>
<tr>
<th>Username text box</th>
<th>Type the username to log into the LabChip GX software. Each user should have a unique user name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password text box</td>
<td>Type the password assigned to the Username. All passwords must be at least 5 characters long and must contain at least one uppercase letter and at least one number. The User Account Policies specify additional password requirements.</td>
</tr>
</tbody>
</table>
New Collection Window

The New Collection window is used to create a new collection using either a Blank Collection (default) or a Template. To open the New Collection window, select Collection → New Collection on the LabChip GX Main Window.

The following options are available:

**Template** - Opens a blank collection and then applies the selected collection template.

**Blank Collection** - Opens a blank collection that does not contain any data. The new collection will use the same settings as the last saved collection of the same assay type.

*The current collection settings are automatically saved in a blank collection template in the current user’s “Documents and Settings” folder on the local computer. These preferences are applied when a blank collection is created. User preferences are saved by assay type, with separate settings saved for DNA, RNA, Protein and Glycan assays.*

**Current Collection** - Opens a blank collection and applies the settings from the currently open collection as a template.

**Assay Type** (DNA, Protein, RNA, Glycan, CZE, or gDNA) - Specifies the type of data files that can be imported into the collection. Only enabled if this is the first collection and no plates have been imported into the workspace. If a workspace already contains a collection, all new collections are the same type as the existing collections. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)

**Name** - Specifies the name of the new collection.
Optics Calibration Window

Use the Optics Calibration window to calibrate the instrument using the Test Chip C as the calibration standard. (If the CFR Support option is installed, only displays if the user has Perform Validation access right.) Only displays when the software is in either Instrument or Simulation mode.

To open the Optics Calibration window, select **Tools → Calibrate Optics** on the **LabChip GX Main Window**.

![Optics Calibration Window](image)

**Figure 96. Optics Calibration Window**

The Optics Calibration Window contains the following options and buttons:

**Reference Contrast** - The Contrast value from Test Chip C that will be compared to the scan results Contrast.

**Instrument Gain Correction** - The current correction factor for the instrument.

**Chip Temperature (Target 35) degC** - The current temperature of the chip. The chip is always warmed to the target temperature to more accurately calibrate the optics.

**Background** - The background measured on the current instrument after focusing.

**Contrast** - The contrast measured on the current instrument.
Optics Calibration Window (Continued)

New Correction Factor - The correction factor calculated from the instrument (Reference Contrast / Scan Results Contrast).

Warm and Scan/Scan/Abort button -
- Warm and Scan: Warms up the chip and laser, focuses the chip, and measures the optical contrast.
- Scan: Scans without the warmup (available only after a scan is complete or aborted, while laser and chip are still warmed up).
- Abort: stops the scan or warm currently in progress.

Apply button - Saves the New Correction Factor to the instrument's non-volatile flash memory.

Done button - Closes the Optics Calibration window.
Perform Signature Window

Use the Perform Signature Window to add an electronic signature to a data file. Add signatures as required by the company’s standard operating procedures. (Data files cannot be signed while the assay is running.) If multiple data files are open in the workspace, only one data file can be signed at a time.

To open the Perform Signature Window, select Security → Perform Signature on the LabChip GX Main Window.

![Figure 97. Perform Signature Window](image)

The Perform Signature Window contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data File Name</td>
<td>Displays the name of the data file being signed.</td>
</tr>
<tr>
<td>Username</td>
<td>Select the username of the user that is signing the data file.</td>
</tr>
<tr>
<td>Role</td>
<td>Displays the Access Level of the selected LabChip GX user.</td>
</tr>
<tr>
<td>Comment</td>
<td>Details on why the signature is being performed and what actions have taken place. It is the signer’s responsibility to ensure all details required by the company’s procedures are included.</td>
</tr>
<tr>
<td>Approval State</td>
<td>Select the desired option, Unreviewed, Accepted, or Rejected. The icons in the CDR Manager Window indicate the Approval State of the data file. All new data files are set to Unreviewed by default.</td>
</tr>
<tr>
<td>Lock</td>
<td>If selected, the data file cannot be saved and the Approval State cannot be changed. Only users with the Unlock permission can unlock data files.</td>
</tr>
<tr>
<td>User Password</td>
<td>The password for the user.</td>
</tr>
<tr>
<td>Sign button</td>
<td>Signs the data file and closes the window.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Closes the window without signing the data file.</td>
</tr>
</tbody>
</table>
Plate Information Window

Use the Plate Information window to view, add, or change plate names and measurements. To open the Plate Information window, select Tools → Plate Editor on the LabChip GX Main Window.

![Plate Information Window](image)

**Figure 98. Plate Information Window**

The Plate Information window contains the following tabs:

- **Predefined Plates** - Displays Caliper-defined plates. These plates are read-only and cannot be edited or deleted.
- **Custom Plates** - Displays all user-created plates. Plates can be added, deleted, and modified.

The Plate Information window contains the following options and buttons:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Information table</td>
<td>Displays the plate information for each plate defined for use in the system. (See “Add Plate Window” on page 185 for a description of each column.)</td>
</tr>
<tr>
<td>Delete Selected Plate</td>
<td>Deletes the selected plate from the system. (Only available when the Custom Plates tab is selected.)</td>
</tr>
<tr>
<td>Add Plate</td>
<td>Opens the Add Plate Window to enter the information for a new plate. (Only available when the Custom Plates tab is selected.)</td>
</tr>
<tr>
<td>Modify Selected Plate</td>
<td>Opens the Add Plate Window to edit the information for the selected plate. (Only available when the Custom Plates tab is selected.)</td>
</tr>
<tr>
<td>Verify Plate</td>
<td>Opens the Verify Plate window to perform a puncture test using the selected plate information. Follow the instructions in the Verify Plate window to test the settings for the selected plate.</td>
</tr>
<tr>
<td>Close button</td>
<td>Closes the Plate Information window.</td>
</tr>
</tbody>
</table>
Print Window

Use the Print window to print information from the currently open workspace. If the workspace contains multiple collections, information from the active (selected) collection is printed. To open the Print window, select File → Print on the LabChip GX Main Window.

![Figure 99. Print Window](image)

The Print window provides the following options for printing:

- **Print All** - Selects all of the options.
- **Gel** - Prints a graphic of the gel for either all wells in the collection or all selected wells.
- **Electropherogram** - Prints a graph of either all wells in the collection or all selected wells.
- **Overlay Electropherogram** - Prints a graphic of all electropherograms (either all selected or all in the collection) over-laid onto the same graph.
- **Well Table** - Prints the well table for either all wells in the collection or all selected wells. The columns selected for view in the well table are printed. Changing the columns selected to view in the Well Table View changes the columns that are printed.
- **Peak Table** - Prints the peak table for all wells in the collection or all selected wells. The columns selected for view in the peak table are printed. Changing the columns selected to view in the Peak Table View changes the columns that are printed.
- **Exclude Marker** - If selected, markers are not printed.
Print Window (Continued)

- **Multiple Electropherogram** - Prints a graph of either all wells in the collection or all selected wells in the specified format, rows by columns.

**Page Option** - Select the page orientation, either Portrait or Landscape.

**Well Option** - Select the wells to be included in the printout, either Entire Collection or Selected Wells.

**Add Border Option** - If selected, the Well Table and Peak Table will print with a border between each column and a border below the column header.

**Add Well Name as Header** - If selected, a well header, containing the plate, well, and sample name for the well, is printed before each set of peaks in a well. (This option is only available if Peak Table is selected.)

**Column Header** - Specifies where to print the column headers, which identify each column in the Peak Table. (This option is only available if Peak Table is selected and Well Table is not selected.)

- If **Per Page** is selected, the column header is printed only at the top of each page.
- If **Per Well** is selected, the column header is printed at the top of each page and at the start of each new well.

**Preview button** - Displays a preview of the selected options.

**Print to PDF button** - Prints the selected information from the active collection to a pdf file.

**Print button** - Prints the selected information from the active collection to the default Windows printer.

**Cancel button** - Closes the Print window without printing.
Print Validation Reports Window

Use the Print Validation Reports Window to print the results after performing Installation Qualification (IQ) or Operational Qualification (OQ). OQ is performed in the System Diagnostics Window.

To open the Print Validation Reports Window, select Validation → Reports on the LabChip GX Main Window.

![Print Validation Reports Window](image)

**Figure 100. Print Validation Reports Window**

The Print Validation Reports Window contains:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics Report</td>
<td>If selected, the results of Hardware OQ tests are printed.</td>
</tr>
<tr>
<td>Software IQ Report</td>
<td>If selected, the results of Software IQ tests are printed.</td>
</tr>
<tr>
<td>Failed Tests Only</td>
<td>If selected, only tests that have failed are printed. If not selected, both passed and failed tests are printed.</td>
</tr>
<tr>
<td>Report Period</td>
<td>Specifies the dates when the tests were run. Tests performed between the From and To dates (inclusive) are printed.</td>
</tr>
<tr>
<td>Print Preview button</td>
<td>Displays a preview of the report and enables you to print or export the results.</td>
</tr>
<tr>
<td>Print button</td>
<td>Opens the Print window to print the report.</td>
</tr>
<tr>
<td>Close button</td>
<td>Closes the window.</td>
</tr>
</tbody>
</table>
Rename Collection Window

Use the Rename Collection window to rename the currently selected collection. The collection name displays on the Collection tab at the top of the LabChip GX Main Window. To open the Rename Collection window, select **Collection → Rename Collection** on the LabChip GX Main Window.

![Rename Collection Window](image)

**Figure 101. Rename Collection Window**

**Name** - Type the desired name for the selected collection.
Robot Teaching Wizard

Use the Robot Teaching Wizard to teach the correct reference location. Reteach the robot if the sipper is not accessing the plate properly. Also includes a plate puncture test to verify the taught location, and a Restore Defaults options to restore the original factory default positions to the robot. (If the CFR Support option is installed, only displays if the user has Perform Validation access right.) Only displays when the software is in either Instrument or Simulation mode.

To open the Robot Teaching Wizard, select Tools → Teaching Utility on the LabChip GX Main Window.

The Robot Teaching Wizard consists of the following windows:

- “Welcome Window” on page 235
- “Teach Robot Window” on page 236
- “Teach the X, Y and Z Reference Positions Window” on page 237
- “Verify a Plate Window” on page 238
- “Verify Positions Window” on page 239
- “Finished Window” on page 240
- “Verify All Target Positions Window” on page 241
- “Verify All Target Positions Correct Window” on page 242
Welcome Window

The Welcome window is the first window displayed in the Robot Teaching Wizard.

![Welcome Window](image)

**Figure 102. Robot Teaching - Welcome Window**

The Welcome Window contains:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify Target Positions Only check box</td>
<td>If selected, clicking the Next button displays the Verify All Target Positions Window</td>
</tr>
<tr>
<td>Restore Default button</td>
<td>Displays a Restore prompt to reset the reference positions to the factory default values.</td>
</tr>
<tr>
<td>Next button</td>
<td>If Verify Target Positions Only is not selected, displays the Teach Robot Window. If Verify Target Positions Only is selected, displays the Verify All Target Positions Window.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Closes the Robot Teach Wizard without saving changes to any positions.</td>
</tr>
</tbody>
</table>
教机器人窗口

教机器人窗口显示了准备机器人进行参考位置教学的指令。

![教机器人窗口](image.png)

图103. 教机器人窗口

教机器人窗口包含以下功能:

<table>
<thead>
<tr>
<th>选项/按钮</th>
<th>功能</th>
</tr>
</thead>
<tbody>
<tr>
<td>回退按钮</td>
<td>显示欢迎窗口。</td>
</tr>
</tbody>
</table>
| 下一步按钮 | 显示教XYZ参考位置窗口。遵循窗口中的说明在点击下一步按钮之前。
| 取消按钮 | 关闭机器人教学向导，不保存任何位置的更改。 |
Teach the X, Y and Z Reference Positions Window

Use the Teach X, Y, and Z Reference Positions Window to align the sipper at the reference position, save the reference position, and test the alignment.

Figure 104. Teach the X, Y and Z Reference Positions Window

The Teach the X, Y, and Z Reference Positions Window contains the following options and buttons:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left/Right buttons</td>
<td>Moves the plate holder toward the left or right side of the instrument. The distance the plate holder moves is set in the Step Size option below the buttons.</td>
</tr>
<tr>
<td>Forward/Backward buttons</td>
<td>Moves the plate holder toward the front or back of the instrument. The distance the plate holder moves is set in the Step Size option below the buttons.</td>
</tr>
<tr>
<td>Up/Down buttons</td>
<td>Moves the plate holder up toward the top of the instrument or down toward the bottom of the instrument.</td>
</tr>
<tr>
<td>Step Size options</td>
<td>Select the desired distance to move the plate holder each time the positioning buttons are clicked. Use the Step size buttons under the positioning buttons for the axis that is being moved.</td>
</tr>
<tr>
<td>Set button</td>
<td>Sets the current position of the plate holder as the reference position.</td>
</tr>
<tr>
<td>Test button</td>
<td>Moves the plate holder to verify that the reference position is set properly. If set properly, the sipper moves into the hole on the plate holder without hitting the sides of the hole.</td>
</tr>
</tbody>
</table>
Verify a Plate Window

Use the Verify a Plate Window to select the name of the plate that will be used to test the plate settings.

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Name list</td>
<td>Displays the names of the plates that have been created for use in the instrument.</td>
</tr>
<tr>
<td>View Plate Info button</td>
<td>Opens the Plate Information Window to view existing plates or to add new plates.</td>
</tr>
<tr>
<td>Back button</td>
<td>Displays the Teach the X, Y and Z Reference Positions Window.</td>
</tr>
<tr>
<td>Next button</td>
<td>Displays the Verify Positions Window.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Closes the Robot Teach Wizard without saving changes to any positions.</td>
</tr>
</tbody>
</table>
Verify Positions Window

Use the Verify Positions Window to verify the taught reference position and the settings for the plate selected in the Verify a Plate Window.

![Verify Positions Window](image)

**Figure 106. Verify Positions Window**

The Verify Positions window contains the following options and buttons:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify Plate Position</td>
<td>If selected, the plate holder moves so that the sipper pierces the tape in the well each corner of the plate. If the well is not pierced in the center of each well, click the Back button and adjust the Plate Information.</td>
</tr>
<tr>
<td>Verify Buffer Position</td>
<td>If selected, the plate holder moves so that the sipper pierces the tape over the buffer vial. If the buffer vial is not pierced in the center, verify and adjust the Reference Position.</td>
</tr>
<tr>
<td>Verify Ladder Position</td>
<td>If selected, the plate holder moves so that the sipper pierces the tape over the ladder vial. If the ladder vial is not pierced in the center, verify and adjust the Reference Position.</td>
</tr>
<tr>
<td>Test button</td>
<td>Moves the plate holder to test the selected positions.</td>
</tr>
<tr>
<td>Back button</td>
<td>Displays the Verify a Plate Window.</td>
</tr>
<tr>
<td>Next button</td>
<td>Displays the Finished Window.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Closes the Robot Teach Wizard without saving changes to any positions.</td>
</tr>
</tbody>
</table>
Finished Window

The Finish Window is the last window to display in the Robot Teach Wizard. Click the Finish button to save changes to the Reference position. (The software prompts you to save changes to the plate information when you exit the Plate Information Window. If you click the Yes button, the plate information is saved even if you click the Cancel button in the Robot Teach Wizard.)

![Finished Window](image)

**Figure 107. Finished Window**

The Finished Window contains the following options and buttons:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back button</td>
<td>Displays the <a href="#">Verify Positions Window</a></td>
</tr>
<tr>
<td>Finish button</td>
<td>Saves the changes to the reference position and closes the Robot Teach Wizard.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Closes the Robot Teach Wizard without saving changes to any positions.</td>
</tr>
</tbody>
</table>
Verify All Target Positions Window

Use the Verify All Target Positions Window to skip teaching the reference positions and verify the plate, buffer vial, and ladder vial positions. Select the Verify Target Positions Only check box on the Welcome Window and click the Next button to open the Verify All Target Positions Window.

Figure 108. Verify All Target Positions Window

The Verify All Target Positions Window contains the following options and buttons:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Name list</td>
<td>Displays the names of the plates that have been created for use in the instrument.</td>
</tr>
<tr>
<td>View Plate Info button</td>
<td>Opens the Plate Information Window to view existing plates or to add new plates.</td>
</tr>
<tr>
<td>Back button</td>
<td>Displays the Welcome Window.</td>
</tr>
<tr>
<td>Next button</td>
<td>Displays the Verify All Target Positions Correct Window.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Closes the Robot Teach Wizard without saving changes to any positions.</td>
</tr>
</tbody>
</table>
Verify All Target Positions Correct Window

Use the Verify All Target Positions Correct Window to verify the plate, buffer vial, and ladder vial were all punctured correctly.

The Verify All Target Positions Correct Window contains the following options and buttons:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Positions Correct check box</td>
<td>Select the check box if all positions were punctured in the center. Clear the check box if any of the positions need to be corrected.</td>
</tr>
<tr>
<td>Back button</td>
<td>Displays the Verify All Target Positions Window.</td>
</tr>
<tr>
<td>Next button</td>
<td>If the Positions Correct check box is selected, the Next button changes to a Finish button. If the Positions Correct check box is not selected, displays the Verification Failed Window. Click the Next button to display the Teach Robot Window to adjust the taught positions.</td>
</tr>
<tr>
<td>Finish button</td>
<td>Closes the Robot Teach Wizard.</td>
</tr>
<tr>
<td>Cancel button</td>
<td>Closes the Robot Teach Wizard without saving changes to any positions.</td>
</tr>
</tbody>
</table>
Run File Editor Window

Use the Run File Editor window to create run files (*.xml) for use with Caliper’s automation control software. When the LabChip GX is running in automation mode and is being controlled by software such as iLink Pro, you must create a run file to specify the settings for the assay that will be run. The run file contains all of the run settings that would be specified in the Start Run Window. Run files can also be imported into the Start Run window to start a run.

To open the Run File Editor window, choose Tools → Run File Editor on the LabChip GX Main Window.

The tabs on the Run File Editor contain the same options as the tabs on the Start Run window. See Start Run Window for definitions of specific options or settings.

The following buttons are located at the bottom of the Run File Editor window:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>Saves the selected settings in a run file with the specified name (*.xml).</td>
</tr>
<tr>
<td>Import</td>
<td>Imports the settings from an existing run file (*.xml) into the Run File Editor window.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Run File Editor window without saving the settings.</td>
</tr>
</tbody>
</table>
Run Info Window

Use the Run Info window to view information about the run options for the selected plate data file.

To open the Run Info window, select **View → Run Info** on the **LabChip GX Main Window**, or right-click on the name of the data file above the plate diagram and select **Run Info**.

![Figure 111. Run Info Window](image)

The information in this window is view-only and cannot be changed.

The **Run Info tab** displays assay information and run information.

The **Event Log tab** displays the events that occurred during the run.

The Run Info window contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Preview</td>
<td>Opens the Print Preview window to view the run information before printing.</td>
</tr>
<tr>
<td>Print</td>
<td>Opens the Print window to print the run information.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Run Info window.</td>
</tr>
</tbody>
</table>
Sample Name Editor Window

Use the Sample Name Editor window to specify names for the samples in the plate. For DNA, Protein, Glycan, CZE, and gDNA assays, also can be used to view, add, edit, or delete expected peaks. Sample Names can be exported to a .CSV file to be re-used in other workspaces or for other plates.

To open the Sample Name Editor window, choose Tools → Sample Name Editor on the LabChip GX Main Window or click the Edit button next to the Sample Name File text box on the Advanced Tab in the Start Run Window after selecting the Sample Name File.

![Sample Name Editor Window](image)

**Figure 112. Sample Name Editor Window**

**Edit Expected Peaks check box** - If selected, displays the Expected Peaks and Window (%) columns for DNA, Protein, Glycan, CZE, and gDNA assays. This option is not available for RNA assays.

The following columns display in the Sample Name Editor window:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well Label</td>
<td>Displays the row letter and column number of each well. Wells are ordered by column if the Order by Column check box is selected. If the window is opened from the Start Run Window, the wells display by column or well depending on the selection on the Run tab. If a plate is running when the window is opened, the wells display by column or well based on the sip order of the currently running plate.</td>
</tr>
</tbody>
</table>
The following buttons and options are located at the bottom of the Sample Name Editor window:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import</td>
<td>Imports a sample name file (*.csv) into the Edit Sample Names window.</td>
</tr>
<tr>
<td>Export</td>
<td>Exports the current sample names and comments into a Sample Names (*.csv) file. See “Using Sample Names Files” on page 63.</td>
</tr>
<tr>
<td>Blank 96 Wells</td>
<td>Clears the sample names in the window and creates a new sample name that is the same as the well label for each well in a 96 well plate.</td>
</tr>
<tr>
<td>Blank 384 Wells</td>
<td>Clears the sample names in the window and creates a new sample name that is the same as the well label for each well in a 384 well plate.</td>
</tr>
<tr>
<td>Order by</td>
<td><strong>Row</strong> - The sample names are ordered by row (A1, A2, A3, etc.). <strong>Column</strong> - The sample names are ordered by column (A1, B1, C1, etc.).</td>
</tr>
<tr>
<td>Group By Quadrant</td>
<td>If selected, the sample names are grouped by quadrant, as well as by rows or columns.</td>
</tr>
<tr>
<td>Apply</td>
<td>Applies the sample name changes to the plate. Sample names cannot be applied during a run.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the Edit Sample Names window. If changes have not been applied to the plate, prompts you to discard the changes. To save the changes, click the Apply button before clicking the Close button.</td>
</tr>
</tbody>
</table>
Save Workspace As Window

The Save Workspace File As window saves the currently open workspace with the specified name in the specified location.

To open this window, choose **File → Save Workspace As**. This window also opens the first time you save a new workspace.

![Figure 113. Save Workspace As Window](image)

Tip: You may want to save the workspace file in the same location as the plate data files to prevent missing plate data files when moving workspace files.
Select a Data File Window

When you choose Import Data File from the File Menu, the Select a Data File window opens as shown in Figure 114. (If the 21 CFR Part 11 option is installed, the CDR Manager Window opens.) Data files generated by the LabChip GX software have a .gxd file extension. Data files generated by the LabChip HT software have a .cla file extension; change the File Type to display .cla files.

![Select a Data File Window](image)

Select a data file name in the list box and click the Open button or double-click a file name to open the data file.

To select multiple files, press and hold CTRL then click each file name. To select a continuous block of files, click the first file, press and hold SHIFT, and then click the last file. To select all files, press CTRL+A.
**Start Run Window**

The Start Run window specifies the assay to run, the plate type, the wells to read, the options for the data file, auto export settings, plate cycles, and import options for sample names and expected peaks. Only displays when the software is in either Instrument or Simulation mode.

![Start Run Window](image.png)

**Figure 115. DNA Assay Start Run Window**

The Start Run window opens when you click the **Start** button above the plate icon. To begin the run, select the desired settings on each tab and then click the **Start** button.

The Start Run Window contains the following tabs:
- **Run Tab**
- **Output Tab**
- **Advanced Tab**

The following buttons are located at the bottom of the Start Run window:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Starts the run using the options specified in the tabs on the Start Run window.</td>
</tr>
<tr>
<td>Import</td>
<td>Imports the settings from a run file (*.xml) into the Start Run window. (Use the Run File Editor Window to create a run file.)</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes the Start Run window without saving any changes and without starting the run.</td>
</tr>
</tbody>
</table>
Run Tab

Use the Run tab in the Start Run Window to specify the assay type, operator name, plate type, barcode option, sample wells, and sipping order for the run. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)

![Start Run Window - Run Tab](image)

**Assay Type**
Select the type of assay to run. The assay types available depend on the type of chip that is loaded in the instrument. The instrument automatically identifies the chip type when the chip is loaded in the instrument.

**Operator**
Specifies the name of the operator running the assay. The Operator Name is saved in the data file.

**Plate Name**
Choose the type of plate that will be used in the run.

**Use Barcode check box**
If selected, the LabChip GX will read the customer-applied barcode on the short (portrait) end of the plate. The barcode will be saved in the data file and can be used as part of the name of the data file.
Run Tab (Continued)

**Samples (Microplate Graphic)**
Select the wells to be read during the assay. Selected wells are blue, cleared (not read) wells are white.
- To select all wells on the plate, click the double-arrow button in the lower-right corner of the plate.
- To select all rows on the plate, click the double-arrow button at the top left corner of the plate.
- To select all columns on the plate, click the double-down-arrow button at the top right corner of the plate.
- To select a column, click the column number at the top or bottom of the plate.
- To select a row, click the row letter on the left or right side of the plate.
- Clear specific wells by clicking on the selected well again.

If a Sample Names File is selected and the Use This File for Sample Selection check box is selected on the Advanced Tab, the wells in the Sample Names File are selected and cannot be changed. “Sample selection based on Sample Names file” displays on the microplate graphic.

**Quadrant Select**
Click the Q1, Q2, Q3, and Q4 buttons to select or clear all wells in each quadrant. Any wells that are already selected are not changed unless the wells are in the specified quadrant.

**Sipping Order**
Select the order in which the wells will be sampled during the assay.
- Select **Row-wise** to sample all wells in each row before proceeding to the next row (A1, A2, A3...). Ladders are sipped every 12 wells.
- Select **Column-wise** to sample all wells in each column before proceeding to the next column (A1, B1, C1...). Ladders are sipped every 12 wells, so some columns will include a ladder in the middle of the column.
- Select the **File Order** check box to sample the wells in the order in which the wells are listed in the Sample Names file. If selected, the wells in the microplate diagram are numbered with the sipping order. Only available if a Sample Names File is selected and the Use This File for Sample Selection check box is selected on the Advanced Tab,
Output Tab

The Output tab on the Start Run Window specifies the location, name, and export settings for plate data files (*.gxd) created during the run.

The data file name can include a specific prefix, the date, the time, and the plate barcode. For example, including the prefix LabChip_GX, the barcode, the date, and the time would create file names such as LabChip_GX_<Barcode>_2008-04-24_10-23-48.

NOTE

If you choose not to use the time of the run as part of the data file name, the LabChip GX software automatically appends _1, _2, etc., for each subsequent run on the same day.

Figure 117. Start Run Window - Output Tab

Data Path
Specifies the location where the data files will be saved.

21 CFR Part 11 option not installed: The default location is C:\Program Files\Caliper Life Sciences\LabChip GX\Data\ Click the Browse button to choose a different location. Click the Default button to reset the text box to the default directory.

21 CFR Part 11 option installed: The default location is C:\Program Files\Caliper Life Sciences\CDR\ Click the Browse button to choose a folder in the CDR. Click the Default button to reset the text box to the default directory.
Output Tab (Continued)

NOTE

Data files should be saved to a local folder on the computer's hard drive. Saving data files to a network drive may cause loss of data if the network connection is slow or interrupted.

Create Daily Sub-Directory check box
If selected, a new directory is created each day in the specified Data Path, and all of the data files from that day are saved in the directory. The directory name is the current date, and the format is YYYY-MM-DD, where YYYY is the year, MM is the month, and DD is the day.

Copy To
If selected, the data file is copied to the specified folder after the run is complete.

File Name: Select the desired file name components. Each selection is added to the end of the file name. Select the components in the order that you want them to display in the file name.

- File Prefix - Specifies the text for the first characters of the data file name.
- Computer Name - If selected, adds the name of the LabChip GX computer to the data file names.
- Project Name - The text is added to the data file names.
- Barcode check box - If selected, the instrument reads the customer-supplied barcode on the short (portrait) edge of the microplate and includes the barcode in the data file name.
- Date check box - If selected, the current date is included in the data file name. The date format is YYYY-MM-DD, where YYYY is the year, MM is the month, and DD is the day. The date is automatically added to the data file name when the 21 CFR Part 11 option is installed.
- Time check box - If selected, the time that the run was started is included in the data file name. The time format is HH-MM-SS, where HH is the hour (0 to 24), MM is the minutes, and SS is the seconds. The time is automatically added to the data file name when the 21 CFR Part 11 option is installed.

File Name Example text box
Read-Only text box that displays the format for the data file name.
Output Tab (Continued)

Automatic Export
If selected, data is automatically exported at the end of each run. Select the type of data to export by clicking the Settings button and choosing the desired settings in the Export Window. For more information, see Exporting Data.

Advanced Tab

Use the Advanced tab on the Start Run Window to select the number of plate cycles, the sample saver options, the Sample Names file, the Expected Peaks file, and the Excluded Peaks file.

![Figure 118. Start Run Window - Advanced Tab](image)

The Advanced tab contains the following options:

**Plate Cycles**
Specifies how many times to repeat the same assay on the plate.

**Random Selection %**
If selected, the instrument will randomly sample the specified percent of wells from the selected wells. For example, if 10 wells are selected, and the Random Selection percent is set to 50%, five wells, selected at random, will be sampled during the run.
Advanced Tab (Continued)

**Sample Saver**
If selected, the selected wells are run the specified number of times. Each well is samples once then the entire run repeats. The data from all wells is combined in the same data file.

**Sample Names File**
Specifies the file that will supply the names of the samples in the assay. Click the Browse button next to **Sample Names File**, select the name of the .CSV file that contains the sample names, and click the Open button. The path and name of the file displays in the text box. (Use the **Sample Name Editor Window** to create Sample Name files.)

- **Use This File for Sample Selection check box** - if selected, only the wells listed in the Sample Names File are selected to be read. The selected wells display on the **Run Tab**.

**Expected Peaks File**
Specifies the file that will supply the Expected Peaks for the assay. Click the Browse button next to Expected Peaks File, select the name of the .GEP file that contains the expected peaks, and click the Open button. The path and name of the file displays in the text box. (See "Using Expected Fragments/ Expected Proteins/ Expected Glycans" on page 67 for more information. Use the **Expected Fragments/Proteins/Glycans Tab** on the **Assay Analysis Window** to create the Expected Peaks file.)

**Excluded Peaks File**
Specifies the file that will supply the Excluded Peaks for the assay. Click the Browse button next to Excluded Peaks File, select the name of the .GEP file that contains the excluded peaks, and click the Open button. The path and name of the file displays in the text box.
System Diagnostics Window

Use the System Diagnostics window to run the diagnostics tests on the LabChip GX or GX II instrument. All tests should be run periodically to verify proper operation of the instrument. To verify proper operation of a particular function, you can select specific tests to run. Only displays when the software is in either Instrument or Simulation mode.

To open the System Diagnostics window, select Validation → Diagnostics.

![System Diagnostics Window](image)

Figure 119. System Diagnostics Window

The left side of the window displays the tests to run on the instrument. Expand each section to view all of the tests in each section. Tests selected with a green check mark will run. To skip a test, click on the check box to clear the selection. Click on a section check box to select or clear all of the tests in the section.
System Diagnostics Window (Continued)

The right side of the window displays the results of the tests. The icon color indicates the status of each test:

- Blue - The test is in progress.
- Yellow - The test was skipped.
- Green - The test passed.
- Red - The test failed or was aborted.

**Run Tests** button - Runs the selected tests (marked with a green check mark). After all tests are complete, the **Test Report Generation** section at the bottom of the right side of the window displays the date and time when the test report was created, the name of the test report (*.log), and the location where the test report was saved. Test report files can be opened with a text editor such as Windows Notepad.

**Abort button** - Stops the tests in progress. Only enabled when tests are running.

**Limits Report** button - Generates a report of test limits. After the report is generated, the Limits Report Generation section at the bottom of the right side of the window displays the date and time when the limit report was generated, the name of the limits report, and the location where the limits report was saved.

**Print Summary** button - Prints a summary of the last tests that were run to the default Windows printer.

**Print button** - Prints the last generated report to the default Windows printer.

**Close button** - Closes the System Diagnostics window.

The bottom of the window displays a progress bar for the entire set of selected tests and a separate progress bar for the test that is currently running.
Unlock Application Window

Use the Unlock Application Window to access the LabChip GX software after it automatically locks. This window displays on top of the LabChip GX software when the software is locked. The automatic lock option is set in the Set Policies tab on the User Administration Window. This window only displays if the 21 CFR Part 11 option is installed.

Figure 120. Unlock Application Window

The Unlock Application Window contains:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Type the user name of the current user or a LabChip GX administrator’s user name.</td>
</tr>
<tr>
<td>Password</td>
<td>Type the password for the specified user name.</td>
</tr>
<tr>
<td>OK button</td>
<td>Verifies the username and password and opens the LabChip GX software if the username and password are correct.</td>
</tr>
</tbody>
</table>
Unlock Data File Window

Use the Unlock Data File Window to unlock a data file to enable the
data file to be saved or to change the Approval State of the data file.
Only users with the Unlock Data Files permission are permitted to
access this window. Administrators can change this setting in the
Edit Users tab on the User Administration Window. The Unlock
Data File option is only available if the 21 CFR Part 11 option is
installed.

To open the Unlock Data File Window, select Security → Unlock
Data File.

![Figure 121. Unlock Data File Window](image)

The Unlock Data File window contains:

**Username** - Select the user name of the LabChip GX user that is
unlocking the data file.

**Reason** - Type the reason why the data file is being unlocked.

**User Password** - The password of the selected LabChip GX User.

**Unlock button** - Unlocks the data file specified at the top of the
window if the username and password are correct.

**Cancel** - Closes the Unlock Data File window without unlocking the
data file.

To lock a data file, use the Perform Signature Window.
User Administration Window

Use the User Administration window to create new LabChip GX users, to edit existing users, to view user information, to activate or deactivate users, to set rights for each access level, and to set LabChip GX software policies.

To open the User Administration window, choose **Security → User and System Administration**.

![User Administration window](image)

**Figure 122. User Administration window**

The User Administration window contains the following tabs:

- “Create New User” on page 261
- “Edit Users” on page 263
- “Show User Info” on page 264
- “De/Activate User” on page 266
- “Define Access” on page 267
- “Set Policies” on page 269

**Close button** - Closes the User Administration window without saving changes. Save the changes on each tab before closing the window.
Create New User

Use the Create New User tab to add a new user name to the LabChip GX software. This window creates the LabChip GX user account, it does not create a Windows user account.

The Create New User tab contains:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Type the user name that the new user will use to log into the LabChip GX software.</td>
</tr>
<tr>
<td>First Name</td>
<td>Type the first name of the user.</td>
</tr>
<tr>
<td>Middle Name</td>
<td>Type the middle name or initial of the user.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Type the last name of the user.</td>
</tr>
<tr>
<td>Position</td>
<td>If desired, type the job title of the user.</td>
</tr>
<tr>
<td>Access Level</td>
<td>Choose the access level for the user. The access level controls the user’s rights in the LabChip GX software. The following access levels are available: • Restricted User • Operator • Supervisor • Administrator • Service</td>
</tr>
<tr>
<td>Password</td>
<td>Type the desired password for the user. The password must meet the password policies selected on the Set Policies tab.</td>
</tr>
<tr>
<td><strong>Option/Button</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Repeat the desired password for the user.</td>
</tr>
<tr>
<td>User Can Perform Signature</td>
<td>If selected, the user can sign data files using the Perform Signature Window.</td>
</tr>
<tr>
<td>Accept/Reject/Lock Data File</td>
<td>If selected, the user can Accept, Reject, and/or Lock data files in the Perform Signature Window.</td>
</tr>
<tr>
<td>Unlock Data File</td>
<td>If selected, the user can unlock data files using the Unlock Data File Window.</td>
</tr>
</tbody>
</table>
Edit Users

Use the Edit Users tab to edit an existing user account.

Figure 124. User Administration Window - Edit Users

The Edit Users tab contains:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select User to Edit</td>
<td>Select the Username for the account to edit.</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the user.</td>
</tr>
<tr>
<td>Middle Name</td>
<td>The middle name or initial of the user.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of the user.</td>
</tr>
<tr>
<td>Position</td>
<td>If desired, the job title of the user.</td>
</tr>
<tr>
<td>Access Level</td>
<td>The Access Level of the user.</td>
</tr>
<tr>
<td>User Can Perform Signature</td>
<td>If selected, the user can sign data files using the Perform Signature Window.</td>
</tr>
<tr>
<td>Accept/Reject/Lock Data File</td>
<td>If selected, the user can Accept, Reject, and/or Lock data files in the Perform Signature Window.</td>
</tr>
<tr>
<td>Unlock Data File</td>
<td>If selected, the user can unlock data files using the Unlock Data File Window.</td>
</tr>
<tr>
<td>Edit User Password</td>
<td>If selected, the user’s password can be changed.</td>
</tr>
<tr>
<td>Password</td>
<td>Type the desired password for the user. The password must meet the password policies selected on the Set Policies tab.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Repeat the desired password for the user.</td>
</tr>
</tbody>
</table>
Show User Info

Use the Show User Information tab to view the account information for an existing username.

![User Administration Window - Show User Info](image)

**Figure 125. User Administration Window - Show User Info**

The Show User Info tab contains:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select User to Display</td>
<td>Select the Username for the account to view.</td>
</tr>
<tr>
<td>Username</td>
<td>The user name for the displayed information.</td>
</tr>
<tr>
<td>Full Name</td>
<td>The first, middle, and last name of the user.</td>
</tr>
<tr>
<td>Position</td>
<td>The job title of the user.</td>
</tr>
<tr>
<td>Access Level</td>
<td>Displays the Access Level of the user.</td>
</tr>
<tr>
<td>Can Perform Signature</td>
<td>Displays Yes if the user has rights to perform signatures. Displays No if the user does not have rights.</td>
</tr>
<tr>
<td>Can Accept/Reject/Lock Data File</td>
<td>Displays Yes if the user has rights to Accept, Reject, and Lock data files. Displays No if the user does not have rights.</td>
</tr>
<tr>
<td>Can Unlock Data File</td>
<td>Displays Yes if the user has rights to unlock data files. Displays No if the user does not have rights.</td>
</tr>
<tr>
<td>Account Created On</td>
<td>Displays the date and time when the account was created.</td>
</tr>
<tr>
<td>Account Last Changed On</td>
<td>Displays the date and time when the account was last changed.</td>
</tr>
<tr>
<td><strong>Option/Button</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Status</td>
<td>Displays Active if the user account is activated. Displays Deactivated if the account has been deactivated.</td>
</tr>
<tr>
<td>Print All Users check box</td>
<td>If selected, information for all user accounts will be printed.</td>
</tr>
<tr>
<td>Print Preview button</td>
<td>Displays a preview of the printed report. The report can be exported to a .rpt file from the Print Preview window.</td>
</tr>
<tr>
<td>Print button</td>
<td>Opens the Print window to print the report.</td>
</tr>
</tbody>
</table>
De/Activate User

Use the De/Activate User tab to Deactivate an active user or to Activate a deactivated user. Users cannot be deleted from the database. User names that will not be used should be deactivated to prevent unauthorized access to the LabChip GX software.

Figure 126. User Administration Window - De/Activate User

The De/Activate User Info tab contains:

<table>
<thead>
<tr>
<th>Option/Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select User</td>
<td>Select the username to be activated or deactivated.</td>
</tr>
<tr>
<td>User Info</td>
<td>Displays the information associated with the selected username.</td>
</tr>
<tr>
<td>Activate button</td>
<td>Click to activate a deactivated username.</td>
</tr>
<tr>
<td>Deactivate button</td>
<td>Click to deactivate an active username.</td>
</tr>
</tbody>
</table>
Define Access

Use the Define Access Tab to assign the desired rights to each access level. These rights control the actions each user is permitted to perform in the LabChip GX software. The Define Access tab is not available while an assay is running.

The Define Access tab displays a column for each access level (Administrator, Supervisor, Operator, Restricted User, and Service). Select Enabled for each right to be allowed for an access level, or select Disabled for each right not allowed for an access level.

The table below describes the function of each Access Right.

<table>
<thead>
<tr>
<th>Access Right</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Administration</td>
<td>If enabled, allows access to the User Administration Window to add and edit users, set access rights, and set policies.</td>
</tr>
<tr>
<td>Run Assay</td>
<td>If enabled, allows users to run assays and save the new data files that are created by the run. Users are not permitted to save changes to existing data files.</td>
</tr>
<tr>
<td>Save Existing Data File</td>
<td>If enabled, allows users to save changes to existing data files.</td>
</tr>
<tr>
<td>Save Workspace</td>
<td>If enabled, allows users to save new and existing workspaces. If Save Existing Data Files is not selected, users can only save workspaces where the data files have not changed.</td>
</tr>
<tr>
<td>Plate Editor</td>
<td>If enabled, allows users to add or edit plate dimensions in the Plate database.</td>
</tr>
<tr>
<td>Access Right</td>
<td>Function</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide/Show in CDR</td>
<td>If enabled, allows users to hide and show data files in the CDR Manager Window.</td>
</tr>
<tr>
<td>Manage CDR Folders</td>
<td>If enabled, allows users to create, rename, and delete folders in the CDR Manager window. This permission is not required for automatically creating daily subdirectories or to move data files in the CDR.</td>
</tr>
<tr>
<td>Perform Validation</td>
<td>If enabled, allows users to perform IQ (Installation Qualifications), OQ (Operation Qualifications), Teaching the robot, and Optics Calibration.</td>
</tr>
<tr>
<td>Print/Export Analysis Results</td>
<td>If enabled, allows users to print or export analysis results.</td>
</tr>
<tr>
<td>Audit Trail Access</td>
<td>If enabled, allows users to view the Audit Trail in the Audit Trail Window.</td>
</tr>
<tr>
<td>Assay Editor</td>
<td>If enabled, allows users to edit and save assays.</td>
</tr>
</tbody>
</table>
### Set Policies

Use the Set Policies tab to specify password, login, automatic lock, and signature policies for the LabChip GX software.

![Figure 128. User Administration Window - Set Policies](image)

The Set Policies tab contains:

<table>
<thead>
<tr>
<th>Access Right</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password Expires After</td>
<td>Specifies the number of days until each password expires. Range is 1 to 1000 days.</td>
</tr>
<tr>
<td>Number of Retired Passwords to Remember</td>
<td>User cannot reuse the specified number of old passwords.</td>
</tr>
<tr>
<td>Minimum Password Length</td>
<td>Specifies the minimum length of each password.</td>
</tr>
<tr>
<td>Maximum Login Attempts</td>
<td>Specifies the number of times the user can attempt to log in before being locked out of the software. Range is from 3 to 20. This option can be disabled to allow unlimited retries without locking the user out.</td>
</tr>
<tr>
<td>Minutes to Automatic Lock</td>
<td>Specifies the number of minutes that the software is inactive until the LabChip GX software locks automatically. Range is from 5 to 4320 minutes (3 days). To disable this option, clear the check box.</td>
</tr>
<tr>
<td>Require Signature on File Update</td>
<td>If selected, an electronic signature is required to save modified data files. Signatures can be performed by any user with the Perform Signature option selected in the Set Policies tab.</td>
</tr>
</tbody>
</table>
LabChip GX Instrument Description

This section identifies and describes the hardware components of the LabChip GX and GX II instruments. All of the components described in this section are the same for the GX and GX II instruments. The LabChip GX runs DNA and RNA assays. The LabChip GX II runs DNA, RNA, Protein, Glycan, and Protein Charge Variant assays.

This section includes the following topics:

- Front View
- Front Panel
- Rear Connectors
- Optics
- Chip Pressure System
- Barcode Reader
- DNA, RNA, and Protein Chips
- Chip Cartridge
- Microplate Carrier
- USB Key for 21 CFR Part 11 Option
- Specifications

Front View

Figure 129 shows the front view of the LabChip GX and identifies the parts on the front of the instrument.

<table>
<thead>
<tr>
<th>Front Panel</th>
<th>Buttons and indicator light. See “Front Panel” on page 271.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front Door</td>
<td>Opens automatically to provide access to the microplate, chip, buffer vial, and ladder vial.</td>
</tr>
</tbody>
</table>
Front Panel

The controls on the front panel open the front door, eject the chip cartridge, and indicate the status of the instrument.

The front panel contains the following parts:

| Status Light | Indicates the state of the instrument:  
Dark (not lit) - Power is off.  
Solid green - Power is on and instrument is idle.  
Flashing green - Running a plate.  
Red - Power is on, cannot communicate with software.  
Flashing Red - Error detected. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Chip button</td>
<td>Moves the robot to open the door and releases the chip cartridge to access the chip. This button is illuminated when this function is available and flashes when movement is in progress.</td>
</tr>
<tr>
<td>Eject button</td>
<td>Moves the robot and opens the door to access the plate in the microplate carrier. This button is illuminated when this function is available and flashes when movement is in progress.</td>
</tr>
<tr>
<td>Power Button</td>
<td>Turns the LabChip GX instrument On (Run) or Off (Standby). Note that power is still supplied to the power supply fans when the power switch is in the Standby position. Turning the instrument on reloads the system firmware and homes the robot.</td>
</tr>
</tbody>
</table>
Rear Connectors

The rear connectors are used to connect the LabChip GX instrument to the computer and power supply.

![Rear Connectors](image)

**Figure 131. Rear Connectors**

The following connectors are located on the back of the instrument:

<table>
<thead>
<tr>
<th>Connector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC Power Cable</td>
<td>Plug the power cord into this connector and a power outlet.</td>
</tr>
<tr>
<td><strong>WARNING</strong></td>
<td>Appliance inlet is disconnecting device. Place device or equipment in a manner so that disconnecting device is accessible at all times.</td>
</tr>
<tr>
<td>USB Cable</td>
<td>Connects the LabChip GX instrument to the computer.</td>
</tr>
</tbody>
</table>
Optics

The LabChip GX optics provide fluorescence detection (red excitation and red emission) for DNA, RNA, Protein and Glycan chips and assays. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)

Red Laser

The LabChip GX instrument includes a high intensity, long-life red diode laser to excite fluorescence on microfluidic chips. It is expected to have a lifetime of tens of thousands of operating hours.

Focusing and Alignment

The LabChip GX instruments use back-reflected red diode laser light for automatic chip focusing.

Photodiode Detectors

The LabChip GX and LabChip GX II use two silicon photodiode detectors for fluorescence detection and autofocus. Fluorescence data can be acquired and stored at rates from 20 to 120 Hz.

Optical Train

The fluorescence excitation, fluorescence detection, and autofocus optical trains contain several lenses and high efficiency interference filters. The optical trains are factory aligned and do not require adjustment.

Chip Pressure System

The pressure pump applies pressure or vacuum to the wells on the chip to move liquid through the chip. The Pressure Pump is located inside the LabChip GX instrument. O-Rings on the Chip Cartridge seal the chip wells and maintain the pressure.

Barcode Reader

The LabChip GX instrument is equipped with an internal Barcode Reader. The Barcode Reader reads the customer-applied barcode on the short (portrait) edge of the microplate.

Proper selection and placement of barcode labels is critical for successful reading. See "Placing the Barcode on the Plate" on page 40 for specifications.

The barcode reader is internal to the system and cannot be viewed from the outside.
DNA, RNA, and Protein Chips

The figures below show the format and parts of the microfluidic chips used in the LabChip GX instruments to perform DNA, Protein, RNA, and Glycan sizing and quantitation. (Protein, Glycan, and Protein Charge Variant assays are only supported on LabChip GX II instruments.)

![Figure 132. Top of Chip](image1)

![Figure 133. Bottom of Chip](image2)
Chip Cartridge

The Chip Cartridge holds the chip, provides the voltage to the chip channels to load, inject, and separate the sample, provides pressure to prime the chip with separation gel, and provides vacuum to the chip wells to pull samples from the microplate into the chip. The Chip Cartridge also contains a heating element to maintain a constant temperature in the chip’s microfluidic channels and provides an optically black beam dump to increase sensitivity and aid fluorescence detection.

Figure 134. Chip Cartridge

Figure 135. Chip Cartridge Lid
Chip Cartridge (Continued)

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lid</td>
<td>Holds the electrodes and o-rings to supply voltage and pressure to the chip.</td>
</tr>
<tr>
<td>Bottom of Cartridge</td>
<td>Holds the chip. The sipper on the chip extends through the sipper slot.</td>
</tr>
<tr>
<td>Optical Window</td>
<td>Window for laser to illuminate chip.</td>
</tr>
<tr>
<td>Optical Beam Dump</td>
<td>Provides an optically dark background under the chip.</td>
</tr>
<tr>
<td>Pressure Plate with Heating Element</td>
<td>Maintains a constant temperature in the chip’s microfluidic channels.</td>
</tr>
<tr>
<td>Electrodes</td>
<td>Apply voltage to the chip to move fluid through the chip and drive electrophoretic separations in the chip channels.</td>
</tr>
<tr>
<td>O-Rings</td>
<td>Create a seal between the chip cartridge and the chip to apply pressure or vacuum to the wells.</td>
</tr>
<tr>
<td>Pressure Port</td>
<td>Supplies pressure (positive or negative) to prime the chip or move samples through the chip.</td>
</tr>
<tr>
<td>Lid Latch</td>
<td>Locks the chip cartridge closed.</td>
</tr>
</tbody>
</table>

High Voltage Interface

Supplies DC voltage to the separation channels in the chip via inert electrodes that are immersed in specific wells on the chip. There are 6 voltage channels for the LabChip GX chips. HV channels can be run in either constant voltage or constant current mode.
**Microplate Carrier**

The LabChip GX instruments contain a stepper motor driven robot that moves the microplate to be accessed by the LabChip.

![Figure 137. Microplate Carrier Parts](image1)

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microplate Carrier</td>
<td>Holds the microplate.</td>
</tr>
<tr>
<td>Microplate Locator</td>
<td>Positions the microplate correctly for access by the sipper on the chip.</td>
</tr>
<tr>
<td>Buffer Vial</td>
<td>Contains buffer to be accessed by the sipper on the chip.</td>
</tr>
<tr>
<td>Ladder Vial</td>
<td>Contains ladder standards to be accessed by the sipper on the chip.</td>
</tr>
</tbody>
</table>

**USB Key for 21 CFR Part 11 Option**

If the 21 CFR Part 11 option is installed, the USB Key must be plugged into a USB port on the LabChip GX computer. If the USB key is not plugged in, the LabChip GX software displays an error message when starting and then shuts down.

![Figure 138. USB Key for 21 CFR Part 11 Option](image2)
Specifications

This section lists the technical specifications for the LabChip GX instruments. Technical specifications are subject to change without notice.

General

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size (H x W x D)</td>
<td>18.75 in. (48cm) x 19.25 in. (49cm) x 25.375 in. (64cm)</td>
</tr>
<tr>
<td>Weight</td>
<td>88 lbs. (40 kg)</td>
</tr>
<tr>
<td>Plate Capacity</td>
<td>one 96-well or 384-well microplate</td>
</tr>
<tr>
<td>Ventilation/Cooling</td>
<td>3” (77 mm) minimum space required around instrument for proper air flow.</td>
</tr>
</tbody>
</table>

Environmental

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating Temperature</td>
<td>65° to 78°F (18° to 26°C)</td>
</tr>
<tr>
<td>Operating Humidity</td>
<td>20% to 70% relative humidity, noncondensing</td>
</tr>
<tr>
<td>Storage Temperature</td>
<td>50° to 104°F (10° to 40°C)</td>
</tr>
<tr>
<td>Transient Overvoltages</td>
<td>Installation Category II Overvoltage</td>
</tr>
<tr>
<td>Pollution</td>
<td>Pollution Degree 2</td>
</tr>
<tr>
<td>Altitude</td>
<td>Up to 2000m</td>
</tr>
<tr>
<td>Indoor Use Only</td>
<td></td>
</tr>
</tbody>
</table>

Electrical

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Input</td>
<td>3.0A max at 100-127Vac, 50-60Hz (±10%)</td>
</tr>
<tr>
<td></td>
<td>1.5A max at 200-240Vac, 50-60Hz (±10%)</td>
</tr>
<tr>
<td>Line Voltage</td>
<td>100-127/200-240V~ nominal</td>
</tr>
<tr>
<td></td>
<td>90-264V~ maximum operating range</td>
</tr>
<tr>
<td>Total Heat Emission</td>
<td>800W</td>
</tr>
<tr>
<td>Fuses</td>
<td>No customer-replaceable fuses in system. Contact PerkinElmer Technical Support (see page 3) if blown fuses are suspected</td>
</tr>
<tr>
<td>Grounding</td>
<td>Through the power cord</td>
</tr>
<tr>
<td>Computer Interface</td>
<td>USB 2.0</td>
</tr>
</tbody>
</table>
## Assay Voltage

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Voltage/Current</td>
<td>-100V (limited by current)</td>
</tr>
<tr>
<td>Maximum Voltage/Current</td>
<td>-3000V (limited by current)</td>
</tr>
</tbody>
</table>

## Chip Pressure

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pressure Range</td>
<td>+50 to -5 psig</td>
</tr>
</tbody>
</table>

## Chip Temperature Control

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature Range</td>
<td>Ambient + 5°C to 40°C (no active cooling)</td>
</tr>
<tr>
<td>Accuracy</td>
<td>± 0.5°C</td>
</tr>
<tr>
<td>Thermal limit switch</td>
<td>65°C - 70°C</td>
</tr>
</tbody>
</table>

## Fluorescence Detection

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detection Wavelength</td>
<td>Bandpass 670-725 nm</td>
</tr>
<tr>
<td>Data rates</td>
<td>20, 30, 40, 50, 60, 80, 100, and 120 Hz</td>
</tr>
</tbody>
</table>

## Light Source (Red laser diode)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warmup Time</td>
<td>30 seconds</td>
</tr>
<tr>
<td>Wavelength</td>
<td>635 nm</td>
</tr>
<tr>
<td>Power output</td>
<td>7.5 mW</td>
</tr>
</tbody>
</table>

## Barcode Reader

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcode Engine</td>
<td>Microscan MS3CCD</td>
</tr>
<tr>
<td>Supported Barcode Types</td>
<td>Code 39, Code 93, Code 128</td>
</tr>
</tbody>
</table>
Maintenance and Service

Cleaning the O-rings and chip interface prevents pressure leaks and current leaks. The O-rings should be cleaned daily, with a more thorough cleaning of the O-rings and chip interface monthly. See Cleaning the Chip Cartridge.

The electrodes should be cleaned daily. Also clean the electrodes after running any diagnostic test using Test Chip B. See “Cleaning the Instrument Electrodes” on page 281.

Test Chip C should be inspected before use and cleaned if necessary. See “Cleaning Test Chip C” on page 282.

Run the Optics Calibration procedure (using Test Chip C) once a month, or more often if the company SOP specifies more frequent calibration or diagnostics. See “Calibrating the Optics” on page 41.

The LabChip GX/GXII Assay User Guides and Quick Guides contain LabChip Kit Essential Practices and instructions for preparing reagents and plates. Make sure to follow the instructions to ensure the optimum performance of your instrument.

The current version of the Assay User Guides and Quick Guides are available on the PerkinElmer web site at: http://www.perkinelmer.com/labchipguides.

The cleaning and maintenance procedures are reviewed during the standard customer training provided with the initial instrument installation. If you have any questions concerning maintenance or require additional training, please contact PerkinElmer Technical Support (see page 3).

WARNING

Laser maintenance and service should be performed only by a qualified PerkinElmer representative.
Cleaning the Chip Cartridge

Daily Cleaning

1. Inspect the inside of the chip cartridge and O-rings for debris.

2. Use the provided lint free swab dampened with DI water or 70%-isopropanol solution in DI water to clean the O-rings using a circular motion. If the O-rings stick to the chip or a pressure leak is detected, perform the more extensive monthly cleaning procedure below.

Monthly Cleaning

1. To reduce pressure leaks at the chip interface, clean the O-rings frequently. Remove the O-rings from the top plate of the chip interface on the LabChip GX instrument. Soak O-rings in DI water for a few minutes. Clean the O-ring faces by rubbing between two fingers.

2. To reduce the occurrence of current leaks, clean the chip interface frequently. Clean the top plate of the chip interface using the provided lint free swab dampened with DI water.

3. Allow the O-rings and chip interface to air dry. Reinsert the O-rings into the chip cartridge.

Cleaning the Instrument Electrodes

The electrodes should be cleaned daily. Also clean the electrodes after running any diagnostic test using Test Chip B.

To clean the electrodes, wipe down using the provided lint free swab dampened in DI water or 70%-isopropanol solution.
Cleaning Test Chip C

Before using Test Chip C, verify the test chip is clean. The chip must be clean before running Diagnostic tests.

1 Inspect the ruby crystal, chrome mask, and all glass surfaces for debris and/or fibers that may scatter light, fluoresce, or block excitation/emission light.

![Figure 139. Top and Bottom of Test Chip C](image)

2 Dust can be removed with a gentle air stream from oil free compressed and filtered house air or compressed air cans. Do not shake can before use. Hold can at a distance from the chip to prevent condensation.

3 To remove dyes or reagents from the Ruby crystal, chrome mask, and glass surfaces:
   a Do not apply any force when cleaning.
   b Use a lint free cloth and/or swabs (provided in accessory kit) dampened with 70%-Isopropanol / DI water solution.
   c Remove liquid from all surfaces with a dry lint free cloth or dry swabs.
   d Dry the chip completely with a gentle air stream from oil free compressed and filtered house air or compressed air cans. Do not shake can before use. Hold can at a distance from the chip to prevent condensation.
Troubleshooting and Diagnostics

This section contains the following topics to help troubleshoot problems with the LabChip GX software:

- “Searching for Events in the Events Tab” on page 283
- “Viewing Current Events in the Events Tab” on page 284
- “Viewing Past Events in the Events Tab” on page 284
- “Error Messages” on page 285
- “Running Installation Qualification (IQ)” on page 290
- “Running Operational Qualification (OQ)” on page 290
- “Diagnostics” on page 291
- “Troubleshooting Assay Problems” on page 298
- “Software Problems” on page 298
  - “Cannot Save a File” on page 298
  - “Computer Software Lock-Ups” on page 299
- “Zipping the Log Files” on page 300

Searching for Events in the Events Tab

Events and errors that occurred during the screening of previous jobs are displayed in the Past Events tab in the Event Viewer Window.

To search for a specific event:

1. On the Event Viewer window, click the Search Result tab.
2. In the Events list, select Current, Past, or All.
3. In the Search Text box, type a search query and click the Search button. The Source, Event Code, and Description fields are searched. The search results appear in the Search Result fields.

The Search Result tab contains the following fields:

Time - The time the event or error occurred.
Source - The source of the event or error.
Event Code - The event/error ID number used by PerkinElmer to troubleshoot problems.
Description - A detailed description of the event or error that occurred.
Viewing Current Events in the Events Tab

While a job or batch is running, the events and errors that occur during the screening display in the Current Events tab in the Event Viewer Window.

- On the Event Viewer window, click the Current Events tab. The Current Events fields display. (These fields are read only.)

The Current Events tab contains the following fields:

**Time** - the time the event or error occurred.

**Source** - The source of the event or error.

**Event Code** - The event/error ID number used by PerkinElmer to troubleshoot problems.

**Description** - A detailed description of the event or error that occurred.

Viewing Past Events in the Events Tab

All events and errors that have occurred during the screening of previous jobs or batches display in fields on the Past Events tab in the Event Viewer Window.

- On the Event Viewer window, click the Past Events tab. The Past Events fields display. (These fields are read only.)

The Past Events tab contains the following fields:

**Time** - The time the event or error occurred.

**Source** - The source of the event or error.

**Event Code** - The event/error ID number used by PerkinElmer to troubleshoot problems.

**Description** - A detailed description of the event or error that occurred.
Error Messages

Before a run is started and while an assay is running, the instrument firmware and software checks for errors (e.g., disconnected devices, bad parameters, bad data, etc.). If an error is detected, an error or warning message displays in the Run Status. Depending on the error, the run may continue or be aborted. The error or warning message describes the problem and either contains information on how to resolve the problem or directs you to call PerkinElmer Technical Support (see page 3).

For specific information about an error or warning message, click one of the links below.

General Errors
- Device <Name> is Disconnected
- Plate Carrier Motion Blocked
- Home Timeout
- Move Timeout
- Pressure Leak Detected
- Focus Failed

Chip Warnings
- HV Check Failed
- Current Leakage Check Failed

LabChip GX Warnings
- HV Check Failed
- Current Leakage Check Failed
- Chip Temperature Warning
Device <Name> is Disconnected

This error message indicates that there is no communication between the software and the specified device.

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Cable between computer and instrument unplugged.</td>
<td>Verify that the USB communication cable is secure.</td>
</tr>
<tr>
<td></td>
<td>Verify the power cord is plugged in.</td>
</tr>
<tr>
<td>2. Instrument power loss.</td>
<td>Press the Power button on the LabChip GX instrument.</td>
</tr>
<tr>
<td></td>
<td>See page 271.</td>
</tr>
<tr>
<td>3. Computer went into hibernation.</td>
<td>Restart the LabChip GX software.</td>
</tr>
<tr>
<td></td>
<td>If the problem is not resolved, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>

Plate Carrier Motion Blocked

Error Message: “Plate carrier motion blocked. Make sure tray movement is not obstructed.”

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Something is blocking the door from opening.</td>
<td>Remove the blockage.</td>
</tr>
<tr>
<td></td>
<td>Restart the instrument.</td>
</tr>
<tr>
<td>2. Something may have fallen inside and is blocking the robot motion.</td>
<td>If the problem is not resolved, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>

Home Timeout

Error Message: “Home Timeout.”

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Something is obstructing the robot motion.</td>
<td>Check for an object blocking the robot motion and remove the blockage.</td>
</tr>
<tr>
<td></td>
<td>Restart the instrument.</td>
</tr>
<tr>
<td>2. Robot Motor has failed.</td>
<td>If the problem is not resolved, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>
**Move Timeout**

Error Message: “Robot Failure.”

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Robot failure</td>
<td>Check for an object blocking the robot motion and remove the blockage.</td>
</tr>
<tr>
<td></td>
<td>Restart the instrument.</td>
</tr>
<tr>
<td></td>
<td>If the problem is not resolved, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>

**Pressure Leak Detected**

Error Message: “Pressure leak detected. Check and clean the O-rings at the chip interface.”

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. O-Ring missing or dirty.</td>
<td>Clean the O-rings (see page 281).</td>
</tr>
<tr>
<td></td>
<td>Run the Pressure Diagnostic Tests (see page 291).</td>
</tr>
<tr>
<td></td>
<td>If the problem is not resolved, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>

**Focus Failed**

Error Messages:
- “Focus failed due to less than 2 peaks found during horizontal scan.”
- “Focus failed due to more than 3 peaks found during horizontal scan.”
- “Focus failed due to dry focus marks not found.”
- “Focus failed due to error in horizontal scan.”

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Focus nominal starting position is incorrect.</td>
<td>Run the Optics Diagnostics tests (see page 291).</td>
</tr>
<tr>
<td>2. Laser or detector failure.</td>
<td>If the problem is not resolved, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>3. Laser interlock switch failure.</td>
<td></td>
</tr>
<tr>
<td>4. Bad or jammed focus motor.</td>
<td></td>
</tr>
</tbody>
</table>
**Maximum Samples Exceeded**

Warning Message: “Maximum number of samples that can be run on this chip has been exceeded. Please install new chip.”

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chip has already been used to process the maximum number of samples</td>
<td>Replace the chip with a new chip. Prepare and reprime the new chip as necessary.</td>
</tr>
</tbody>
</table>

**Chip Primed for Different Assay**

Warning Message: “Assay for which chip was primed is different from run assay or unknown.”

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
</table>
| The last assay that the chip was primed for does not match the assay that is going to run. | 1. Click the No button, remove the chip, refresh with appropriate reagents, and repeat the chip priming step.  
2. Click the Yes button to skip repriming and continue with the run with the current chip. |

**HV Check Failed**

Warning Message: “HV check failed.”

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
</table>
| 1. Dirty electrode block. | 1. Run the Current Leak Diagnostics test (see page 291). If test fails, clean o-rings and electrode block (see page 281).  
2. Re-priming can sometimes clear chip clogs. Eject the chip drawer, push the drawer back in, and restart the run. See the LabChip GX/GXII Assay User Guide for troubleshooting.  
3. If the problem is not resolved, contact PerkinElmer Technical Support (see page 3). |
| 2. Clogged chip. |                                      |
Current Leakage Check Failed

Warning Message: “Current leakage check failed.”

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dirty electrode block.</td>
<td>Clean the O-rings (see page 281).</td>
</tr>
<tr>
<td></td>
<td>Run the Current Leak Diagnostic Test (see page 291).</td>
</tr>
<tr>
<td></td>
<td>If the problem is not resolved, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>

Chip Temperature Warning

Warning Message: “Average chip temperature is out of range.”

<table>
<thead>
<tr>
<th>Possible Causes</th>
<th>Recommended Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chip heater failed.</td>
<td>Restart the instrument. If problem persists, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>
Running Installation Qualification (IQ)

The Installation Qualification (IQ) verifies proper installation of the LabChip GX software and verifies no unauthorized changes have been made to the software. The IQ can be run whenever required by your laboratory procedures.

The Installation Qualification can be used to check software installation qualification after routine computer maintenance, such as disk cleanup, after installing antivirus software, or after installing Microsoft service packs. The Installation Qualification checks LabChip GX software registry settings, the directory structure, and the integrity of each file specified for the software application.

To run the IQ:

1. On the LabChip GX Main Window, select Validation → Software IQ. The Installation Qualification Window opens.

2. To view the results of the previous IQ before running a new IQ, click the Previous Result button. The View Installation Qualification Results Window displays the results of the last IQ that was run.

3. To start the IQ, click the Start IQ button. The Installation Qualification window displays the tests that are run for the IQ, the progress of each test, and the Pass/Fail status of each test as it is completed.

4. To save the results of the IQ, click the Save As button, specify the desired location and name of the file, and click the Save button. IQ results are saved as .xml files.

Running Operational Qualification (OQ)

The System Diagnostics window performs an automated Operational Qualification whenever required by your laboratory procedures.

The System Diagnostics Window displays the tests that are performed on the left side of the window. The test results are displayed on the right side of the window. After all tests are complete, the test report is generated and saved to a file for review, printing, and documentation purposes.

See “Diagnostics” on page 291 for details on running the Diagnostics.
Diagnostics

The LabChip GX software contains a set of diagnostic tests to verify proper operation of the LabChip GX or GX II instrument. These tests are not dependent on assay chemistry. All tests must pass to ensure the instrument is functioning properly. To open the System Diagnostics Window, select Validation → Diagnostics.

The following procedures are included in this section:

- Running the Diagnostics Tests
- “Description of Diagnostic Tests” on page 292

Running the Diagnostics Tests

To begin running the Diagnostics tests, click the Run Tests button on the System Diagnostics Window. The tests run from top to bottom, prompting you to load the correct chips or plates as required for each test. Follow the prompts. As each test is completed, the results display on the right side of the window.

Supplies Required to Run Diagnostics Tests:

- Test Chip A (PerkinElmer P/N 760453)
- Test Chip B (PerkinElmer P/N 760489)
- Test Chip C (PerkinElmer P/N 760624)
- Test Plate with barcode label

To order Test Chip A, B, or C, contact PerkinElmer Technical Support (see page 3).
Description of Diagnostic Tests

This section includes the following information about the diagnostic tests: the test names, descriptions, potential failures, and the chip required to run the test.

- “Computer Resources Test” on page 292
- “System Components Test” on page 293
- “Chip Interface Test” on page 293
- “RF Tag Test” on page 294
- “Pressure Leak Test” on page 294
- “Chip Temperature Test” on page 294
- “Current Leakage Test” on page 295
- “Optics Test” on page 295
- “Plate Handler Test” on page 296
- “HV Voltage Calibration Test” on page 297
- “HV Current Calibration Test” on page 297
- “Barcode Test” on page 297

Computer Resources Test

Any chip can be loaded

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check CFR database connection (only if Security is installed)</td>
<td>SQL server not started. Start SQL Server Express.</td>
</tr>
<tr>
<td></td>
<td>Database not installed properly. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Check CDR Service (only if Security is installed)</td>
<td>Service exited unexpectedly or not started.</td>
</tr>
<tr>
<td>Check Remote CDR Connection (only if Remote CDR is set up.)</td>
<td>Remote server is down. Network is down.</td>
</tr>
<tr>
<td>Memory Check</td>
<td>Available memory below 500 MB. System may function with lower memory but there is risk of failure if analyzing many plates.</td>
</tr>
</tbody>
</table>
**Disk Space Check**  
Available disk space below 4 GB. Risk of losing data as disk space is used. Free space on local hard drive.

### System Components Test

Any chip can be loaded

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify Fan Operation</td>
<td>Damaged fan. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>
| Check Chip Cartridge Interlock | Chip Drawer is not open or closed at the correct time. Close or open chip drawer as instructed.  
Interlock Switch is defective. Contact PerkinElmer Technical Support (see page 3). |

### Chip Interface Test

Remove Chip

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marker Pressure Sensor Test</td>
<td>Pressure sensor out of calibration. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Marker Pressure Chip Interface Clog Test</td>
<td>Clog in pressure line. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Priming Pressure Sensor Test</td>
<td>Pressure sensor out of calibration. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Priming Pressure Chip Interface Clog Test</td>
<td>Clog in pressure line. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Sipping Pressure Sensor Test</td>
<td>Pressure sensor out of calibration. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Sipping Pressure Chip Interface Clog Test</td>
<td>Clog in pressure line. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>
**RF Tag Test**

Test Chip A required

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read RF Tag</td>
<td>Bad tag on chip. Try another chip with known good RF Tag.</td>
</tr>
<tr>
<td></td>
<td>Problem with RF Tag reader. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>

**Pressure Leak Test**

Test Chip A required

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marker Pressure O-Ring Leak</td>
<td>Pressure leak at O-rings. Clean or replace the O-rings (see page 281) and clean the chip cartridge.</td>
</tr>
<tr>
<td>Priming Pressure O-Ring Leak</td>
<td>Problem with pressure lines. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Sipping Pressure O-Ring Leak</td>
<td></td>
</tr>
</tbody>
</table>

**Chip Temperature Test**

Test Chip A required

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chip Heater Ramp</td>
<td>Initial chip temperature not achieved in time. Temperature ramp time not within spec may indicate heater disconnected or burned out. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>
Current Leakage Test

Test Chip A required

For each pin, apply -3000V to pin and -100 to all others. Sum up currents.

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leakage Check: Channel (0, 1, 2, 5, 6, and 7)</td>
<td>Source current too high or sum of sink currents too high. Clean or replace the O-rings (see page 281) and clean the chip cartridge. If error persists, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>

Optics Test

Test Chip A required

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Optics</td>
<td>Optics Motor failure. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Focus/Laser/Detector</td>
<td>Incorrect initial starting position due to crash or contact of optics block with an object. Laser or detector failed. Laser power too low. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Laser On/Off</td>
<td>Signal level difference between On and Off states too low may indicate laser burned out or detector failure. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>
Test Chip C required

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optics Calibration</td>
<td>Signal out of range indicates laser, optical alignment, or filter degradation. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td></td>
<td>If the Drift is greater than 7.5%, calibrate the optics (see page 41).</td>
</tr>
<tr>
<td></td>
<td>If the Gain factor is not within the factory limits, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Optics Noise</td>
<td>If the Optics Noise is greater than the limit, calibrate the optics (see page 41).</td>
</tr>
<tr>
<td></td>
<td>If the problem still occurs, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>

Plate Handler Test

Test Chip A Required

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Sensor Check Absence</td>
<td>Faulty sensor. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Plate Sensor Check Presence</td>
<td></td>
</tr>
<tr>
<td>Plate Punch Test</td>
<td>Verify correct plate type is selected for test.</td>
</tr>
<tr>
<td></td>
<td>Verify dimensions of plate are correct in the Plate Information Window.</td>
</tr>
<tr>
<td></td>
<td>If all punches are misaligned, teach plate position (see “Robot Teaching Wizard” on page 234). If the problem persists, contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>
HV Voltage Calibration Test

Test Chip B required

Test description: For each channel, apply -3000V while setting other channels to 0.0 uA. Ensure each channel reaches applied voltage.

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage Calibration: Channel (0, 1, 2, 5, 6, and 7)</td>
<td>Voltage out of calibration or electrode not connected to power supply. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>

HV Current Calibration Test

Test Chip B required

Current Calibration Test: For each channel, set one channel to -3000V. Set another channel to 20ua. Set all other channels to 0ua. Current for first channel should be -20ua. Voltage for the current controlled channel should be -120V +/- 22V.

Current Stability Test: Monitor current level for 10 seconds to verify it is stable at 20ua.

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Calibration Channel (0, 1, 2, 5, 6, and 7)</td>
<td>Current out of calibration. Electrode not connected to power supply. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
<tr>
<td>Current Stability Channel (0, 1, 2, 5, 6, and 7)</td>
<td>Current out of calibration. Electrode not connected to power supply. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>

Barcode Test

Use any Chip. Test Plate required.

<table>
<thead>
<tr>
<th>Description</th>
<th>Potential Cause of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read barcode on test plate.</td>
<td>Plate missing barcode. Place barcode on plate in correct position (see page 40).</td>
</tr>
<tr>
<td></td>
<td>Barcode is not read correctly. Barcode reader disconnected or misaligned. Contact PerkinElmer Technical Support (see page 3).</td>
</tr>
</tbody>
</table>
Troubleshooting and Diagnostics

Troubleshooting Assay Problems

For problems with assays, see the Assay User Guide for the specific assay you are running. The Assay Guides contain common problems that may occur for each type of assay, and suggested solutions to resolve the problems.

The current version of the Assay User Guides can be accessed on the PerkinElmer web site at: http://www.perkinelmer.com/labchipguides.

If the problem is not resolved by following the suggestions in the Assay User Guide, Contact PerkinElmer Technical Support (see page 3).

Software Problems

If any of the following software problems occur, follow the suggestions to correct the problem:

- Cannot Save a File
- Computer Software Lock-Ups

Cannot Save a File

File has been saved as a Read Only file.

If you editing an existing file, verify the file is not Read Only. If it is, the title bar shows Read Only after the file name. Read-only files can be edited and saved with a new name or in a new location with the same name, but cannot be saved over the original file.

Hard drive is full.

Verify there is sufficient free space on the drive to save the file. If not, clear some space on the hard drive. On non-21 CFR Part 11 systems, you can archive files that you are not using to another location.

If you do have sufficient space, try closing all open applications and then turning off the power to the computer. After a few seconds, restart the computer, open another file, and try resaving it to verify the Save function is working properly.

LabChip GX software is corrupted.

Reinstall the software. If the problem persists, contact PerkinElmer Technical Support (see page 3).
Computer Software Lock-Ups

If a computer or software lock-up occurs:

1 Try to exit and then re-launch the LabChip GX software.

2 If this is not successful, exit the application using the **Task Manager**:
   a Right-click in the desktop menu bar and select **Task Manager**.
   b Click the **Applications** tab.
   c While holding down the **Shift** key, select all running applications.
   d Hold the **Ctrl** key and click **End Task**.

3 If the **Task Manager** cannot be accessed, try one or all of the following:
   • Press the **Ctrl**, **Alt**, and **Delete** keys on the keyboard simultaneously.
   • Perform a hard reboot by turning off the computer and then restarting it.
   • Power cycle the LabChip GX instrument.

4 Contact PerkinElmer Technical Support (see page 3).
Zipping the Log Files

The Caliper Log Zipper is a small software utility that zips the LabChip GX log files and system info files and places the resulting DiagnosticsLog.zip file on the computer desktop. This utility can be used to package all of the log and diagnostic files together if the files need to be emailed to PerkinElmer Technical Support.

To zip the LabChip GX diagnostics logs:

1. On the Windows desktop, select Start → All Programs → Caliper Life Sciences → LabChip GX → Caliper Log Zipper. The Caliper Log Zipper window opens.

![Figure 140. Caliper Log Zipper Window](image)

2. Click the **Zip** button. The DiagnosticsLog.zip file is saved to the computer desktop. Any existing older file with the same name is over-written.

3. To save a copy of the file, either rename the file or move the file to a different location.
Tips and Shortcuts

This section describes the shortcuts and actions that can be performed in the LabChip GX software by clicking, right-clicking, etc.

Single Click

- **In Plate View** - Selects or de-selects a well.
- **In Gel View** - Selects a well and displays the graph in the Graph view.
- **In Well Table View** - Selects a well, displays the graph in the Graph view, and selects the well in the Gel view.
- **In Peak Table View** - Selects a peak, displays the graph in the Graph view, and selects the well in the Gel view.

Ctrl + Click

- **In Gel View** - Overlays second and subsequent well data over original well data in the Graph view (for each Ctrl + click on a lane in the gel). Each well in the graph is shown in a different color.
- **In Well Table view** - Overlays second and subsequent well data over original well data in the Graph view (for each Ctrl + click on a row in the Well Table). Each well in the graph is shown in a different color.

Ctrl + Shift + Click

- **In Gel View** - Highlights corresponding well data trace in Overlay Electropherogram view (adds trace to overlay if not already included). This trace becomes the foreground trace for peak selection. Repeat click to undo highlighting.

Right-Click

- Right-click in any view to display a shortcut menu with available options. In the **Graph View**, different shortcut menus display depending on whether the cursor is near a peak or not near a peak.
Glossary of Terms

This Glossary includes explanations and examples of the following terms:

- Apex
- Assay File
- Baseline
- Bubble
- CLA
- Clipboard
- Collection
- Collection Template
- Data Files
- Data Points
- Data Filtering
- DNA Assay Analysis
- Electrokinetic Forces
- Electroosmotic Flow
- Electrophoresis
- End Point
- End Time
- Filter Width
- Genomics Quality Score [0-5]
- GXD Files
- Hardware Diagnostics
- Inflection Threshold
- Lab-on-a-Chip
- Ladder
- Ladder Analysis
- Lower Marker
- Log Files
- Marker Drift Tolerance
- Microfluidics
- Minimum Peak Height
- Minimum Peak Width
- Molarity
• Molecular Separation Techniques
• Optical Calibration
• Peak Baseline
• Peak Height
• Peak Identification
• Point-to-Point Fit
• Polynomial Filter
• Polynomial Order
• Protein Assay Analysis
• Protein Charge Variant Assay
• RNA Assay Analysis
• RNA Degrade Factor
• Rolling Ball Baseline Curve Example
• Run Button
• Slope Threshold
• Smear
• Standard Curve Window
• Start Point
• Start Time
• Titer
• Tool Tip
• Upper Marker
• Workspace
• Zero Baseline

Apex

After locating a start point, the peak find algorithm looks for the first negative slope value and saves the previous point as the apex. If the value of the apex is less than the minimum peak height limit, the algorithm starts looking for a new peak.

Assay File

File created by the LabChip GX software to specify assay and analysis settings, such as Ladder and marker sizes and concentrations, peak find settings, expected peaks, and excluded peaks.
Baseline

A baseline is established just after the start time setting. (For DNA and RNA assays, you can change the Baseline Start time on the Analysis Tab.) After the overall baseline is established, a local baseline is calculated for each peak to compensate for baseline drift.

To select the desired baseline algorithm for all of the samples in the plate, choose the desired option on the Peak Find Tab: No Baseline, Zero Baseline, or Baseline Subtraction. See “Zero Baseline” on page 329 for more information about the Zero Baseline option.

Baseline Subtraction can use either Spline fit or Rolling Ball fit for the baseline curve algorithm.

- **Spline** - Creates a smooth line fit to the baseline data points and subtracts this smooth fit from the data. The Threshold determines how much the baseline fit follows changes in the data. Lowering the Threshold below the default value of 20 allows the baseline fit to ignore regions that are slow changes of real signal peaks and not baseline drift. This spline curve is not constrained to remain below the signal and may produce negative signal values when subtracted from the signal.

- **Rolling Ball** - Generates a smooth baseline curve by mathematically rolling a ball under the sample signal, keeping it in contact with the closest signal point without crossing into the signal. Time Diameter and Signal Diameter determine the smoothness of the curve in the Time and Signal axes and determine how closely the curve follows the signal. The ball is constrained to never cross into the signal, therefore the baseline curve is never greater than the signal and will not produce negative signal values when subtracted from the signal. See “Rolling Ball Baseline Curve Example” on page 322 for more information.

For isolated peaks, the local peak baseline is a straight line connecting the start point of the peak with the end point. For peaks that are very close together, an average baseline is used when the value between the peaks does not drop to the actual baseline.

Figure 141 on page 305 shows baselines established for DNA assay peaks (based on the settings in the Peak Find Tab). DNA peaks are determined on a peak-by-peak basis (the overall baseline is shown).
Bubble

If the tip of a pipette is not positioned below the liquid level in the well, bubbles can result. If a large bubble forms at the bottom of a well, remove the sample from the well, pipette the sample back into the well, and continue with the loading procedure.

CLA

The file extension for data files created by the LabChip HT software. CLA files can be opened in the LabChip GX software. Opening a .CLA file (see page 60) creates a .GXD file with the same name.

Clipboard

A temporary storage area that contains information you have cut or copied. You can paste the contents of the clipboard into other programs (provided that program supports that type of information). Information remains on the clipboard until you replace it with the information from another cut or copy command.

Collection

Use a collection to view the plate data. A workspace can contain multiple collections to supply different views of the same data.

Each collection specifies:
• the wells selected for view in each plate data file,
• the layout of each Collection tab, and
• the display properties for each view in each collection.
Collection Template

A collection template saves the display options for a collection and any defined filters in the collection. Collection templates are used to create new collections using the saved display settings and filters. Collection templates do not save the list of plates or the wells selected in the plates.

To save a collection template based on the settings in the open collection, select Collection → Save Template on the main Menu Bar.

To apply a collection template to a new collection, select the Template option in the New Collection Window.

To apply a collection template to an existing collection, select the tab for the desired collection and then select Collection → Apply Template on the main Menu Bar.
Data Files

While running an assay, the raw data received from the instrument is automatically saved to the plate data file (*.gxd). As the data from each single well is received, it is saved to the data file. The name of the data file is specified during the run in the Start Run Window. If a run is stopped before the run is complete, the data file contains the data for the completed wells.

After a run is complete, the data is analyzed using the analysis settings in the assay. The analysis settings are saved in the data file (.gxd).

After the run, you can change the analysis settings using the Assay Analysis Window. When the new settings are applied, the data is reanalyzed and the updated results are displayed. Changes to the analysis settings are not saved until the workspace is saved. To save analysis settings without saving the workspace, select Workspace → Save Plate or right-click on the plate name above the plate diagram on the left side of the window and choose Save Plate.

Changes to the analysis settings are saved at the end of the plate data file without overwriting previous settings in the file. The Restore Plate option can be used to return to previous analysis settings.

Data Points

Data points are determined by the data collection rate set in the assay properties.

Show Data Points is an option in the Graph View Properties that displays the data points used to generate the graph.

Data Filtering

Before identification of peaks in the fluorescence data can proceed, the raw data must be smoothed to prevent the detection of signal noise as peaks. For details on the data filtering process, see “Data Smoothing” on page 108.
DNA Assay Analysis

DNA samples contain two marker peaks outside the limits of the DNA fragment sizes the assay is designed to detect. The ladders contain the same two marker peaks. The sample data is aligned to the ladder data by matching the peak times of the two markers in the sample data with the same two markers in the ladder data. The size of each sample peak is calculated by linear interpolation between the known ladder peak migration time and size using the peak aligned migration time. The analysis settings can be changed to perform the interpolation using a local third order polynomial fit to the time instead of the size relationship provided by the ladder.

The concentration of the sample peaks is calculated using the known area and concentration of the ladder peaks. The molarity of each sample peak is calculated using the sample concentration, the DNA fragment size (in base pairs) attributed to the peak, and the known molecular weight of the DNA base pair.

Electrokinetic Forces

Electrokinetic forces are used to move, switch, mix, and separate the nucleic acid samples. Active control over voltage gradients directs the movement of materials using the phenomenon of electroosmotic flow or electromigration.

Electroosmotic Flow

A phenomenon that results from an electrical double layer formed by ions in the fluid and surface electrical charges immobilized on the capillary walls. When an electric field is applied, the bulk solution moves towards one of the electrodes. This phenomenon can be used to move fluids through microfabricated channels.

Electrophoresis

A technique of separating molecules on the basis of their mobility. An electrical potential is applied across a capillary containing a sample in a fluid medium. Positive molecules migrate towards the cathode and negative molecules migrate towards the anode at different speeds depending on their electrophoretic mobility.

End Point

The peak find algorithm looks for a leveling off when the value of the slope is less than the value set for the slope threshold. This is marked as the end point of the peak.
End Time

This setting determines the time after the start of a run before which the last peak or fragment will be located (any peaks appearing after this time are ignored).

Filter Width

This setting on the Peak Find Tab determines the width of the polynomial (in seconds) to be applied to the data for filtering (noise reduction). The default depends on the assay selected.

Genomics Quality Score [0-5]

Calculated in gDNA assays to measure the quality (relative intactness) of the gDNA. The Genomics Quality Score ranges from 0 to 5, where 5 represents the highest quality of gDNA. The Genomics Quality Score can be used to measure the quality of gDNA before proceeding with further analysis of the sample. The Genomics Quality Score displays in the Well Table View.

GXD Files

The file extension for data files created in the LabChip GX software. The data file contains the data from the read, assay information, analysis settings, and Run Information for the run.

Data is saved to the file as each well is read. If a run is stopped before the run is complete, the data for any completed wells is saved in the data file.

The file name is specified during the run in the Start Run Window.

Hardware Diagnostics

Whenever a run begins, the instrument checks for errors (e.g., defective high-voltage supplies, missing conductivity between wells, etc.). If an error is detected, a message box displays and the run stops. The message box describes the problem and either contains information on how to resolve the problem or directs you to call PerkinElmer Technical Support (see page 3).
Inflection Threshold

Peaks that are very close together are identified as a single peak if the peaks do not have a clear valley between them. The Inflection Threshold property splits peaks based on the slope. The inflection threshold defines the value that the slope minimum must be below to trigger a splitting of the peak. As the threshold is increased, more peak splitting occurs. For details, see “Understanding Peak Finding” on page 108.

Lab-on-a-Chip

The generic term for a microfluidic product, signifying a chemical process or material movement taking place on a microchip. In contrast to analysis in a standard laboratory that relies on human intervention at several stages to manipulate or observe samples and record results, the self-contained lab-on-a-chip represents an almost hands-free technology.

Ladder

Ladders are used to align the data and calculate the size of data peaks. (Protein Charge Variant assays do not use ladders or markers.) The Ladder vial is located in the front right corner of the microplate carrier, next to the buffer vial. The Ladder is sipped before the first well and then after every 12 wells. The ladder is analyzed before sample analysis starts.

The peak sizes and markers defined for the ladder in the assay are assigned consecutively, starting with the first peak detected in the ladder. If too few peaks are detected in the ladder well, analysis stops and an error is generated. Peaks appearing above the upper marker do not have to be detected. The Peak Table View for the ladder well shows the peak size and concentration set in the Assay Analysis Window.

![Figure 142. Ladder Graph]
Ladder Analysis

A ladder is a mix of compounds of known sizes that is used to create a size ruler for the samples. Ladder data is used to convert the migration time of each sample peak into a size for the compound responsible for that peak. The known sizes of the ladder compounds are supplied in the assay file and can be viewed in the Analysis Tab on the Assay Analysis Window.

The initial step in ladder analysis is to identify the most prominent peaks in the ladder well and associate each peak with the known ladder sizes. The analyzed ladders provide a table of values relating size to migration time. Typically the migration time uses the center of the peak in the ladder and the sample.

Failure to find the correct number of ladder peaks prevents further analysis of the sample wells using the faulty ladder. The software automatically attempts to use the nearest good ladder before generating an analysis error.

A **Ladder Quality Score** is computed for each Ladder well. The Ladder Quality Score is the $R^2$ value for the fit of the peak migration times to size curve multiplied by 10. If the Ladder Quality Score is less than the **Ladder Rejection Threshold** specified on the Alignment Tab in the Assay Analysis Window, the ladder well generates an error and is not used for sizing or quantization. The software will use the nearest good ladder to analyze the samples.

The analysis settings can specify which ladder is used to size any particular sample row. If more accurate sizing can be obtained by measuring migration times at the start of each peak, this option can be selected in the Assay Analysis Window.

Lower Marker

An internal standard that is added to a sample in a well to assist in determining size and concentration of the sample. For DNA assays, the marker is the same as the first peak in the DNA ladder. DNA ladders and samples also contain an **Upper Marker**. For Protein and RNA assays, the marker is the same as the first peak in the ladder. Protein Charge Variant assays do not use ladders or markers.
Log Files

The LabChip GX software log file displays in the Event Viewer Window. The log file maintains a running record of all events that occur with the instrument while it is online with the software and records all events that occur in the software. Each event specifies the date and time of the event, source of the event, the event code, and a description of the event.
Marker Drift Tolerance

Isolating the markers in the sample is key to alignment and sizing. The markers in the sample appear similar in size and migration time to the markers in the ladder. Markers are discriminated from nearby peaks through a weighing scheme which attributes a numerical value to the migration time similarity and area similarity. This approach is usually successful as long as the first peak is the marker, but when there is a peak of similar size arriving just before the true marker, the first marker is likely to be confused with the marker. When the primary differentiator between the two peaks is the migration time, the marker drift tolerance can be used to narrow the acceptable range for the migration time by increasing the importance of the similarity between the sample and ladder marker peak times. The marker drift tolerance specifies the accepted range as a percentage of the ladder migration time. The blue and yellow triangles shown in the figure below represent the weight assigned to a peaks migration time for a tolerance of 100% and 10% respectively.

Figure 143. Marker Drift Tolerance
As the drift tolerance is reduced, the acceptable deviation from the ladder marker migration time is reduced, causing the analysis to reject nearby peaks preceding the true marker.

The marker drift tolerance is selected on the Advanced Tab of the Assay Analysis Window (see page 205).

**Microfluidics**

The miniaturization of chemical processes generally pertaining to systems involved in the control of fluid flow. This includes pumps, valves, jets, and microchannels.

**Minimum Peak Height**

The Minimum Peak Height value determines the height limit below which a peak will not be detected. For each peak, the difference between the peak start time and the peak apex must be greater than the Minimum Peak Height value.

The Minimum Peak Height is specified on the Peak Find Tab of the Assay Analysis Window.

**Minimum Peak Width**

The Min Peak Width value determines the width (in seconds) under which a peak will not be detected. For each peak, the difference between the peak start time and the peak end time must be greater than the Minimum Peak Width value.

The Minimum Peak Width is specified on the Peak Find Tab of the Assay Analysis Window.

**Molarity**

\[
\text{Molarity} = \frac{(\text{Concentration} \times 10^6)}{(660 \times \text{Size})} \text{[nmol/l]}
\]

where molarity is measured in nanomoles per liter (nmol/l), Concentration is measured in nanograms per microliter (ng/µL), Size is measured in base pairs (bp), and

\[660 \times \left[\frac{\text{g}}{(\text{mol} \times \text{bp})}\right]\] is the molecular weight of a single base pair
Molecular Separation Techniques

Processes such as gel electrophoresis, liquid chromatography, and capillary electrophoresis, which can separate biomolecular organic substances from other compounds.

Optical Calibration

The LabChip GX instrument reads fluorescence of a laser illuminated dye attached to compounds present in a sample. The absolute value of this fluorescence has little meaning as all computed quantizations, such as concentration, are derived from ratios of fluorescence to known standards found in the supplied ladder. Due to component variations in the optical subsystem, the same sample delivers different absolute fluorescence on different instruments, making it somewhat disconcerting to the user when comparing the e-grams of similar samples run on different instruments. In order to provide a more consistent absolute fluorescence for visual comparisons, an optical calibration process is included in the LabChip GX software.

The Optical Calibration uses a calibrated test chip (Test Chip C), which has a stable, dry fluorescent material embedded in the channel. Test Chip C is provided with all new instruments. Test Chip C is factory-calibrated with a reference contrast value written in the chip RF tag. Each instrument uses this test chip to determine an optical gain correction factor, which will scale its optical response to a common standard.
Peak Baseline

A local peak baseline is calculated for each peak. For isolated peaks, the local peak baseline is a straight line connecting the start point with the end point. For peaks that are very close together, an average baseline is used when the value between the peaks does not drop to the actual baseline. The peak baseline for each peak in Figure 144 is shown in a different color.

![Figure 144. Peak Baselines](image)

The peak baseline algorithm starts at the earliest peak and checks whether the end point is within a certain distance from the start of the next peak. When a cluster of peaks is detected, the peak baseline is the line joining the first peak's start to the last peak's end. The start and end points of adjacent peaks in the cluster are averaged to the same point so that no gaps exist between peaks.

The peak baseline Start Point and End Point can be moved in the Overlay Electropherograms Tab if Show Peak Baselines is selected in the Graph View Properties.

Peak Height

The value at the apex of the peak minus the local baseline start value.
Peak Identification

From the smoothed data, peaks are identified using a hill-climbing algorithm running along the smoothed data and its first derivative.

The peak baseline is drawn across the peak bottom by taking local averages just outside the peak start and end points and connecting the two points. The peak height, measured from the apex down to the peak baseline, must exceed the minimum peak height specified in the Assay Analysis Window for the bump to be identified as a peak. For details, see “Understanding Peak Finding” on page 108.

The peak start, end, and baseline can be viewed in the Graph View by selecting the Show Peak Baselines option in the Graph View Properties. The area of each peak is determined by trapezoidal integration of the peak signal between peak boundaries and above the peak baseline.

Point-to-Point Fit

This curve fit is composed of line segments between each pair of data points that are used to interpolate data between the points.

Polynomial Filter

The first step the software takes in analyzing the raw data is to apply Data Filtering. Data filtering is performed by means of a polynomial “filter” that is applied to the raw data. The figure below approximates the shape of the filter and shows what peaks may resemble if the filter application is too strong.

Polynomial Order

This setting on the Peak Find Tab determines the order of the polynomial filter used to convolve with the data. A polynomial filter is used to filter the data to increase the signal-to-noise ratio and calculate filter slope information for peak detection. The default setting is 6 (for 6th order). A setting of 4 produces a straighter baseline, preventing quick changes in the signal.
Protein Assay Analysis

Protein assays utilize a chemistry that generates an extra set of peaks (system peaks) just above the lower marker that should not be included in the analysis. These system peaks must be identified and excluded from further quantitative analysis. For ladder analysis, peaks occurring after the lower marker less than the “Ladder Ratio” analysis setting, are tagged system peaks to avoid confusion with legitimate ladder peaks.

Protein samples contain a single lower marker. Alignment to a single marker does not provide enough constraints to align large proteins, so data is aligned to two ladders, one sipped just before the sample wells and another sipped just after the sample wells. The second ladder is called the bracket ladder. Samples are scaled so the sample’s lower marker is nearly aligned with both ladder lower markers. The scaling is weighted by the proximity in sip time to each ladder. The sample sipped closest to the primary ladder is scaled to align more closely to the primary ladder and the sample sipped just before the bracket ladder is scaled to align most closely to the bracket ladder. Then each sample is shifted in time so the sample's lower marker aligns exactly with the primary ladder lower marker.

After alignment, the size of the protein producing each peak is calculated from the aligned peak time using a log (size) versus 1/(Time-T0) fit to the primarily ladder peaks of known size and measured migration time. T0 is determined empirically as the time offset which delivers the best straight line fit to the ladder data, The value of T0 used for the fit can be viewed in the Well Table View.

This fit to the ladder peak data can be viewed by selecting Standard Curve from the Analysis menu. After sample peaks have been sized, the system peaks are identified and excluded based on their size. Any peak of size greater than the lower marker but less than the Min. Sample Size specified in the Assay Analysis Window is labeled a system peak and excluded from concentration and purity analysis.

To determine sample peak concentration, the peak areas are first corrected to compensate for the fact that the fluorescence intensities are sampled at a constant time interval so slower moving proteins spend more time under the detector than fast moving proteins. The peak concentration is then calculated using the ladder peak areas and concentration for the ladder supplied in the Assay Analysis Window. The concentration is adjusted for the differing dilution ratios of sample and ladder.
To quantitize the sample peak concentration based on a different standard, the new standard must be added into each sample well at a known concentration. The analysis settings provide a Sample Peak Quantitation option using the peak area and concentration of the User Standard instead of the ladder concentrations.

**Protein Charge Variant Assay**

Capillary Zone Electrophoresis (CZE) is an electrophoretic separation technique used to evaluate the charge heterogeneity of proteins in a sample. The LabChip GXII performs a microfluidic adaptation of this technique for the Protein Charge Variant Assay. For Protein Charge Variant assays, the separation channel does not contain a polymer gel because the analytes are not separated by size.

Protein Charge Variant assays separate analytes based on differences in their net charge: molecules with a higher net charge migrate faster than those with a lower net charge. The relative difference in migration speeds (and therefore the resolution) between molecules of different pI is higher when the pH of the running buffer is closer to the pIs of the molecules.

For the HT Protein Charge Variant assay, the pH of the running buffer is less than the pIs of the variants, so molecules have a net positive charge. Variants that are more basic (have a higher pI) than others appear earlier in electropherogram. The software can be used to track expected variants, based on migration time, and to determine the relative amount of each variant, based on peak area.

Protein Charge Variant assays do not use ladders or markers to align the data. The size of a peak is not calculated, only the % Rel amount of each peak. Protein Charge Variant assays and data files do not include any ladder or marker parameters or options.
RNA Assay Analysis

RNA analysis initially progresses similarly to DNA analysis except that the baseline for RNA peaks is calculated using a spline-fit, much like the baseline used for the Baseline Subtraction option. However, this computed fit is not subtracted from the data; instead it is used to determine the peak height and to limit the peak extends.

The RNA ladder is similar to the DNA ladder but does not contain an upper marker. RNA sample data is aligned with the lower maker and then the sample peaks are sized using point-to-point interpolation between ladder peaks. The most prominent peaks found within predefined size windows are identified as ribosomal rRNA genes 5S, 18S and 28S (for eukaryote RNA), 16S and 23S (for prokaryote RNA).

For the purpose of quantitizing the full RNA content in the sample, a straight-line baseline is drawn across the bottom of the sample by finding the local averages about its endpoint. The area baseline endpoints can be moved on the Graph View after the “Show Peak Baselines” option is selected in the Graph View Properties. Trapezoidal integration from the straight-line baseline to the data signal is used to calculate the total RNA area. Integration is performed from the end of the lower marker to the endpoint of the area baseline. The range from the end of the 5S to the start of the 18S peak is termed the Fast Area. This area is calculated in the same way as the total RNA area.

For the purpose of quantitizing the rRNA peaks, a two-point baseline is drawn across the bottom of each peak identified as rRNA and the area is computed. These areas and rRNA peak heights and some relevant ratios are available for display in the Well Table View. A combination of the quantities is used to assess the quality of the RNA sample.
RNA Degrade Factor

This value quantifies the degradation of the ribosomal peaks, which typically leads to an increase in the fast area region between the 5S and the 16S (prokaryote) or 18S (eukaryote) ribosomal peaks. The quantity is computed as follows:

For prokaryote:

\[ 200 \times \text{Fast Area} / (\text{Fast Area Time Span}) / (\text{Height of 16S} + \text{Height of 23S}) \]

For eukaryote:

\[ 200 \times \text{Fast Area} / (\text{Fast Area Time Span}) / (\text{Height of 18S} + \text{Height of 28S}) \]

As the sample RNA degradation increases, this factor will increase. A value below 10 is obtained with high quality RNA but the user should determine their own threshold for discriminating between good and bad RNA. This quantity can be viewed and reported in the Well Table View.
Rolling Ball Baseline Curve Example

The figures below show the effect of changing the size of the ball when using the Rolling Ball Baseline Curve.

**Figure 145** shows a baseline (the light blue line) generated by a ball with settings of Time Diameter = 5 sec and Signal Diameter = 100 RFU.

**Figure 146 on page 323** shows a baseline (the light blue line) generated by a ball with settings of Time Diameter = 10 sec and Signal Diameter = 200 RFU. The baseline curve does not follow the signal as closely because the ball is larger. Increasing the ball size generates a smoother baseline.

Either ball dimension can be used to increase the smoothness of the curve, but increasing the Time Diameter increases the computation time required to compute the curve, while increasing the RFU Diameter does not.
Run Button

To begin running an assay, click the Run button located at the top left of the LabChip GX Main Window. The Start Run Window opens to select the assay, wells, data file name, etc. If the chip has not been primed yet, primes the chip before starting the run.

![Run Button](image)

After the run has begun, this button changes to Stop. See “Stopping a Run” on page 31.

**NOTE**

The Run button does not display if the software was installed in Reviewer mode.
Slope Threshold

The **Slope Threshold** setting represents the amount of change in response over time required to differentiate between a peak and baseline noise. Changing this setting may cause certain peaks that were previously detected to be ignored or to interpret noise as peaks. For details, see “Understanding Peak Finding” on page 108.

The **Slope Threshold** setting can be changed in the Peak Find Tab.

Smear

Specifies a size range in which to detect the region of the fluorescence signal instead of specifying a specific size for a peak. Use a smear to detect a broad mix of molecules of similar but distinct sizes in a sample. The concentration or fractional presence within a specified range of molecule sizes is measured. Specify the Start Size and End Size of a smear in the Assay Analysis Window on the Smear Analysis Tab.

The Smear Properties can be viewed in table form in the Well Table View. To view the Smear Properties in the table, add the desired property to the Well Table View. The properties extracted from the smear match those of a peak, having start and end points, area, concentration, etc. % Purity is the ratio of smear concentration to total sample peak concentration, exclusive of markers, system peaks, and excluded peaks. Excluded peaks are not excluded from analysis calculations such as concentration or area within the smear region, so the limits must avoid excluded peaks. An additional Peak Count property is available for smears. Peak Count is the number of non-excluded sample peaks in the region, where the center of the peak is inside the smear limits.

In the Graph View, the smear regions display with the start and end points drawn at the base of the smear in the chosen color and the trace highlighted with the smear color. Override the smear baseline by dragging with the mouse in the Graph view. The baseline start and end points can be adjusted in the graph to change the height of the baseline or the size range of the smear. Smears can overlap to include the same region in multiple smears.

In the Gel View, the smear region is shown on the gel as a colorized region. The color is a transparent version of the color selected for the region, so that the fluorescence intensity shows through.
Standard Curve Window

The Standard Curve window shows the Standard curve used for the selected plate data. Each window displays the following menus:

**View menu** - Select or clear the ladders to display in the window.

**Copy menu** - Copies the current view to the clipboard.

**Print menu** - Displays the Print Preview or prints the Standard Curve.

**DNA Assays**

When you choose **Standard Curve** from the **Analysis** menu for a DNA assay, a window similar to Figure 147 opens. The standard curve is drawn from the values obtained for the DNA ladder. It is a plot of the size of the ladder peaks vs. time with a point-to-point fit. For each sample peak, the apex is interpolated from the Standard Curve to determine the peak size in bp (base pairs).

![Figure 147. DNA Assay Standard Curve](image)

For more information about the use of the standard curve during analysis, see "How the Software Analyzes DNA Data" on page 43.

**Protein Assays**

When you choose **Standard Curve** from the **Analysis** menu for a Protein assay, a window similar to Figure 148 opens. The standard curve is drawn from the values obtained for the protein ladder. It is a plot of the size of the ladder peaks vs. time with a Log fit. For each sample peak, the apex is interpolated from the Standard Curve to determine the peak size in kDa (kiloDaltons).
RNA Assays

When you choose Standard Curve from the Analysis menu for an RNA assay, a window similar to Figure 149 opens. The standard curve is drawn from the values obtained for the RNA ladder. It is a plot of the size of the ladder peaks vs. time with a point-to-point fit. For each sample peak, the apex is interpolated from the Standard Curve to determine the peak size in nt.

For more information about the use of the standard curve during analysis, see “How the Software Analyzes RNA Data” on page 49.
gDNA Assays

When you choose **Standard Curve** from the **Analysis** menu for a gDNA assay, a window similar to Figure 150 opens. The standard curve is drawn from the values obtained for the gDNA ladder. It is a plot of the size of the ladder peaks vs. time with a point-to-point fit. For each sample peak, the apex is interpolated from the Standard Curve to determine the peak size in kb (kilo base pairs).

![Figure 150. gDNA Assay Standard Curve](image)

**Start Point**

The peak find algorithm analyzes the data from time zero looking for a slope greater than the **Slope Threshold**. The point where the slope is greater than the slope threshold specified in the **Peak Find Tab** is marked as the start point of a peak.

**Start Time**

This setting determines the time after the start of a run when peaks will be detected. Any peaks appearing before this time are ignored.
**Titer**

Allows the use of a standard with a known concentration to be used as a calibration standard instead of using a ladder. The well location and known concentrations of the standard are specified in the Assay Analysis Window on the Titer Tab.

The Titer Standard Curve used for calibration is normalized against the lower marker (protein and RNA) or upper marker (DNA) to adjust for slight variations in each well. A normalization standard can be added to each well to be used only for normalization. (Normalization standards must be the same concentration in each well.) Specify the normalization standard in the Assay Analysis Window on the Advanced Tab. Titers can also be imported from another plate if the Normalization Standard is the same. If Sample Peak is selected, the Sample Peaks must be the same size.

The Concentration to Favor in Fit adjustment on the Titer tab enables you to choose whether to weight either the higher or lower concentrations more heavily when calculating the Titer Standard Curve.

**Tool Tip**

A small box containing text that describes the item indicated by the mouse pointer. To view a Tool Tip, position the cursor over an item on the window. Leave the cursor stationary for a moment and a Tool Tip (if one exists for that item) displays.

**Upper Marker**

An internal standard that is added to a DNA sample in a well to assist in determining size and concentration of the sample. The marker is the same as the last peak in the DNA ladder.

**Workspace**

Use a workspace file to view the plate data from a run. Multiple plate data files can be opened in the same workspace to enable comparison between data from different plates or different runs.

Each workspace can contain multiple Collections for viewing the same data in different layouts.
A Workspace file includes:
- the links to the plate data files in each collection
- the selected wells and arrangement of the wells in the views
- the layout selected for each collection

**Zero Baseline**

Selecting this setting in the Peak Find Tab offsets the graphs shown for the individual wells but does not affect analysis. The mean of 100 points before the baseline time (derived when calculating well noise) is used as the zero baseline value.

All electropherograms produced with the instrument show some amount of background fluorescence. By default, the LabChip GX software enables the Zero Baseline function. To change the Baseline Algorithm, select None, Zero Baseline, or Baseline Subtraction on the Peak Find Tab.

![Figure 151. Zero Baseline On](image1)

![Figure 152. Zero Baseline Off](image2)
PerkinElmer Product Warranty

PerkinElmer Health Sciences, Inc. ("PerkinElmer") provides a limited warranty to the original purchaser of each product (each, a "Warranty"), as set forth below. Please note that extended warranty and support plans are available for purchase, under separate agreement. Please contact PerkinElmer customer support for more information.

I. LIMITED WARRANTY.

LabChip GX/GX II Instrument Warranty: PerkinElmer warrants to the original purchaser ("Customer") that at the time of shipment to the Customer, the LabChip GX/LabChip GX II instrument ("Instrument") is free from defects in materials and workmanship, and shall substantially conform to its published specifications.

Microfluidic Chips Warranty: PerkinElmer warrants to Customer that at the time of shipment to the Customer, the microfluidic chips (each, a "Chip") are free from defects in material and workmanship, and shall substantially conform to the Chips published specifications. A "defect" for purposes of this Chip Warranty is defined as any failure that occurs during analysis of the first one hundred (100) samples being run on a Chip. Customer shall only use solvents and/or reagents supplied by PerkinElmer or expressly recommended by PerkinElmer in conjunction with the use of the Chip.

Software and Firmware: PerkinElmer warrants that such software and firmware will conform to PerkinElmer’s program manuals current at the time of shipment to Customer when properly installed on the processor and properly used in accordance with the software’s end user license agreement; provided, however, that PerkinElmer does not warrant that the operation of the processor or software or firmware will be uninterrupted or error-free.

EXCEPT IN THE CASE OF AN AUTHORIZED DISTRIBUTOR OF PERKINELMER, AUTHORIZED IN WRITING BY PERKINELMER TO EXTEND THIS WARRANTY TO DISTRIBUTOR’S CUSTOMERS, THE WARRANTY HEREIN APPLIES ONLY TO THE CUSTOMER AND MAY NOT BE ASSIGNED, SOLD OR OTHERWISE TRANSFERRED TO ANY THIRD PARTY.

II. WARRANTY PERIOD.

Unless otherwise stated in a purchase order, quotation or other purchase and sale documentation agreed to in writing by PerkinElmer, the warranty period begins upon the date of shipment and shall continue for a period of (i) one (1) year for an Instrument; (ii) sixty (60) days for Chips; and (iii) ninety (90) days for software and firmware (each, a “Warranty Period”). Customer must notify PerkinElmer of any Warranty claim prior to expiration of the Warranty Period. Notwithstanding anything to the contrary contained herein, the Warranty Period for data processing equipment, including data storage devices, processors, printers, terminals, communication interfaces, tape drives and all similar devices, is in all cases limited to ninety (90) days from the date of shipment to Customer.

III. EXCLUSIONS, LIMITATIONS AND CUSTOMER RESPONSIBILITY.

Instrument Exclusions: It is recognized that some parts by their nature may not function for the Warranty Period applicable to the Instrument. Therefore, the following are expressly excluded from the Warranty described in Section I above:

- chromatography columns, filaments, energy sources, lamps, power amplifier tubes, graphite tubes, sample cell holders, burner and furnace chambers, nebulizers, and other similar parts referenced in the Instrument's applicable operating manual;
- equipment or accessories which are identified on applicable price lists, quotations, special promotional materials for which this limited Warranty may be further limited. Included within this category are items produced by third party manufacturers (as to which PerkinElmer passes to Customer the warranty it has been provided by the manufacturer) and items which are sold at specially reduced prices with reduced warranty protection (in some cases, extended warranty protection may be available at an increased price); and
- loss, damage, or defects resulting from transportation to the Customer's facility, improper or inadequate maintenance by Customer, Customer-supplied software or interfacing, unauthorized modification or misuse, operation outside of the environmental specifications for the Instrument or improper site preparation or maintenance.

Chip Exclusions: The Chip Warranty described in Section I above does not extend to any Chip which has been:

- the subject of an accident, misuse, or neglect;
- modified by a party other than PerkinElmer;
- used in a manner not in accordance with the instructions contained in the product's user manual;
- used with solvents and/or reagents not supplied by PerkinElmer and/or recommended in writing by PerkinElmer; and/or
- used for an assay or application which has not been approved by PerkinElmer.

Customer Responsibilities: In order for a product to be covered under any Warranty described herein, Customer must comply with the following terms:

- The product must be used under normal installation and application conditions as described in the applicable product's user manual
- The product must be maintained as described in the applicable user manual.
• When PerkinElmer provides telephone, fax, or email support, Customer is responsible for completing any necessary documentation required by PerkinElmer for the provision of any services.
• Customer must perform the appropriate level of revalidation required as a result of any maintenance or service provided.
• For on-site services, Customer must ensure that the site where the product is located is safe for PerkinElmer personnel to enter, prior to PerkinElmer performing any services under this Warranty. PerkinElmer reserves the right to refuse to service the products covered under this warranty, if the Customer's site where the product is located is hazardous to the health and safety of PerkinElmer personnel.

Limitations:
• The Warranty only covers products manufactured by PerkinElmer. Any warranties that may be applicable to third party components shall be provided by the respective manufacturers or suppliers of such third party components, and PerkinElmer shall use reasonable efforts to assist the customer in securing the benefits of any such warranties.
• Damage to limited-life parts caused by insufficient maintenance or cleaning practices or unauthorized applications are not covered under Warranty.
• Failure of the Customer to comply with the aforementioned “Customer Responsibilities” will void any applicable Warranty.
• Any hardware or software covered under Warranty that is altered will void the Warranty, unless such alteration is performed by PerkinElmer or an approved PerkinElmer vendor.
• Any product that has been subject to misuse, accident, negligence or improper transportation, handling, installation, storage, use, or maintenance shall not be covered under any applicable Warranty.
• Many PerkinElmer products require the use of PerkinElmer Automation Certified Disposables for proper operation. These may include, but are not limited to: pipet tips, seals, labels and filters. Use of a PerkinElmer product with any disposables other than the specified PerkinElmer Automation Certified Disposables will void any applicable Warranty.
• All software products are subject to the applicable software end user license agreement included with the software product.
• Any Warranty provided herein shall apply only to products within the country of original delivery. Products transferred outside the country of original delivery, either by PerkinElmer at the direction of Customer or by Customer’s actions subsequent to delivery, may be subject to additional charges prior to any warranty repair or replacement of such products based on the actual location of such products and PerkinElmer's warranty and/or service surcharges for such location(s).

IV. REMEDIES, DISCLAIMER AND LIMITATIONS OF LIABILITY.

Warranty Disclaimer: TO THE MAXIMUM EXTENT PERMISSIBLE UNDER APPLICABLE LAW, PERKINELMER EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES OF ANY KIND, EXPRESS, IMPLIED OR STATUTORY, INCLUDING WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT OF THIRD PARTY RIGHTS, AND ANY IMPLIED WARRANTIES ARISING FROM COURSE OF DEALING OR COURSE OF PERFORMANCE. PERKINELMER DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN ANY SOFTWARE WILL MEET THE CUSTOMER’S REQUIREMENTS, OR THAT THE OPERATION OF ANY SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN ANY SOFTWARE WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY PERKINELMER SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO THE CUSTOMER. THE TERMS OF THIS DISCLAIMER DO NOT AFFECT OR PREJUDICE THE STATUTORY RIGHTS OF A CONSUMER ACQUIRING PERKINELMER PRODUCTS OTHERWISE THAN IN THE ORDINARY COURSE OF BUSINESS, NEITHER DO THEY LIMIT OR EXCLUDE ANY LIABILITY FOR DEATH OR PERSONAL INJURY CAUSED BY PERKINELMER'S NEGLIGENCE.

Remedies: As Customer’s sole and exclusive remedy under this Warranty, PerkinElmer agrees either to repair or replace, at PerkinElmer’s sole option, any part or parts of such product which, under proper and normal conditions of use, prove(s) to be defective within the applicable Warranty Period. Alternatively, PerkinElmer may at any time, in its sole discretion, elect to discharge its warranty obligation hereunder by accepting the return of any defective product pursuant to the terms set forth herein and refunding the purchase price paid by Customer. THE REMEDIES PROVIDED HEREIN ARE CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES. PERKINELMER NEITHER ASSUMES NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR IT ANY OTHER LIABILITY IN CONNECTION WITH THE DESIGN, MANUFACTURE, SALE, DELIVERY, INSTALLATION, SERVICE OR USE OF THE PRODUCTS.

Limitations of Liability: REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE OR OTHERWISE, IN NO EVENT WILL PERKINELMER, ITS AFFILIATES, ITS LICENSORS OR SUPPLIERS BE LIABLE TO CUSTOMER OR ANY THIRD PARTY UNDER ANY LEGAL THEORY OF LIABILITY FOR ANY LOSS OF PROFITS OR REVENUE, LOSS OR INACCURACY OF DATA, INTERRUPTION OF BUSINESS, COST OF SUBSTITUTION, INTERRUPTION, DELAY, LOSS RESULTING FROM SYSTEM OR SYSTEM SERVICE FAILURE, BREACHES IN SYSTEM SECURITY, OR ANY OTHER INDIRECT, SPECIAL, CONSEQUENTIAL, EXEMPLARY OR INCIDENTAL DAMAGES OF ANY NATURE, EVEN IF PERKINELMER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND WHETHER OR NOT SUCH DAMAGES ARE FORESEEABLE. IN NO EVENT WILL THE LIABILITY OF PERKINELMER, ITS AFFILIATES, ITS LICENSORS OR SUPPLIERS EXCEED THE GREATER OF ONE U.S. DOLLAR OR THE PURCHASE PRICE RECEIVED BY PERKINELMER FROM CUSTOMER FOR THE PRODUCTS. Some jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, so the above exclusion may not apply.
PerkinElmer Software License Agreement

***IMPORTANT INFORMATION PLEASE READ CAREFULLY***

This Software contains computer programs and other proprietary material and information, the use of which is subject to and expressly conditioned upon acceptance of this License Agreement (the "Agreement"). This Agreement is a legally binding agreement between you (meaning the individual person or the entity that the individual represents that has obtained the Software for its internal productive use and not for outright resale) (the "Licensee") and PerkinElmer (which means (i) PerkinElmer Health Sciences, Inc., if the Licensee is located in the United States; (ii) the local PerkinElmer, Inc. sales subsidiary, if the Licensee is located outside the United States and in a country in which PerkinElmer, Inc. has a local sales subsidiary; and/or (iii) PerkinElmer Cellular Technologies Germany GmbH, if the Licensee is located outside the United States and in a country in which PerkinElmer, Inc. does not have a local sales subsidiary), with offices at 940 Winter Street, Waltham, Massachusetts 02451. Unless PerkinElmer agrees otherwise in writing, this Agreement governs Licensee’s use of the Software, except to the extent all or any portion of the Software is governed by a third party licensor's terms and conditions.

BY DOWNLOADING, INSTALLING, OR USING THE SOFTWARE, OR BY OPENING THE SOFTWARE PACKAGE OR ISSUING A PURCHASE ORDER FOR A LICENSE TO USE THE SOFTWARE, AS THE CASE MAY BE, YOU ARE (I) REPRESENTING TO PERKINELMER THAT YOU ARE AUTHORIZED TO BIND THE LICENSEE; (II) AGREEING ON BEHALF OF THE LICENSEE THAT THE TERMS OF THIS AGREEMENT SHALL GOVERN THE RELATIONSHIP OF THE PARTIES WITH REGARD TO THE SUBJECT MATTER IN THIS AGREEMENT AND ARE WAIVING ANY RIGHTS, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, TO ANY CLAIM ANYWHERE IN THE WORLD CONCERNING THE ENFORCEABILITY OR VALIDITY OF THIS AGREEMENT; AND (III) AGREEING THAT THE SOFTWARE IS ACCEPTED AS DELIVERED. IF YOU DO NOT HAVE AUTHORITY TO AGREE TO OR DO NOT ACCEPT THE TERMS OF THIS AGREEMENT ON BEHALF OF THE LICENSEE, PERKINELMER WILL NOT AND DOES NOT LICENSE THE SOFTWARE TO THE LICENSEE AND YOU MUST IMMEDIATELY RETURN THE UNOPENED SOFTWARE PACKAGE WITHIN FORTY-EIGHT (48) HOURS OF RECEIPT FOR A REFUND, CEASE ANY FURTHER ATTEMPT TO INSTALL, DOWNLOAD OR USE THIS SOFTWARE FOR ANY PURPOSE, AND REMOVE ANY PARTIAL OR FULL COPIES MADE FROM THIS SOFTWARE.

THIS IS A LICENSE AGREEMENT AND NOT AN AGREEMENT FOR SALE.

1 Definitions:
   a “Affiliates” means, with respect to a party to this Agreement, any Person that controls, is controlled by, or is under common control with that party. For the purpose of this definition, “control” shall mean, direct or indirect, ownership of fifty percent (50%) or more of the shares of stock entitled to vote for the election of directors, in the case of a corporation, or fifty percent (50%) or more of the equity interest in the case of any other type of legal entity, status as a general partner in any partnership, or any other arrangement whereby the entity or person controls or has the right to control the board of directors or equivalent governing body of a corporation or other entity, or the ability to cause the direction of the management or policies of a corporation or other entity.
   b “Documentation” means user manuals, technical manuals and any other materials provided by PerkinElmer, in printed, electronic or other form, that describe the installation, operation, use or technical specifications of the Software.
   c “Person” means an individual, corporation, partnership, joint venture, limited liability company, governmental authority, unincorporated organization, trust, association or other entity.
   d “Software” means the software program(s) associated with the LabChip GX and/or LabChip GX II products for which Licensee is obtaining a license, as may be set forth in any purchase order, and also includes any associated hardware. Software also includes any updates and/or purchased upgrades to the Software that Licensee may receive and/or purchase from time to time under a separate services or support contract.
   e “Third Party” means any Person other than PerkinElmer and Licensee.

2 License Grant and Scope. Subject to and conditioned upon Licensee’s payment of any fees due for the license granted hereunder and Licensee’s strict compliance with all terms and conditions set forth in this Agreement, PerkinElmer hereby grants to Licensee a non-exclusive, non-transferable, non-sublicensable, limited license during the Term to use, the Software, solely as set forth in this Section 2 and subject to all conditions and limitations set forth in Section 3 or elsewhere in this Agreement. This license grants Licensee the right to:
   a download, copy, and install, in accordance with the Documentation, the Software on a single computer owned or leased, and controlled by, Licensee. In addition to the foregoing, Licensee has the right to make one (1) copy of the Software solely for archival and backup purposes; provided that Licensee shall not, and shall not allow any Person to, install or use any such copy other than if and for so long as the copy installed in accordance with the preceding sentence is inoperable and, provided, further, that Licensee uninstalls and otherwise deletes such inoperable copy. All copies of the Software made by the Licensee: (i) will be the exclusive property of PerkinElmer; (ii) will be subject to the terms and conditions of this Agreement; and (iii) must include all trademark, copyright, patent and other intellectual property rights notices contained in the original;
   b use and run the Software, in executable code only, as properly installed in accordance with this Agreement and the Documentation; and
3 Restrictions. Licensee shall not, and shall require its employees and/or other authorized users not to, directly or indirectly:

a use (including make any copies of) the Software and/or Documentation beyond the scope of the license granted in Section 2;

b modify, translate, adapt or otherwise create derivative works or improvements, whether or not patentable, of the Software and/or Documentation or any part thereof;

c combine the Software or any part thereof with, or incorporate the Software or any part thereof in, any other programs;

d reverse engineer, disassemble, decompile, decode or otherwise attempt to derive or gain access to the source code of the Software or any part thereof;

e remove, delete, alter or obscure any trademarks or any copyright, trademark, patent or other intellectual property or proprietary rights notices from the Software or Documentation, including any copy thereof;

f except as expressly set forth in Section 2(a) and Section 2(c), copy the Software and/or Documentation, in whole or in part;

g rent, lease, lend, sell, resell, sublicense, assign, distribute, publish, transfer or otherwise make available the Software or any features or functionality of the Software, to any Third Party for any reason, whether or not over a network and whether or not on a hosted basis, including in connection with the internet, web hosting, wide area network (WAN), virtual private network (VPN), virtualization, time-sharing, service bureau, software as a service, cloud or other technology or service;

h use the Software in, or in association with, the design, construction, maintenance or operation of any hazardous environments or systems, including: (i) power generation systems; (ii) aircraft navigation or communication systems, air traffic control systems or any other transport management systems; (iii) safety-critical applications, including medical or life-support systems, vehicle operation applications or any police, fire or other safety response systems; and (iv) military or aerospace applications, weapons systems or environments;

i use the Software in violation of any federal, state or local law, regulation or rule;

j use the Software for purposes of competitive analysis of the Software, the development of a competing software product or service;

k install or use the Software on more than one computer simultaneously without the purchase of additional licenses and/or the express written consent of an authorized PerkinElmer representative; and/or

l use the Software to provide outsourcing, service bureau, online services or trainings to a Third Party, without the express written consent of an authorized officer of PerkinElmer.

4 Open Source. The Software may contain or be provided with open source libraries, components, utilities and other open source software (collectively, "Open Source"), which Open Source may have applicable license terms as identified by PerkinElmer upon written request, or as otherwise may be provided with the applicable Documentation. Notwithstanding anything to the contrary herein, use of the Open Source shall be subject to the applicable Open Source license terms and conditions to the extent required by the applicable licensor (which terms shall not restrict the license rights granted to Licensee hereunder but may contain additional rights) and such Open Source license terms shall only apply to such Open Source component and not the entire Software. Any breach by Licensee of any Open Source license shall also be deemed a breach of this Agreement. In the event of a conflict between the Open Source license and this Agreement, the Open Source license will prevail solely with respect to the Open Source component.

5 Responsibility for Use of Software. Licensee is responsible and liable for all uses of the Software through access thereto provided by Licensee, directly or indirectly. Specifically, and without limiting the generality of the foregoing, Licensee is responsible and liable for all actions and failures to take required actions with respect to the Software by its employees or by any other Person to whom Licensee may provide access to or use of the Software, whether such access or use is permitted by or in violation of this Agreement.

6 Security Mechanisms. PerkinElmer and its Affiliates endeavor to take all legal actions available to it to eliminate piracy of its software products. As such, the Software may include a security mechanism which collects and transmits usage data for the purpose of detecting the installation or use of illegal copies of the Software. Data collected will not include any Licensee data created with the Software. Licensee consents to such detection and collection of data, as well as its transmission and use. PerkinElmer also reserves the right to use a hardware lock device, license administration software, and/or a license authorization key to control access to the Software. Licensee shall not take any steps to avoid, remove, disable, circumvent, defeat, or otherwise create or implement any workaround to any such measures. Use of the Software by Licensee without the required lock device or authorization key provided by PerkinElmer is strictly prohibited.
Compliance. PerkinElmer may, in PerkinElmer's sole discretion, audit the Licensee's use of the Software under this Agreement at any time during the Term to ensure Licensee's compliance with this Agreement, provided that (i) any such audit shall be conducted on not less than ten (10) business days' prior notice to Licensee, and (ii) no more than one audit may be conducted in any twelve (12) month period except for good cause shown. PerkinElmer also may, in its sole discretion, audit Licensee's systems within twelve (12) months after the end of the Term to ensure Licensee has ceased use of the Software and removed all copies of the Software from such systems as required hereunder. Licensee shall reasonably cooperate with PerkinElmer's personnel conducting such audits and provide all reasonable access requested by the PerkinElmer to records, systems, equipment, information and personnel, including serial numbers and related information. PerkinElmer shall only examine information directly related to the Licensee's use of the Software. PerkinElmer may conduct audits only during Licensee's normal business hours and in a manner that does not unreasonably interfere with the Licensee's business operations.

Ownership. The Software is licensed, not sold, to Licensee subject to the terms of this Agreement. PerkinElmer reserves all rights not expressly granted to Licensee. Licensee owns the media, if any, on which the Software is recorded, but PerkinElmer retains ownership of all copies of the Software itself. Licensee acknowledges that the Software contains and embeds valuable, unpublished information that is proprietary and confidential to PerkinElmer and its licensors and suppliers. Licensee agrees to keep all such information confidential. This does not preclude Licensee from using information Licensee lawfully obtain from another source.

Term. This Agreement is effective on the date Licensee accepts this Agreement and/or downloads or installs the Software, whichever is earlier, and will continue until terminated. This Agreement and the licenses granted hereunder will terminate immediately without notice to Licensee if (i) Licensee materially breaches any term or condition of this Agreement; or (ii) if Licensee files, or has filed against it, a petition for voluntary or involuntary bankruptcy or pursuant to any other insolvency law, makes or seeks to make a general assignment for the benefit of its creditors or applies for, or consents to, the appointment of a trustee, receiver or custodian for a substantial part of its property. Licensee also may terminate this Agreement, at any time, by destroying the Software and all copies thereof. Upon any termination, the license granted to Licensee shall immediately cease and Licensee agrees to discontinue all use of the Software, promptly erase all copies of the Software and portions thereof from Licensee's computer storage or any other media, and return or destroy all copies of the Software. Termination is not an exclusive remedy.

Limited Warranty. PerkinElmer's sole warranty with respect to the Software is that for a period of ninety (90) days from the date of receipt, the Software will substantially contain the functionality described in the published specifications, and when properly installed on a computer meeting the specifications set forth in, and operated in accordance with, the Documentation, will substantially perform in accordance therewith. THE FOREGOING WARRANTY DOES NOT APPLY, AND PERKINELMER STRICTLY DISCLAIMS ALL WARRANTIES, WITH RESPECT TO ANY THIRD PARTY MATERIALS.

Warranty Disclaimer. TO THE MAXIMUM EXTENT PERMISSIBLE UNDER APPLICABLE LAW, PERKINELMER EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES OF ANY KIND, EXPRESS, IMPLIED OR STATUTORY, INCLUDING WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR SATISFACTORY QUALITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT OF THIRD PARTY RIGHTS, AND ANY IMPLIED WARRANTIES ARISING FROM COURSE OF DEALING OR COURSE OF PERFORMANCE. PERKINELMER DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE LICENSEE'S REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, PERKINELMER DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY PERKINELMER SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO THE LICENSEE. THE TERMS OF THIS DISCLAIMER DO NOT AFFECT OR PREJUDICE THE STATUTORY RIGHTS OF A CONSUMER ACQUIRING PERKINELMER PRODUCTS OTHERWISE THAN IN THE ORDINARY COURSE OF BUSINESS, NEITHER DO THEY LIMIT OR EXCLUDE ANY LIABILITY FOR DEATH OR PERSONAL INJURY CAUSED BY PERKINELMER'S NEGLIGENCE.

Limitation of Liabilities. PerkinElmer's and its Affiliates' entire liability and Licensee's sole and exclusive remedy shall be, at PerkinElmer's sole discretion, either (A) the return of any license fee paid for the Software, or (B) correction or replacement of the Software that does not meet the terms of this limited warranty and that is returned to PerkinElmer with a copy of the purchase receipt. REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREBIN FAILS OF ITS ESSENTIAL PURPOSE OR OTHERWISE, IN NO EVENT WILL PERKINELMER, ITS AFFILIATES, ITS LICENSORS OR SUPPLIERS BE LIABLE TO LICENSEE OR ANY THIRD PARTY UNDER ANY LEGAL THEORY OF LIABILITY FOR ANY LOSS OF PROFITS OR REVENUE, LOSS OR INACCURACY OF DATA, INTERRUPTION OF BUSINESS, COST OF SUBSTITUTION, INTERRUPTION, DELAY, LOSS RESULTING FROM SYSTEM OR SYSTEM SERVICE FAILURE, BREACHES IN SYSTEM SECURITY, OR ANY OTHER INDIRECT, SPECIAL, CONSEQUENTIAL, EXEMPLARY OR INCIDENTAL DAMAGES OF ANY NATURE ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, EVEN IF PERKINELMER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND WHETHER OR NOT SUCH DAMAGES ARE FORESEEABLE. IN NO EVENT WILL THE LIABILITY OF PERKINELMER, ITS AFFILIATES, ITS LICENSORS OR SUPPLIERS EXCEED THE GREATER OF ONE U.S. DOLLAR OR THE LICENSE FEE RECEIVED BY PERKINELMER FROM LICENSEE FOR THE SOFTWARE. Some jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, so the above exclusion may not apply.
13 U.S. Government End Users. The Software is commercial computer software, as such term is defined in 48 C.F.R. §2.101. Accordingly, if the Licensee is the US Government or any contractor therefor, Licensee shall receive only those rights with respect to the Software and Documentation as are granted to all other end users under license, in accordance with (a) 48 C.F.R. §227.7201 through 48 C.F.R. §227.7204, with respect to the Department of Defense and their contractors, or (b) 48 C.F.R. §12.212, with respect to all other US Government licensees and their contractors. If this Agreement fails to meet the Government's minimum needs or is inconsistent in any respect with Federal procurement law, the Government agrees to return this software, unused, to PerkinElmer.

14 Export Law. The Software is subject to U.S. export control laws and may be subject to export or import regulations in other countries. Licensee agrees to strictly comply with all such laws and regulations and acknowledge that Licensee has the responsibility to obtain any required export, re-export, or import licenses. Licensee agree to indemnify and hold PerkinElmer harmless from all claims, losses, liabilities, damages, fines, penalties, costs and expenses relating to Licensee's breach of these obligations.

15 Trademark Acknowledgement. The PerkinElmer logo is a registered trademark of PerkinElmer, Inc. PerkinElmer and LabChip are registered trademarks of PerkinElmer, Inc. and/or its Affiliates. All other Third Party brands, products, service names, trademarks, or registered service marks are used to identify the products or services of their respective owners, and are the property of their respective holders.

16 General.

   a This Agreement will be governed by the laws of the Commonwealth of Massachusetts, without giving effect to conflict of laws principles that require the application of the laws of any other jurisdiction. The UN Convention on Contracts for the International Sale of Goods will not apply to this Agreement. Licensee hereby irrevocably submits to the personal jurisdiction and venue of, and agrees to service of process issued or authorized by, state and federal courts with jurisdiction over Suffolk County, Massachusetts, and Licensee waives any objection thereto. The prevailing party in any action under this Agreement is entitled to receive its costs and expenses, including reasonable attorneys' fees, incurred in that action, in addition to any other relief it may receive.

   b If any term or provision of this Agreement is invalid, illegal or unenforceable in any jurisdiction, such invalidity, illegality or unenforceability shall not affect any other term or provision of this Agreement or invalidate or render unenforceable such term or provision in any other jurisdiction. This Agreement may only be amended, modified or supplemented by an agreement in writing signed by each party hereto. No waiver by any party of any of the provisions hereof shall be effective unless explicitly set forth in writing and signed by the party so waiving. Except as otherwise set forth in this Agreement, no failure to exercise, or delay in exercising, any right, remedy, power or privilege arising from this Agreement shall operate or be construed as a waiver thereof; nor shall any single or partial exercise of any right, remedy, power or privilege hereunder preclude any other or further exercise thereof or the exercise of any other right, remedy, power or privilege. Licensee may not assign or delegate this Agreement, nor any rights or duties hereunder, in whole or in part, without PerkinElmer's prior written approval, which may be withheld in its sole discretion, and any purported attempt to do so is void. Only a written amendment referencing this Agreement and executed and delivered by both parties can modify this Agreement.

   c PerkinElmer shall not be in default hereunder by reason of any failure or delay in the performance of its obligations hereunder where such failure or delay is due to strikes, labor disputes, civil disturbances, riot, rebellion, invasion, epidemic, hostilities, war, terrorist attack, embargo, natural disaster, acts of God, flood, fire, sabotage, fluctuations or non-availability of electrical power, heat, light, air conditioning or Licensee equipment, loss and destruction of property or any other circumstances or causes beyond PerkinElmer's reasonable control.

   d This Agreement and all other documents that are incorporated by reference herein, constitutes the sole and entire agreement between PerkinElmer and Licensee with respect to the subject matter contained herein, and supersedes all prior and contemporaneous understanding, agreements, representations and warranties, both written and oral, with respect to such subject matter. This Agreement shall be construed without regard to any presumption or rule requiring construction or interpretation against the party drafting an instrument or causing any instrument to be drafted.
Index

Numerics

21 CFR Part 11 option 114

A

Aborting a run 31
About LabChip GX Window 183
AC power cable 272
Accept setting permissions 118
Access Rights, changing 121
Account policies 123
Activating username 120
Active Data Tab 161
Add New Expected Peak Window 184
Add Plate Window 185
Adding a New Plate 38
Adding a new username 118
Adding a peak 74
Advanced Tab 205, 254
Assay Analysis Window 205
Start Run Window 254
AIA format 103, 105
Algorithm, Baseline 192
Align marker peaks 80
Alignment
  optics 273
turning on/off 80
using default ladder 79
Alignment Tab 188
Altitude 278
Analysis .72, 146, 308, 311, 317, 318, 320
Analysis menu 146
Analysis On/Off 146
Analysis parameters 72
Assay Analysis window 186
DNA 43
DNA assays 308
GX Touch 107
How the Software Analyzes Genomic DNA Data 58
How the Software Analyzes Glycan Data 54
How the Software Analyzes Protein Charge Variant Data 57
How the Software Analyzes RNA Data 49
identifying peaks 317
ladder 311
Protein assays 318
Protein data 45
RNA assays 320
turning on/off 80
viewing errors 92
Analysis Tab 189
Annotation
  Annotate expected peaks 164
text 164
Apex 303
Assay .19, 22, 84
Assay Analysis window 186
Assay file 303
Assay Information Tab 187
Assay User Guides 22
Assay Voltage 278
Class 187
Comments 187
Exporting an assay 84
Name 187
Principles 19
Saving an assay 84
Starting a Run 22
Title 187
Assay Analysis Window 186
Audit Trail .127
  export 129
  viewing 128
Audit Trail Export Window 209
Audit Trail Manage Columns Window 210
Audit Trail Window 208
Auto Export 29
Auto Export window 219

B

Backing up data files 59
Backup Server 133
  backing up to remote folder 135
  restoring from remote folder 136
  setting up 133
Barcode 278
  Barcode Engine 278
  Barcode reader 273
<table>
<thead>
<tr>
<th>Barcode Test</th>
<th>297</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label position</td>
<td>40</td>
</tr>
<tr>
<td>Supported Barcode Types</td>
<td>278</td>
</tr>
<tr>
<td>Baseline</td>
<td>49, 189, 192, 304, 316</td>
</tr>
<tr>
<td>adjusting peak</td>
<td>76</td>
</tr>
<tr>
<td>Algorithm</td>
<td>192</td>
</tr>
<tr>
<td>Analysis Tab</td>
<td>189</td>
</tr>
<tr>
<td>Plateau</td>
<td>192</td>
</tr>
<tr>
<td>Bracketed ladder</td>
<td>188</td>
</tr>
<tr>
<td>Bubble</td>
<td>305</td>
</tr>
<tr>
<td>Buffer vial</td>
<td>277</td>
</tr>
<tr>
<td>Cables</td>
<td>272</td>
</tr>
<tr>
<td>Calibrating the optics</td>
<td>41</td>
</tr>
<tr>
<td>Calibration limits</td>
<td>41</td>
</tr>
<tr>
<td>Calibration Optical</td>
<td>315</td>
</tr>
<tr>
<td>Calibration Point</td>
<td>205</td>
</tr>
<tr>
<td>Calibration standard</td>
<td>202</td>
</tr>
<tr>
<td>Cannot save a file</td>
<td>298</td>
</tr>
<tr>
<td>Cartridge</td>
<td>275</td>
</tr>
<tr>
<td>CDR</td>
<td>130</td>
</tr>
<tr>
<td>security suggestions</td>
<td>130</td>
</tr>
<tr>
<td>CDR Folder</td>
<td>214</td>
</tr>
<tr>
<td>CDR Manager Window</td>
<td>211</td>
</tr>
<tr>
<td>CDR Server Utility Window</td>
<td>213</td>
</tr>
<tr>
<td>CDR Utility Window</td>
<td>214</td>
</tr>
<tr>
<td>Center Calibration Point</td>
<td>205</td>
</tr>
<tr>
<td>Center point</td>
<td>303</td>
</tr>
<tr>
<td>Change Password Window</td>
<td>216</td>
</tr>
<tr>
<td>Changing access rights</td>
<td>121</td>
</tr>
<tr>
<td>Changing sample name</td>
<td>25, 63</td>
</tr>
<tr>
<td>Changing the View of the Results</td>
<td>85</td>
</tr>
<tr>
<td>Changing user information</td>
<td>119</td>
</tr>
<tr>
<td>Chemical Safety</td>
<td>8</td>
</tr>
<tr>
<td>Chip</td>
<td>274</td>
</tr>
<tr>
<td>priming</td>
<td>25</td>
</tr>
<tr>
<td>Chip button</td>
<td>271</td>
</tr>
<tr>
<td>Chip cartridge</td>
<td>275</td>
</tr>
<tr>
<td>cleaning the chip cartridge</td>
<td>281</td>
</tr>
<tr>
<td>Chip Expiration</td>
<td>151</td>
</tr>
<tr>
<td>Chip focusing</td>
<td>273</td>
</tr>
<tr>
<td>Chip Interface Test</td>
<td>293</td>
</tr>
<tr>
<td>Chip Pressure system</td>
<td>273</td>
</tr>
<tr>
<td>Chip Primed for Different Assay warning</td>
<td>288</td>
</tr>
<tr>
<td>Chip Status</td>
<td>151</td>
</tr>
<tr>
<td>Chip Temperature Test</td>
<td>294</td>
</tr>
<tr>
<td>Chip Temperature Warning</td>
<td>289</td>
</tr>
<tr>
<td>Chromatography Data Interchange Format</td>
<td>103, 105</td>
</tr>
<tr>
<td>CLA file</td>
<td>305</td>
</tr>
<tr>
<td>opening</td>
<td>60</td>
</tr>
<tr>
<td>Cleaning the Chip Cartridge</td>
<td>281, 298</td>
</tr>
<tr>
<td>Clear Default Ladder button</td>
<td>189</td>
</tr>
<tr>
<td>Clearing the default ladder</td>
<td>79</td>
</tr>
<tr>
<td>Clipboard</td>
<td>305</td>
</tr>
<tr>
<td>Collection</td>
<td>61, 146, 157, 305, 306</td>
</tr>
<tr>
<td>adding to workspace</td>
<td>61</td>
</tr>
<tr>
<td>Collection Menu</td>
<td>146</td>
</tr>
<tr>
<td>Collection pane</td>
<td>157</td>
</tr>
<tr>
<td>Selecting the Wells in a Collection template</td>
<td>306</td>
</tr>
<tr>
<td>Color, gel</td>
<td>167</td>
</tr>
<tr>
<td>Column-wise</td>
<td>250</td>
</tr>
<tr>
<td>Compare results</td>
<td>85</td>
</tr>
<tr>
<td>Compatible plates</td>
<td>38</td>
</tr>
<tr>
<td>Computer Resources Test</td>
<td>292</td>
</tr>
<tr>
<td>Computer Software Lock-Ups</td>
<td>299</td>
</tr>
<tr>
<td>Concentration</td>
<td>19, 189</td>
</tr>
<tr>
<td>Concentration size correction</td>
<td>205</td>
</tr>
<tr>
<td>Continuing a Run</td>
<td>32</td>
</tr>
<tr>
<td>Contrast</td>
<td>167</td>
</tr>
<tr>
<td>Copy</td>
<td>94</td>
</tr>
<tr>
<td>Copy Gel</td>
<td>94</td>
</tr>
<tr>
<td>Copy Graph</td>
<td>94</td>
</tr>
<tr>
<td>Copy Lane</td>
<td>94</td>
</tr>
<tr>
<td>Copy data file</td>
<td>252</td>
</tr>
<tr>
<td>Correction factor, optics</td>
<td>41</td>
</tr>
<tr>
<td>Correction, concentration size</td>
<td>205</td>
</tr>
<tr>
<td>Create daily subdirectories</td>
<td>59</td>
</tr>
<tr>
<td>Create New User Tab</td>
<td>261</td>
</tr>
<tr>
<td>Current Calibration Test</td>
<td>297</td>
</tr>
<tr>
<td>Current Leakage Check Failed Warning</td>
<td>289</td>
</tr>
<tr>
<td>Current Leakage Test</td>
<td>295</td>
</tr>
<tr>
<td>Curve fit</td>
<td>189, 317</td>
</tr>
<tr>
<td>Customer Support plans</td>
<td>3</td>
</tr>
<tr>
<td>Cycles</td>
<td>254</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Data</td>
<td></td>
</tr>
<tr>
<td>smoothing</td>
<td>108</td>
</tr>
<tr>
<td>Data Analysis</td>
<td>42, 49, 54, 57, 58</td>
</tr>
</tbody>
</table>
DNA ........................................ 43
DNA Assay Analysis .......................... 308
DNA ladder .................................. 43

GX Touch ................................... 107
Door .......................................... 270

How the Software Analyzes Genomic DNA Data ................. 58
Edit Users Tab ................................ 263
How the Software Analyzes Glycan Data ........................... 54
Eject button .................................. 271
How the Software Analyzes Protein Charge Variant Data ...... 57
Electrical safety ................................ 10
How the Software Analyzes RNA Data ............................ 49
Electrode wells ................................ 274
Protein ....................................... 45
Electrodes .................................... 275
Data File ..................................... 60, 85, 305, 307, 309
Electrokinetic Forces .......................... 308
automatically exporting ...................... 126
Electropherogram ............................ 308
backing up .................................. 135
Graph View Properties ..................... 164
evaluation ................................... 85
printing ...................................... 97
hiding ........................................ 132
printing multiple ............................ 101
locking ....................................... 125
viewing errors ............................... 92
moving ....................................... 131
Electrophoresis ............................... 19, 308
opening ....................................... 60
Enable Remote CDR Backup ................ 214
reanlayzing .................................. 95
End Point .................................... 308
remote backup ............................... 133
End Time .................................... 192, 309
restoring ..................................... 136
changing ..................................... 80
reverting to revision ......................... 126
Error collection ............................. 179
showing ....................................... 132
Error Messages ............................... 285, 286, 287, 288, 289
signing ....................................... 125
Chip Primed for Different Assay Warning ......................... 288
Data File location ............................ 252
Chip Temperature Warning .................. 289
Data File Version Window .................. 217
Current Leakage Check Failed Warning ................. 288
Data filtering ................................ 307
Device Disconnected Error ................ 286
Data Folder ................................... 130
Diagnostics ................................... 291
creating ...................................... 131
Maximum samples exceeded Warning ................. 288
deleting ....................................... 131
Move Timeout Error ........................ 287
Data points ................................... 307
Error Message Area .......................... 153
Data Range ................................... 189
Focus Failed Error ........................... 286
De/Activate User Tab ......................... 266
Error Message Area .......................... 153
Defecting username ......................... 120
Move Timeout Error ........................ 287
Default Ladder ................................ 77
Plate Carrier Motion Blocked Error .......... 276
Detector ....................................... 273
Pressure Leak Detected Error ............... 287
Device Disconnected Error ................ 286
Running tests ................................ 291
Diagnostics ................................... 291
Dilution Ratio ................................ 189
Errors .......................................... 288
Disconnected Device Error .................. 286
viewing analysis ............................. 92
DNA ........................................... 43
Viewing Current Events in the Events Tab ................. 284
Data File ..................................... 60, 85, 305, 307, 309
Electropherograms tab ....................... 90, 163
Data File Version Window .................. 217
Electrophoresis ............................... 19, 308
Data Folder ................................... 130
Enable Remote CDR Backup ................ 214
creating ...................................... 131
deleting ....................................... 131
Diagnostics ................................... 291
Maximum samples exceeded Warning ................. 288
running tests ................................ 291
Dilution Ratio ................................ 189
Plate Carrier Motion Blocked Error .......... 286
Disconnected Device Error .................. 286
Viewing Current Events in the Events Tab ................. 284
DNA ........................................... 43
Viewing Past Events in the Events Tab ........................................ 284
Excluded fragments .................................................. 198
Excluded peaks ...................................................... 198
Excluded Peaks Tab .................................................. 198
Excluded proteins .................................................... 198
Excluding a peak .................................................... 74
Expected Fragments .................................................. 67
Expected Fragments Tab .............................................. 196
Expected Glycans .................................................... 67
Expected Glycans Tab ................................................. 196
Expected Peaks ........................................................ 67
Expected Peaks button ............................................... 198
Export ................................................................. 63, 102, 196, 198, 200, 202, 209, 219
Audit Trail Export Window ........................................... 209
Auto Export window .................................................. 219
Automatically ......................................................... 29
default ladder ....................................................... 79
Excluded Peaks button ............................................... 198
Expected fragments .................................................. 196
Expected peaks ....................................................... 196
Expected Peaks button ............................................... 196
Expected proteins .................................................... 196
Export window ........................................................ 219
Manually ............................................................... 102, 105
Sample names ......................................................... 63
Select the Auto Export Settings ................................... 29
Smear button .......................................................... 200
Titer .................................................................... 202
Export As Assay button ............................................... 186
Exporting an assay .................................................... 84

Filter View .............................................................. 180
Filter Width ............................................................ 192, 309
Filtered Peaks only .................................................... 179
Filtering parameters ................................................... 72
Finding peaks ........................................................... 317
First Peak Time ........................................................ 327
Focus Failed Error ..................................................... 286, 287
Focusing ................................................................. 273
Font ..................................................................... 164
Forcing expected peaks ............................................... 69
Front panel ............................................................... 271
Front view ............................................................... 270
Fuses .................................................................. 11, 278

G
Gel ........................................................................ 94, 167
copying ................................................................. 94
exporting ............................................................... 104
Gel color ................................................................. 85
Gel View ................................................................. 167
Gel View Properties .................................................. 170
printing ................................................................. 97
Gel Color ............................................................... 170
Gel Contrast Range ................................................... 170
Gel View Properties .................................................. 170
Genomic DNA Data Analysis ....................................... 58
Global Analysis settings .............................................. 186
GQS Smear Start Size ................................................ 207
Graph ................................................................. 85, 94, 325
Active Data tab ......................................................... 161
copying ................................................................. 94
Electropherograms tab ................................................. 163
Graph View Properties ............................................. 164
max per page .......................................................... 164
overlay ................................................................. 89
Overlay Electropherograms Tab ................................. 162
printing ................................................................. 97
printing multiple ..................................................... 101
selected gels only ..................................................... 164
Standard curve ....................................................... 325
Graph selected gels only ............................................. 164
Graph View ............................................................ 158
Grounding ............................................................... 278
GX Touch Data ......................................................... 107
GXD file ................................................................. 60

F
File format .............................................................. 252
File menu ............................................................... 145
File Order ............................................................. 250
H
Hardware Diagnostics .................. 309
Heat Emission ............................... 278
Help menu .................................. 150
Hide excluded peaks ...................... 179
Hiding views ................................ 87
High Conc Size Corr ...................... 206
High Voltage safety ....................... 10
Home Timeout .............................. 286
How the Software Analyzes DNA Data 43
How the Software Analyzes Genomic DNA Data ......................... 58
How the Software Analyzes Glycan Data 54
How the Software Analyzes Protein Charge Variant Data ............... 57
How the Software Analyzes Protein Data 45
How the Software Analyzes RNA Data 49
HV Check Failed Warning ............... 288
HV Current Calibration Test .......... 297
HV Voltage Calibration Test .......... 297
Identifying peaks .......................... 317
Import ........................................... 60, 63, 196, 198, 200, 202
data file ........................................ 60
Excluded Peaks button .................. 198
Expected Peaks button .................. 196
sample names ............................... 63
Smear button .............................. 200
Titer ............................................. 202
Inflection Threshold ....................... 112, 192, 310
Installation Qualification Window ........ 222
Instrument description .................. 270
Instrument menu ......................... 147
Instrument mode ........................... 21
Instrument safety ........................ 7
IQ, running .................................. 290
LabChip GX main window ................ 143
LabChip Kit assay description .......... 19
Label position ............................. 40
Lab-on-a-Chip ................................ 310
Ladder ........................................ 189, 310, 311
Alignment tab ............................. 188
clearing default ladder ................. 79
concentration ............................. 189
DNA ............................................. 43
exporting default ladder ............... 79
Ladder Analysis ............................. 311
ratio .......................................... 189
selecting default .......................... 77
using default .............................. 79
Ladder Rejection Threshold ............ 189
Ladder vial .................................. 277
Lane Width ................................. 170
Laser .......................................... 273
Laser Safety .................................. 9
Last Peak Time ............................. 309
Layout Options Window ................. 223
Leading Edge ............................... 205
Line Voltage ............................... 278
Linear Fit ..................................... 202
Location, barcode label ................. 40
Lock .............................................
   setting permissions ..................... 118
   Locking a data file ..................... 125
   Locking the software .................. 116
   Log file ................................ 312
   Log fit ................................... 189
   Login Window ........................... 224
   Lower marker ............................ 311
Main window ................................ 143
Maintenance and Service ............... 280
   Cleaning the Chip Cartridge .......... 281, 298
Manual export ............................ 105
Manual peak ................................ 74
Manually exporting data ............... 105
Marker ........................................ 49, 189
   aligning .................................. 80
   Assignments ............................. 189
   concentration ........................... 189
   DNA ....................................... 43
   Drift Tolerance ......................... 207
   LM for Glycan ............................ 83
   LM for Protein and RNA ............... 82
   Marker well .............................. 274
   UM and LM for DNA .................... 81
Maximum Graphs per Page ............. 164
Run button .................. 151, 323
Run File Editor Window .................. 243
Run Info Window .................. 244
Run Status .................. 151
Run Tab, Start Run Window .................. 250

S
Safety .................. 7, 8, 9, 10, 11
chemical .................. 8
electrical .................. 10
fuses .................. 11
instrument .................. 7
laser .................. 9
mechanical .................. 11
power cord .................. 11
training required .................. 7
Sample .................. 25, 164, 205
calculating DNA size .................. 43
Name .................. 164
Name template .................. 63
Sample Color .................. 164
Sample Peak Quantitation .................. 205
Sample Saver .................. 25
Sample Name Editor Window .................. 245
Sample Names File .................. 254
Sample Names file .................. 63
Sample Saver .................. 254
Sample Selection .................. 254
Save .................. 33

Saving and Exporting Assays .................. 84
Saving Plate Data Files .................. 33
Saving Workspace Files .................. 34
Save Workspace As Window .................. 247
Scale Gel Contrast .................. 247
Searching for Events in the Events Tab . 283
Standard curve .................. 189, 325
DNA .................. 43
Start .................. 22, 25, 327
Monitoring the Run .................. 30
Running the assay .................. 25
Start button .................. 25
Start Point .................. 327
Starting a Run .................. 25
Start Run Window .................. 249
Start Time .................. 192
changing .................. 80
Status light .................. 271
Stop Button .................. 25, 31
Stop button .................. 151
Storage Temperature .................. 278
Support plans .................. 3
Supported Barcode Types .................. 278
System Components Test .................. 293
System Diagnostics Window .................. 256
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aborting a run</td>
<td>31</td>
</tr>
<tr>
<td>Changing analysis time</td>
<td>80</td>
</tr>
<tr>
<td>Changing user info</td>
<td>120</td>
</tr>
<tr>
<td>Deactivating user info</td>
<td>120</td>
</tr>
<tr>
<td>Deleting users</td>
<td>118</td>
</tr>
<tr>
<td>Entering a new user</td>
<td>118</td>
</tr>
<tr>
<td>Excluding a peak</td>
<td>74</td>
</tr>
<tr>
<td>Focus Failed</td>
<td>74</td>
</tr>
<tr>
<td>Home Timeout</td>
<td>286</td>
</tr>
<tr>
<td>HV Check Failed</td>
<td>288</td>
</tr>
<tr>
<td>Maximum samples exceeded</td>
<td>288</td>
</tr>
<tr>
<td>Move Timeout</td>
<td>287</td>
</tr>
<tr>
<td>Plate Carrier Motion Blocked</td>
<td>286</td>
</tr>
<tr>
<td>Pressure Leak Detected</td>
<td>287</td>
</tr>
<tr>
<td>Troubleshooting Assay Problems</td>
<td>298</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>31, 283, 298</td>
</tr>
<tr>
<td>Unlock Application Window</td>
<td>258</td>
</tr>
<tr>
<td>Unlock Data File window</td>
<td>259</td>
</tr>
<tr>
<td>Unlocking the software</td>
<td>116</td>
</tr>
<tr>
<td>Upper marker</td>
<td>328</td>
</tr>
<tr>
<td>USB cable</td>
<td>272</td>
</tr>
<tr>
<td>USB Key</td>
<td>277</td>
</tr>
<tr>
<td>User Administration Window</td>
<td>260</td>
</tr>
<tr>
<td>User Standard</td>
<td>205</td>
</tr>
<tr>
<td>Valuingmenu</td>
<td>149</td>
</tr>
<tr>
<td>Valley to Valley</td>
<td>205</td>
</tr>
<tr>
<td>Ventilation</td>
<td>278</td>
</tr>
<tr>
<td>Verifying Plate</td>
<td>38</td>
</tr>
<tr>
<td>Version, assay</td>
<td>187</td>
</tr>
<tr>
<td>View menu</td>
<td>149</td>
</tr>
<tr>
<td>Viewing</td>
<td>284</td>
</tr>
<tr>
<td>Viewing Events in the Events Tab</td>
<td>284</td>
</tr>
<tr>
<td>Viewing Error Analysis</td>
<td>92</td>
</tr>
<tr>
<td>Viewing Graphs in the Electropherograms Tab</td>
<td>90</td>
</tr>
<tr>
<td>Viewing Past Events in the Events Tab</td>
<td>284</td>
</tr>
<tr>
<td>Views</td>
<td>158</td>
</tr>
<tr>
<td>Filter View</td>
<td>180</td>
</tr>
<tr>
<td>Gel View</td>
<td>167</td>
</tr>
<tr>
<td>Graph View</td>
<td>158</td>
</tr>
<tr>
<td>Hiding views</td>
<td>87</td>
</tr>
<tr>
<td>Peak Table View</td>
<td>174</td>
</tr>
<tr>
<td>Showing and hiding</td>
<td>87</td>
</tr>
<tr>
<td>Well Table View</td>
<td>172</td>
</tr>
<tr>
<td>Voltage Calibration Test</td>
<td>297</td>
</tr>
<tr>
<td>Voltage Safety</td>
<td>10</td>
</tr>
<tr>
<td>Warnings</td>
<td>288, 289</td>
</tr>
<tr>
<td>Chip primed for different assay</td>
<td>288</td>
</tr>
<tr>
<td>Chip Temperature Warning</td>
<td>289</td>
</tr>
<tr>
<td>Current Leakage Check Failed</td>
<td>289</td>
</tr>
<tr>
<td>HV Check Failed</td>
<td>288</td>
</tr>
<tr>
<td>Maximum samples exceeded</td>
<td>288</td>
</tr>
<tr>
<td>Viewing analysis</td>
<td>92</td>
</tr>
<tr>
<td>Waste disposal</td>
<td>8</td>
</tr>
<tr>
<td>Waste wells</td>
<td>274</td>
</tr>
<tr>
<td>Wavelength</td>
<td>278</td>
</tr>
<tr>
<td>Weight</td>
<td>278</td>
</tr>
<tr>
<td>Well Depth</td>
<td>38, 185</td>
</tr>
<tr>
<td>Well Groups, aligning</td>
<td>188</td>
</tr>
<tr>
<td>Well Peak Find Settings</td>
<td>192</td>
</tr>
<tr>
<td>Well Table View</td>
<td>172</td>
</tr>
</tbody>
</table>
adding columns .................. 93
printing ......................... 99
viewing errors .................. 92
Wells, selecting .................. 62
Window menu .................... 149
Workspace ....................... 61, 145, 328
  adding collection ................. 61
  opening a new workspace ....... 59
  printing ........................ 96
Saving Workspace Files .......... 34
Workspace Menu ................. 145

X
X Margin  ......................... 38, 185

Y
Y Margin ......................... 38, 185

Z
Zero baseline ...................... 85, 329
Zoom In  ......................... 88
Zoom Out  ....................... 88